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OrCAD Capture Reference Guide
About this Manual

Welcome

OrCAD® Capture (henceforth referred to as Capture) is a schematic design tool set for the 
Windows environment. With Capture, you can draft schematics and produce connectivity and 
simulation information for printed circuit boards and programmable logic designs.

The OrCAD® Reference Guide describes menu commands, windows, toolbars and dialog 
boxes available to users via the Capture user interface. This book serves as both a reference 
manual and the content source for the Capture context-sensitive online Help.

Where to Find Information in this Manual

The OrCAD® Reference Guide contains information on both menu command and dialog 
boxes available in the Capture environment with convenient cross links.

Menu Commands

The menu commands in Capture are covered across the following chapters (grouped by the 
section of the environment to which they belong):

Project manager command reference

Schematic page editor and part editor command reference

Session log command reference

Command Window command reference

Window descriptions

The Window descriptions chapter provides a brief description of the different windows 
available in the Capture environment.
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Dialog Box descriptions

The dialog box descriptions are covered in a number of chapters of this guide, grouped 
alphabetically. Each of the descriptions provides details of how to open the dialog and a 
description of each of the controls on the dialog.
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Where to Find Additional Information

To access additional technical documentation from the OrCAD Capture user interface, display 
the online Help page by choosing Help – Documentation from the main menu.

How to Contact Technical Support

If you have questions about installing or using OrCAD Capture, contact the Cadence Online 
Support
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2
Project manager command 
reference

This chapter covers:

■ File menu on page 23

■ Design menu on page 30

■ Edit menu on page 38

■ View on page 52

■ Tools menu on page 55

■ PSpice on page 61

■ Options menu on page 66

■ Window menu on page 72

■ Help menu on page 75

File menu

New command on page 24

Open command on page 24

Close Project command on page 25

Save command on page 26

Save As command on page 26

Save Project As on page 27

Archive Project command on page 27
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Print Preview command on page 28

Print command on page 28

Print Setup command on page 29

1,2,3,4 command on page 29

Change Product command on page 29

Exit command on page 30

New command

Open command

Available from: File menu

Function:

Use this command to create a new project, design, library. Choose a 
command from the menu that appears:

■ Project

■ Design

■ Library

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see1,2.... command).

Note: If you click the Create document toolbar button from the project 
manager window, the New Project dialog box appears.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ ALT, F, N

Available from: File menu
June 2020 24 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

../cap_ug/Glossary.html#project
../cap_ug/Glossary.html#design
../cap_ug/Glossary.html#library


OrCAD Capture Reference Guide
Project manager command reference
Close Project command

Function:

Use this command to open an existing project, design, library, VHDL, or 
Verilog file in a new window. Choose a command from the menu that 
appears:

■ Demo Designs

■ Project

■ Design

■ Library

■ Project

■ VHDL File

■ Verilog File

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see 1,2.... command).

You can create a new design, library, VHDL, or Verilog file using the New 
command on the File menu.

Note: When you click the Open button on the toolbar, a standard 
Windows Open dialog box appears, in which you can choose the type of 
file you want to open in the Files of type drop-down list. Among the listed 
choices are SDT Schematic (*.SCH) and SDT Library (*.LIB).

Shortcuts:

Capture Toolbar:: 

Keyboard:

■ ALT, F, O

Available from: File menu

Function:
Use this command to close the active window. If necessary, you are 
prompted to save your changes.

Shortcuts: Keyboard: ALT, F, C
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Save command

Save As command

Available from: File menu

Function:

Use this command to save the active, modified projects, designs, 
libraries, and VHDL files. You can save a design, library, VHDL file, or 
session log under a different name using the Save As command on the 
File menu.

Note: When you save a project, Capture automatically creates a backup 
with a .DBK file extension. When you save a library, Capture automatically 
creates a backup with a.OBK file extension. If you save only a schematic 
page or part, no backup is generated.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+S

■ ALT, F, S

Available from: File menu

Function:

Use this command to save the active project, design, library, VHDL file, 
or session log under a different name or to save a new, unnamed project, 
design, library, VHDL file, or session log. You can save a design, library, 
schematic page, part, or session log with the Save command on the File 
menu.

The Save As command opens a standard Windows dialog box to save 
files.

Note: When you save a project, Capture automatically creates a backup 
with a .DBK file extension. When you save a library, Capture automatically 
creates a backup with a.OBK file extension. If you save only a schematic 
page or part, no backup is generated.

Note: When you use the Save As command, you are prompted to choose 
the file type from the Save As Type list in the Save As dialog box. You can 
choose to save the file in the current design database schema version or 
in a schema version that is one version prior to the application version you 
are currently using.
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Save Project As

Archive Project command

Shortcuts: Keyboard: ALT, F, A

Available from: File menu

Function:

Use this command to save the associated files present inside or outside 
the project directory along with the project at a new location while 
maintaining their internal and external links. Associated files include 
referred projects, designs, libraries, simulation profiles, and output files.

The Save Project As command opens the Project SaveAs dialog box. In 
this dialog box, you can specify a project name that is different from the 
design name. The Project SaveAs settings can be customized using the 
Settings tab of the dialog box which gives you the option to copy the 
design file along with the project and rename it. You can also selectively 
specify to copy the referred files present within or outside the project 
folder.

Note: Referred files include Projects, Libraries, Output Files, Simulation 
Files and so on referred from the current project. 

Important

Irrespective of the option selected to copy the referred files, the 
links to the referred files are always updated   for the new saved 
project. In case of PSpice projects, PSpice files are always 
copied to the new location, irrespective of the options selected 
in the settings tab.

Available from: File menu
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Print Preview command

Print command

Function:

Use this command to save the project (*.OPJ) and all the related files 
(design (*.DSN), library (*.OLB), and referenced projects) in a different 
directory and create a zip archive (.zip) of this directory for archival 
purposes. 

You can also specify any additional files or directories that you may want 
to be archived along with your project files. 

You can include output files and library files (like *.OLB files in the 
Library folder and *.VHD files).

Shortcuts: Keyboard: ALT, F, H

Available from: File menu

Function:

Use this command to see how a schematic page or part will look when 
printed.

After setting the options in the Print Preview dialog box, click OK to 
preview the printed document. You can use the buttons at the top of the 
window to view different pages and to zoom in and out.

Note: Be prepared to wait if you attempt to print multiple pages or parts. 
Depending on the number and size of the pages or parts you are 
previewing, Capture may require extra time to display the selection.

Shortcuts: Keyboard: ALT, F, V

Available from: File menu

Function:
Use this command to print the active schematic page, the active part, or 
the selected items in the project manager.

Note: When you print multiple copies, the copies are grouped by page, 
not sorted by copy.
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Print Setup command

1,2,3,4 command

Change Product command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+P

■ ALT, F, P

Available from: File menu

Function:

Use this command to choose a printer, paper source, and orientation 
before printing. The Print Setup command displays the Print Setup 
dialog box, a standard windows dialog box for configuring your printer or 
plotter. For more information on setting up printers and plotters, refer to 
the documentation for your configured printer driver.

Tip

Many times, the options for your printer are not available in the 
standard setup dialog box. If you do not find the options you 
need, try the printer setup in the Windows Control Panel.

Shortcuts: Keyboard: ALT, F, R

Available 
from:

File menu

Function:
Use the numbers listed at the bottom of the File menu to open one of 
the last four projects or files. Choose the file you want to open.

Shortcuts: Keyboard: ALT, F, N (n = 1, 2, 3, or 4)

Available 
from:

File menu
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Exit command

Design menu

New Schematic command on page 31

New Schematic Page command on page 31

New Part command on page 32

New Part command on page 32

New Part from Spreadsheet command on page 32

Function:

Use this command to select a product suite from which to open 
Capture without having to exit the tool.

This command is not available if you have a project open in Capture.

Select the Use as default check box to set the default product suite 
from which Capture should check out a license each time you start 
the tool. If this option is selected, then the suite selection dialog box 
will not appear the next time you start the tool. However, if you want 
the suite selection dialog box to be displayed again then clear the 
Use as default check box in the suite selection dialog box.

Shortcuts: Keyboard: ALT, F, C

Available from: File menu

Function:

Use this command to exit the software. If necessary, you are prompted 
to save your changes.

You can also exit the software by choosing the Close command on the 
session frame Control menu (ALT, SPACEBAR, C).

Shortcuts:

Keyboard:

■ ALT+F4

■ ALT, SPACEBAR, C

■ ALT, F, X
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Rename command on page 33

Rename command on page 33

Remove Occurrence Properties command on page 33

Make Root command on page 33

Replace Cache command on page 34

Update Cache command on page 36

Cleanup Cache command on page 37

Set Password Command on page 37

Remove Password on page 37

Change Password on page 38

New Schematic command

New Schematic Page command

Available from: Design menu

Function:

Use this command to create a schematic folder in the active project.

You can add a new schematic page to the selected schematic folder 
using the New Schematic Page command on the Design menu.

Note: Schematic folder, schematic page, part, part alias, and symbol 
names are completely case sensitive. It is possible to have a part named 
"XYZ" and another one named "xyz," and Capture's tools will treat the two 
separately.

Shortcuts: Keyboard: ALT, D, S

Available from: Design menu
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New Part command

New Part from Spreadsheet command

Function:

Use this command to add a new schematic page to the selected 
schematic folder.

You can add a new schematic folder to the active project using the New 
Schematic command on the Design menu.

Note: Schematic folder, schematic page, part, part alias, and symbol 
names are completely case sensitive. It is possible to have a part named 
"XYZ" and another one named "xyz," and Capture's tools will treat the two 
separately.

Shortcuts: Keyboard: ALT, D, P

Available from: Design menu

Function:

Use this command to create a part in the active library. Part aliases are 
created at the same time as the original part and show up in the library 
independently from the original part, but are represented in the project 
manager by a part icon with a horizontal line through the center. You can 
add part aliases to a library after the original part is created using the 
Property Sheet pane.

Note: Schematic folder, schematic page, part, part alias, and symbol 
names are completely case sensitive. It is possible to have a part named 
"XYZ" and another one named "xyz," and Capture's tools will treat the two 
separately.

Tip

You can use an existing part as a model for a new part by moving 
a copy of the part to a second library and then editing the copy. 
If you wish to have the new part in the original library, rename 
the new part, then move it to the original library.

Shortcuts: Keyboard: ALT, D, T

Available from: Design menu
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Rename command

Remove Occurrence Properties command

Make Root command

Function: Use this command to create a new part in the active library.

Shortcuts: Keyboard: ALT, D, H

Available from: Design menu

Function:
Use this command to change the name of the selected schematic folder, 
schematic page, or part. If you rename a power or ground symbol using 
this command, the name is limited to 31 characters.

Shortcuts: Keyboard: ALT, D, R

Available from: Design menu

Function:
Use this command to remove all the unique annotations you have placed 
on parts

Note: The following changes will be lost using this command:

❑ inherent properties on occurrences

❑ user-define properties on occurrences

❑ gate or pin swaps unique to the part occurrences

❑ occurrence properties on title blocks, pins, and nets

You can use the property editor to find occurrence properties on 
objects in your design.

Shortcuts: Keyboard: ALT, D, O

Available from: Design menu
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Replace Cache command

Function:

Use this command to designate the selected schematic folder as the root 
schematic folder of the hierarchy.

Important

If you haven't specified a root for your design, you cannot 
generate reports. Also, when folders are copied to a new design, 
the ROOT designation is lost and must be reestablished in the 
design.

Shortcuts: Keyboard: ALT, D, M

Available from: Design menu

Function:
Use this command to replace the selected part in the design cache, 
based on its current definition in any library. You can also use this 
command to replace a selected part in the cache with a different part.

Important

When you replace a selected part in the design cache, make 
sure the part library is correct before you change the part name 
to the library part name. If more than one part is selected in the 
design cache, you can use the Replace Cache command to 
replace them, but the Part name field will not be available.

When you replace a part in the design cache, you replace all the 
parts in the active design that share the same part value and 
library. If the replaced part displays on an open schematic page, 
the parts on that page do not change until the page is closed and 
then reopened. 
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Note: If you select all the parts in the design cache and execute the 
Replace Cache command to replace parts from a new library in 
which one of the parts doesn't exist, the execution will quit when it 
gets to that part. Parts below it will not be replaced in the cache.

Using the Replace Cache dialog box, you can choose to preserve 
schematic part properties or replace schematic part properties.

If you select the action to Preserve schematic part properties, 
Capture brings in the graphics, pins, package properties, and part 
properties from the library while retaining all instance and 
occurrence properties of the schematic part in the design. The part 
reference changes to an unannotated reference (?), and the value 
becomes the new part name. If you look at the property editor Parts 
tab, you will also see that the package property value appears in the 
PCB Footprint property column. You will lose any changes made to 
the pin properties after the part was placed, including those made by 
the Annotate tools.

Note: Using the Preserve schematic part properties option with the 
Replace Cache command causes the same behavior as the default 
Replace Cache command in Capture Release 9 and earlier.

If you select the action to Replace schematic part properties, 
Capture brings in graphics, pins, package properties, and user 
properties from the library, totally replacing the schematic part in the 
design. Any value, PCB footprint, part reference, and instance or 
occurrence property defined on the schematic page will not change. 
Remember that instance and occurrence properties always obscure 
library definitions.

Note: The Replace Cache and Update Cache commands are quite 
similar. However, there are a couple of significant differences between the 
two commands. You can modify a part's link to the library (part name, 
path, and library) with Replace Cache, but not with Update Cache. 
Update cache only brings in new data when the path has changed. 
Another difference is that if the path and library names do not change, 
Replace Cache reloads the part definition into the design. However, if 
Update Cache finds that the part name and the library names are the 
same, it does not bring in part changes.
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Update Cache command

Tip

If you need to know a part’s library of origin, you can select the 
part in the project manager, then select Replace Cache from the 
Design menu. The part name and the library and path are listed 
in the dialog box that appears. Click Cancel to return to the 
project manager.

You can discover the library of origin for multiple parts by .

Shortcuts: Keyboard: ALT, D, C

Available from: Design menu

Function:

Use this command to update the selected parts in the design cache, 
based on their current definitions in their original libraries. This command 
works when one or more parts are selected. You can select all the parts 
also.

When you change a part in the design cache, you change all the parts in 
the active design that share the same part value and library. Part 
properties are retained, but pin properties are not. If the modified part 
appears on an open schematic page, the parts on that page do not 
change until the page is closed and reopened.

If you copy pages from one design or library to another, parts displayed 
on the copied pages may appear different due to differences in each 
design or library cache. If a part is not already in the destination design 
cache, Capture will copy it from the source design's cache. Otherwise, it 
will use the part already present in the destination design's cache.

Note: The Replace Cache and Update Cache commands are quite 
similar. However, there are a couple of significant differences between the 
two commands. You can modify a part's link to the library (part name, 
path, and library) with Replace Cache, but not with Update Cache. 
Update cache only brings in new data when the path has changed. 
Another difference is that if the path and library names do not change, 
Replace Cache reloads the part definition into the design. However, if 
Update Cache finds that the part name and the library names are the 
same, it does not bring in part changes.
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Cleanup Cache command

Set Password Command

Remove Password

Tip

If you need to know a part's library of origin, you can select the 
part in the project manager, then select Replace Cache from the 
Design menu. The part name and the library and path are listed 
in the dialog box that appears. Click Cancel to return to the 
project manager.

You can discover the library of origin for multiple parts by .

Shortcuts: Keyboard: ALT, D, U

Available from: Design menu

Function:
Use this command to cleanup the design cache. This command removes 
nonexistent parts from the cache.

Shortcuts: Keyboard: ALT, D, N

Available from: Design menu

Function:

Use this command to set a password to a Capture design. Once you 
click on the command, you will asked to enter and confirm the password.

Note: Once the password is set to the design, there is no way to recover 
the design without the correct password.

Shortcuts: -

Available from: Design menu

Function:
Use this command to remove the already set password to a Capture 
design. 
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Change Password

Edit menu

Cut command on page 39

Copy command on page 39

Paste command on page 40

Project command on page 42

Properties command on page 42

Object Properties command on page 44

Browse command on page 45

Power Pins command on page 49

Rename Part Property command on page 50

Go To command on page 51

Clear Session Log command on page 52

Delete Part Property command on page 51

Replace command on page 51

Shortcuts: -

Available from: Design menu

Function:
Use this command to modify or update the already set password to a 
Capture design. Once you click the command, you will asked to enter 
and confirm the password.

Shortcuts: -
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Cut command

Copy command

Available from: Edit menu

Function:

Use this command to remove the selected object from the active window 
and put it on the Clipboard. This command is only available when an 
object is selected.

Cutting objects to the Clipboard replaces any objects previously stored 
there. Use the Paste command to copy objects to another page or part, 
or to another Windows application that supports pasting from the 
Clipboard.

Note: The Cut and Copy command are unavailable in the part editor 
when you have one or more pins selected with other objects (such as an 
arcs and lines).

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+X

■ ALT, E, T

Pop-up menu: Cut

Available from: Edit menu

Function:

Use this command to copy a selected object to the Clipboard without 
removing it from the active window. This command is available only if an 
object is selected.

Copying objects to the Clipboard replaces any objects previously stored 
there. Use the Paste command to copy objects to another page or part, 
or to another Windows application that supports pasting from the 
Clipboard.

Note: The Cut and Copy commands are unavailable in the part editor 
when you have one or more pins selected with other objects (such as arcs 
and lines).
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Paste command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+C

■ ALT, E, C

Pop-up menu: Copy

Available from: Edit menu

Function:

Use this command to place any objects stored on the Clipboard into the 
active window. This command is unavailable if the Clipboard is empty.

Pasting objects from the Clipboard does not affect the Clipboard's 
contents. Use Paste to copy objects to another page or part, or to 
another Windows application that supports pasting from the Clipboard. 
You can only paste text into text boxes.

Note: If you copy a part into the Clipboard and then paste it onto a 
schematic page, Capture will automatically assign a unique reference 
designator to the pasted part when two conditions are met:

1. The Auto Reference option on the Miscellaneous tab of the 
Preferences dialog box is selected.

2. The pasted part has a reference designator assigned to it when it is 
copied to the Clipboard.

Capture assigns the reference designator, updated to the next available 
value (one greater than the highest value used on the schematic at that 
point.) If the pasted part has a default reference (for example, R?) 
Capture does not assign a unique reference designator to it. 

Important

In part editor, you can copy objects and paste them in the part 
editor only. Similarly, in symbol editor, you can copy objects and 
paste them in the symbol editor only. 
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Lock command

UnLock command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+V

■ ALT, E, P

Pop-up menu: Paste

Available from: Edit menu

Function:

Use this command to lock a design, schematic folder, or a page in the 
project manager. A lock icon appears for design, schematic folder, or 
page you have locked. You cannot delete, move, rename, change a 
locked object. When you lock a page all the parts in the page are also 
locked.

Locking an item locks the sub-items. For example, if you lock a design, 
the schematic folders and the pages in these folders are also locked.

Note: Save the project after locking to ensure the lock state is saved. 

Shortcuts:

Keyboard:

■ ALT, E, L

Pop-up menu: Lock

Available from: Edit menu

Function:

Use this command to unlock a design, schematic folder, or a page in the 
project manager. The lock icon disappears for design, schematic folder, 
or page you have unlocked.

Locking an item locks the sub-items. For example, if you lock a design, 
the schematic folders and the pages in these folders are also locked.

Note: Save the project after locking to ensure the lock state is saved. 
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Project command

Properties command

Shortcuts:

Keyboard:

■ ALT, E, N

Pop-up menu: UnLock

Available from: Edit menu

Function:

Use this command to add resources to your project. When you choose 
this command, the Add file to Project Folder dialog box appears, in which 
you can locate and select files to add to your project. The files are added 
to the folder that is currently selected in the project manager window.

This command is only available when the File tab is active in the project 
manager window.

Shortcuts: Keyboard: ALT, E, R

Available from: Edit menu

In the project manager, use this command to view properties about the 
selected document. Using the Properties dialog box, you can access 
information general, type, and project about the file that is currently selected
in the project manager window. You can also change the file's type. A file or
project must be selected in the project manager window to access the 
Properties command.

In the schematic page editor, use this command to open the property editor,
where you can edit properties and other data for the selected objects.

The properties you can edit depend on the selected objects. The following 
lists the inherent properties you can edit and the dialog boxes in which you 
edit them:

Function:

Objects Dialog Box

Arcs Edit Graphic dialog box

Images (pictures) Not applicable
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Bookmarks Edit Bookmark dialog box

Buses Property editor Property editor

Bus entries User Properties dialog box

DRC markers View DRC Marker dialog box

Ellipses Edit Filled Graphic dialog box

Hierarchical blocks Property editor

Hierarchical pins Property editor

Hierarchical ports Property editor

IEEE symbols Place IEEE Symbol dialog box

Junctions Not applicable

Lines Edit Graphic dialog box

Multiple objects Property editor or Browse spreadsheet 
editor

Nets (wires and buses Property editor

Net aliases Property editor

No connects Not applicable

Off-page connectors Edit Off-Page Connector dialog box

Parts Property editor

Pictures (images) Not applicable

Part body borders Not applicable

Pins (part editor) Pin Properties dialog box (part editor)

Pins (schematic page editor) Property editor

Polygons Edit Filled Graphic dialog box

Polylines Edit Graphic dialog box

Power, ground Property editor

Rectangles Edit Filled Graphic dialog box

Text Place Text dialog box

Title blocks Property editor

Objects Dialog Box
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Object Properties command

Wires Property editor

Objects Dialog Box

Note: You can edit homogeneous sets of the following objects in the 
spreadsheet editor:

■ Bookmarks

■ DRC markers

■ Hierarchical ports

■ Nets

■ Off-page connectors

■ Parts

■ Pins

Shortcuts:

Keyboard:

■ CTRL+E

■ ALT, E, I

Mouse: Double-click on a part

Pop-up menu: Edit Properties

Available from: Edit menu
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Browse command

Function:

Use this command to open the Property Editor window for a design. You 
can use the property editor window to edit part, net, pin, title block, 
global, port, and alias properties. 

This command is available only when you have selected any one of the 
following items in the Project manager window:

■ Design file (.dsn)

■ Schematic folder

■ Schematic page

You can access the Edit Object Properties command from pop-up menu.

Shortcuts: Keyboard: ALT, E, O

Available from: Edit menu

Function:

Use this command in the project manager to specify which items to 
search for and how to sort the results. Choose a command from the 
menu that appears:

■ Parts command

■ Nets command

■ Hierarchical Ports command

■ Off-page Connectors command

■ Titleblocks command

■ Bookmarks command

■ DRC Markers command

■ Flat Netlist command

■ Power Pins command

You can open a schematic page or part by double-clicking on the 
selected item. You can also choose properties to edit and change one or 
more items.

Shortcuts: Keyboard: ALT, E, B
June 2020 45 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Project manager command reference
Parts command

Nets command

Hierarchical Ports command

Available from: Edit menu, Browse command

Function:

Use this command to list the parts of the selected schematic pages in 
the browse window. The Browse Properties dialog box gives you the 
option to use instances or occurrences.

You can sort the parts in the browser spreadsheet by clicking the button 
at the top of each column in the browse window. Capture only displays 
the occurrences of the parts in the browse window.

You can select single or multiple parts and edit them with the Properties 
command. When you edit one part, a part editor window appears. When 
you select multiple parts, the Browse spreadsheet editor appears.

Shortcuts: Keyboard: ALT, E, B, P

Available from: Edit menu, Browse command

Function:

Use this command to list the nets of the selected schematic pages in the 
browse window. Capture only displays the occurrences of the nets in the 
browse window.

You can select single or multiple nets and edit them with the Properties 
command. When you edit nets, the property editor window appears.

Double-click on a net to view it in the schematic page editor.

Shortcuts: Keyboard: ALT, E, B, N

Available from: Edit menu, Browse command
June 2020 46 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Project manager command reference
Off-page Connectors command

Titleblocks command

Function:

Use this command to list the hierarchical ports of the selected schematic 
pages in the browse window. You can use this command to follow ports 
through a hierarchy when tracing problems in a hierarchical design.

You can select single or multiple hierarchical ports and edit them with the 
Properties command. When you edit one hierarchical port, the Edit 
Hierarchical Port dialog box appears. When you select multiple 
hierarchical ports, the Edit Properties dialog box appears.

Double-click on a hierarchical port to view it in the schematic page editor.

Shortcuts: Keyboard: ALT, E, B, H

Available from: Edit menu, Browse command

Function:

Use this command to list the off-page connectors of the selected 
schematic pages in the browse window. You can use this command to 
follow nets as they travel through off-page connectors to other pages.

You can select single or multiple off-page connectors and edit them with 
the Properties command. When you edit one off-page connector, the 
Edit Off-Page Connector dialog box appears. When you select multiple 
off-page connectors, the Browse spreadsheet editor appears.

Double-click on an off-page connector to view it in the schematic page 
editor.

Shortcuts: Keyboard: ALT, E, B, O

Available from: Edit menu, Browse command

Function:

Use this command to list the title blocks of the selected schematic pages 
in the browse window. When you edit a title block, the User Properties 
dialog box appears. Double-click on a title block to view it in the 
schematic page editor.

Shortcuts: Keyboard: ALT, E, B, T
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Bookmarks command

DRC Markers command

Flat Netlist command

Available from: Edit menu, Browse command

Function:

Use this command to list the bookmarks of the selected schematic 
pages in the browse window. Bookmarks are useful for marking a 
particular spot in your design.

You can select single or multiple bookmarks and edit them with the 
Properties command. When you edit one bookmark, the Edit Bookmark 
dialog box appears. When you select multiple bookmarks, the Edit Part 
Properties dialog box appears.

Double-click on a bookmark to view it in the schematic page editor.

Shortcuts: Keyboard: ALT, E, B, B

Available from: Edit menu, Browse command

Function:

Use this command to list the DRC markers of the selected schematic 
pages in the browse window. DRC markers are placed on pages by the 
Design Rules Check tool. They are useful when troubleshooting your 
design before creating a netlist.

You can select single or multiple DRC markers and edit them with the 
Properties command. When you edit one DRC marker, the View DRC 
Marker dialog box appears. When you select multiple DRC markers, the 
Browse spreadsheet editor appears.

Double-click on an DRC marker to view it in the schematic page editor.

Shortcuts: Keyboard: ALT, E, B, D

Available from: Edit menu, Browse command
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Power Pins command

Find command

Function:

Use this command to list the nets of the design, as they will appear in a 
netlist.

You can select single or multiple nets and edit them with the Properties 
command. When you edit nets, the property editor window appears.

Double-click on a net to view it in the schematic page editor.

Shortcuts: Keyboard: ALT, E, B, F

Available from: Edit menu, Browse command

Function:

Use this command to list the power pins in the design.

You can choose the view mode as occurrences or instances from the 
Browse Properties dialog.

Shortcuts: Keyboard: ALT, E, B, W

Available from: Edit menu
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Rename Part Property command

Function:

Use this command to locate an object or string of text in a design.

In the schematic page editor and project manager, the Find command 
finds all instances of the specified text search string, parts, part pins, 
DRC markers and constraints. The Find command supports wildcard 
searches. Use an asterisk (*) to match any string of characters, and a 
question mark (?) to match any single character.

In the session log, the Find command will find the next occurrence of the 
specified text search string from the current position. However, it does 
not support wildcard searches.

The Find window in part editor can search only pin and text, and it 
supports wildcard searches.

In the design variant schematic page, the Find command will find parts 
that are not present or parts with different property values attached to it.

This command can be used to search at different levels of a design 
folder hierarchy in the Project manager.

The search command can be executed at any of the following levels or 
selections of the design folder hierarchy:

■ Design Level

■ Folder level - For any number of selected folders within the design

■ Page Level - For any number of selected pages within the design. 
This includes pages selected from different folders.

Note: The command also allows multi-level selection. This means you 
can simultaneously select folder and pages.

The search command can also be executed on an open schematic page.

Shortcuts:

Keyboard:

■ CTRL+F

■ ALT, E, F

Available from: Edit menu
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Delete Part Property command

Replace command

Go To command

Function:

Use this command to rename a part property for every placed part that 
includes the property for an entire design.

Note: This command is available only when you have selected the design 
(.DSN) or the schematic page(s) in the Project Manager window.

Shortcuts: Keyboard: ALT, E, Y

Available from: Edit menu

Function:

Use this command to delete a part property from every placed part in a 
design.

Note: This command is available only when you have selected the design 
(.DSN) or the schematic page(s) in the Project Manager window.

Shortcuts: Keyboard: ALT, E, D

Available from: Edit menu

Function:
Use this command to find and replace a particular string in a text editor 
window. When you choose Replace from the Edit menu, the Replace 
dialog box appears.

Shortcuts: Keyboard: ALT, E, E

Available from: Edit menu
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Clear Session Log command

View

Toolbar command on page 53

Capture Toolbar command on page 53

Draw Toolbar command on page 53

PSpice Toolbar command on page 54

 on page 54

 on page 54

Function:

Use this command to center the view on a specific location, grid 
references, or bookmark. By clicking the Go To command, the Go To 
Line dialog box dialog box appears.

Note: The Go To command is always available on the right mouse button 
context-sensitive menus in the part editor and schematic page editor. The 
Go To command, with the Relative option selected, is particularly useful 
for precise placement and spacing.

Shortcuts:

Keyboard:

■ CTRL+G

■ ALT, E, G

Available from: Edit menu

Function:
Use this command to clear the Session log.

Note: This command is only available if the Session log is selected.

Shortcuts:

Keyboard:

■ CTRL+DEL

■ ALT, E, S
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Toolbar command

Capture Toolbar command

Draw Toolbar command

Available from: View menu

Function:

Use this command to show or hide the toolbars. This setting is stored in 
your .INI file and thus affects the visibility of the toolbar in subsequent 
sessions. You can move the toolbars anywhere on the screen by 
pressing the left mouse button over the toolbar, and then moving the 
mouse to the toolbar's new location. If the toolbar is moved to any edge 
of the window, the toolbar snaps into place. Otherwise, it floats on the 
screen wherever it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Shortcuts: Keyboard: ALT, V, T

Available from: View – Toolbar menu

Function:

Use this command to show or hide the Capture toolbar. This setting is 
stored in your .INI file and thus affects the visibility of the toolbar in 
subsequent sessions. You can move the toolbar anywhere on the screen 
by pressing the left mouse button over the toolbar, and then moving the 
mouse to the toolbar's new location. If the toolbar is moved to any edge 
of the window, the toolbar snaps into place. Otherwise, it floats on the 
screen wherever it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Available from: View - Toolbar menu
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PSpice Toolbar command

Command Window command

Function:

Use this command to show or hide the Draw toolbar. This setting is 
stored in your .INI file and thus affects the visibility of the toolbar in 
subsequent sessions. You can move the toolbar anywhere on the screen 
by pressing the left mouse button over the toolbar, and then moving the 
mouse to the toolbar's new location. If the toolbar is moved to any edge 
of the window, the toolbar snaps into place. Otherwise, it floats on the 
screen wherever it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Available from: View - Toolbar menu

Function:

Use this command to show or hide the PSpice toolbar. This setting is 
stored in your .INI file and thus affects the visibility of the toolbar in 
subsequent sessions. You can move the toolbar anywhere on the screen 
by pressing the left mouse button over the toolbar, and then moving the 
mouse to the toolbar's new location. If the toolbar is moved to any edge 
of the window, the toolbar snaps into place. Otherwise, it floats on the 
screen wherever it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Available from: View - Toolbar menu

Function:

Use this command to open the TCL Command window in the OrCAD 
Capture workspace.

For details see the Command Window.
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Tools menu

Annotate command on page 55

Update Properties command on page 55

Bill of Materials command on page 56

Export Properties command on page 57

Import Properties command on page 58

Generate Part command on page 59

Split Part command on page 61

Customize command on page 61

Annotate command

Update Properties command

Available from: Tools menu

Function:

Use this command to update part references in the active design. You 
specify the scope and parameters of the update in the Annotate dialog 
box.

Annotate will update references for primitive hierarchical blocks. For 
example, you could specify the reference to be "Halfadd?" when you 
place a hierarchical block. Then, when you run Annotate, the hierarchical 
block's reference is updated along with other parts.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ ALT, T, O

Available from: Tools menu
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Bill of Materials command

Function:

Use this command to update properties based on an update file. This 
command constructs a combined property string for a part or net. Then, 
if that string matches a string in the update file, it replaces the specified 
properties of the combined property string with the update string 
properties. Capture update files use a .UPD file extension.

If you are updating net properties, Capture will ll of the nets in the 
schematic folder even if only one schematic page is selected. Capture 
updates all of the nets in the schematic folder because a single net can 
appear on more than one schematic page within the schematic folder. 
Capture only updates the selected schematic folders and schematic 
pages when updating part properties.

Tip

Capture report files are text files, and can be opened in any text 
editor. You may want to use the tab alignment capability of your 
word processor to line reports up correctly. Spreadsheets will 
automatically align the columns of Capture-generated report 
files.

Shortcuts: Keyboard: ALT, T, U

Available from: Tools menu

Function:
Use this command to create a summary list of all parts used in the 
design. You can also use an include file to add information to the bill of 
materials. By default, Capture include files use a .INC file extension.

Important

Reference designators should not exceed 24 characters. When 
Bill of Materials encounters a reference designator that is longer 
than 24 characters, an error occurs and the bill of materials isn't 
generated.
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Export Properties command

Important

Capture report files are text files, and can be opened in any text 
editor. You may want to use the tab alignment capability of your 
word processor to line reports up correctly. Spreadsheets will 
automatically align the columns of Capture-generated report 
files.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ ALT, T, B

Available from: Tools menu

Function:

Use this command to write the properties of the selected documents to 
an ASCII text file. Properties are delimited by tabs so the file is suitable 
for manipulation by spreadsheet or database software. You can export 
properties from a design or library.

For more information on property files see .

Important

If you add, delete, or reorder lines in a project's property file, the 
file cannot be imported.

If you move a PART line in a design property file created in a 
library property file, be sure to move all the PIN lines associated 
with it and keep them in the same order. Otherwise, importing 
the file may fail or cause unwanted changes to your project or 
library.

In every case, it is much safer to refrain from adding, deleting, or 
reordering the lines in a property file.
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Import Properties command

Note: It is a good idea to update part references before you export 
properties.

Because various popular spreadsheet and database applications behave 
differently, Capture can import properties with or without enclosing 
quotation marks around each field in the property file. The fields must be 
tab-delimited, though—all other characters, including commas and 
leading and trailing spaces, are treated as part of a field's text. Be sure 
your spreadsheet or database program can save in this format.

Shortcuts: Keyboard: ALT, T, E

Available from: Tools menu

Function:

Use this command to import the contents of a tab-delimited property file. 
The imported properties may add to or supersede existing properties. 
The property file must be in the format used by Capture when you 
choose the Export Properties command from the Tools menu. You can 
import properties to a design or library.

For more information on property files see .

The Import Properties command opens a standard Windows dialog box 
for opening files.

Important

If you add, delete, or reorder lines in a project's property file, the 
file cannot be imported.

If you move a PART line in a design property file created in a 
library property file, be sure to move all the PIN lines associated 
with it and keep them in the same order; otherwise, importing 
the file may fail or cause unwanted changes to your project or 
library.

In every case, it is much safer to refrain from adding, deleting, or 
reordering the lines in a property file.
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Generate Part command

Note: It is a good idea to update part references before you export 
properties.

Because various popular spreadsheet and database applications behave 
differently, Capture can import properties with or without enclosing 
quotation marks around each field in the property file. The fields must be 
tab-delimited, though—all other characters, including commas and 
leading and trailing spaces, are treated as part of a field's text. Be sure 
your spreadsheet or database program can save in this format.

Note: If Capture finds errors in the property file, the project or library 
remains unchanged. There is no risk that some parts will be changed and 
others not.

Shortcuts: Keyboard: ALT, T, I

Available from: Tools menu
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Function:

Use this command to create a library and an associated part that 
represents your design. You can use a schematic, a library containing 
schematics, or a netlist to generate a symbol for the project.

You can use the symbol you generate with the Generate Part command 
to represent the actual component (such as an FPGA or CPLD) in 
schematic designs or other projects. When you use the Generate Part 
command, Capture creates a library file (.OLB) and part based on the 
pins defined in the report file or schematic and references it in the 
Outputs folder of the project manager. If the library already exists, the 
new part is appended to the existing library. If the part already exists in 
the library, the new part replaces it.

Note: If the schematic from which you generate a part has one or more 
Param symbols, the entries in that symbol are placed on the resulting part 
as user properties. You can then overwrite default values for those 
properties on a specific instance or occurrence.

The Generate Part dialog box offers a number of netlist and source file 
types that are used to generate a part or symbol. The Capture 
Schematic/Design source file type uses a library or a single schematic to 
create the new .OLB containing the new part and a copy of the schematic 
for easy portability and design reuse. You can use this source type to 
create a design reuse module.

Capture reads a variety of PLD vendor pin reports to create library parts 
for the Capture schematic system. Most PLD vendor pin reports describe 
the pin number, signal name, and direction (or mode) of a package pin 
programmed by the place-and-route process. Pins are sorted 
alphabetically by name, with input type pins located on the left-hand side, 
and output or bidirectional pins on the right-hand side.

Generate part can create new parts or update the pin numbers of an 
existing library part with the Update pins on existing part in library option, 
which allows for engineering change orders (ECOs) from a 
programmable logic project to update the part symbol of the system 
schematic.

Note: To create a pin on a symbol using the Generate Part utility, the pin 
must have a pin to port mapping in the pin file.

Shortcuts: Keyboard: ALT, T, G
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Split Part command

Customize command

PSpice

Bias Points command on page 62

New Simulation Profile command on page 62

Edit Simulation Profile command on page 62

Run command on page 63

View Simulation Results command on page 63

View Output File command on page 64

Make Active command on page 64

Simulate Selected Profile(s) command on page 64

Available from: Tools menu

Function:

Use this command to divide a part into multiple sections.

Note: You need to select a single-sectioned part from a library. You can 
split a multi-sectioned part only when it has been split already using this 
command.

Shortcuts: Keyboard: ALT, T, L

Available from: Tools menu

Function:

Use this command to customize the OrCAD Capture menus.

You can:

■ choose the menus to show and hide.

■ add or remove buttons (commands) from the menus.

■ create a custom menu and add buttons (commands) to the menu.
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Create Netlist command on page 65

View Netlist command on page 66

Marker List command on page 66

Bias Points command

New Simulation Profile command

Edit Simulation Profile command

Available from: PSpice menu, Bias Points submenu

Function:

From a schematic page, point to Markers on the PSpice menu.

Use the commands in the Bias Points submenu to enable and disable 
bias point display, toggle selected bias points and to set preferences for 
displaying and printing bias points.

Shortcuts: Keyboard: ALT, S, B, E

Available from: PSpice menu

Function:

You must create a simulation profile (or edit an existing one) before you 
can set up a PSpice simulation. Use this command to create a new 
simulation profile. A simulation profile (*.SIM) saves your simulation 
settings for an analysis type so you can reuse them easily.

After creating a new profile, you can edit the settings with the Edit 
Simulation Settings command.

Shortcuts:

PSpice Toolbar: 

Keyboard:

■ ALT, S, N

Available from: PSpice menu

Function:
Use this command to edit an existing PSpice simulation profile. 
Simulation profiles can be edited in Capture and PSpice.
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Run command

View Simulation Results command

Shortcuts:

PSpice Toolbar: 

Keyboard:

■ ALT, S, E

Available from: PSpice menu

Function:

After setting all the simulation parameters you need, choose Run to 
perform the simulation. This command automatically performs the 
following steps:

■ checks design rules for your design.

■ creates a simulation netlist for PSpice.

■ opens PSpice using the netlist created from your design.

PSpice creates an output file (.OUT) as the simulation progresses. It 
contains bias point information, model parameter values, error 
messages, and so on. If the simulation fails, you can view the output file 
to see the error messages.

If the simulation completes successfully, PSpice produces a data file 
(.DAT). This is the file PSpice uses to display the simulation results.

To see marker simulation results, the schematic must be open.

Note: You can run PSpice simulations from the Capture environment by 
pressing the F11 function key.

Shortcuts:

PSpice Toolbar: 

Keyboard:

■ ALT, S, R

Available from: PSpice menu
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View Output File command

Make Active command

Simulate Selected Profile(s) command

Function:

Use this command to view the most recent simulation results, for the 
active simulation profile. To see marker simulation results, the schematic 
must be open.

Note: You can view the simulation results from the currently active profile 
by pressing the F12 function key.

Shortcuts:

PSpice Toolbar: 

Keyboard:

■ ALT, S, V

Available from: PSpice menu

Function:
Use this command to view the most recent output file for the current 
design.

Shortcuts: Keyboard: ALT, S, W

Available from: PSpice menu

Function:
Use this command, with the project manager active, to make the 
selected simulation profile the active profile. In the project manager, the 
simulation profile folder is in the PSpice Resources folder.

Available from: PSpice menu
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Create Netlist command

Function:

Use this command, with the project manager active, to simulate selected 
profiles.

Simulate Selected Profile(s) automatically performs the following steps:

■ Checks design rules for your design.

■ Creates a simulation netlist for PSpice.

■ Opens PSpice using the netlist created from your design.

You can select one profile or multiple profiles to be simulated or viewed. 
If you select only one profile for simulation, it is handled as though you 
chose the Run command. If you select one file for viewing, it is handled 
as though you chose the View Simulation Results command.

If you select multiple profiles, simulations for all selected profiles are 
performed using the simulation queue. You must then open the .DAT files 
to view the results.

See  for procedures to simulate and view multiple profiles.

Shortcuts: Keyboard: ALT, P, A

Available from: PSpice menu

Function:

Use this command to create a simulation netlist for the current design. 
The netlist is generated for all levels of hierarchy, starting from the top, 
regardless of whether you are pushed into any level of the hierarchy.

In OrCAD Capture, the TEMPLATE property specifies the primitive parts' 
contributions to the netlist. In the process of creating the netlist, buses, 
connectors, and so on, are resolved. Only parts with a TEMPLATE 
property are included in the simulation.

During the netlist process, Capture creates several files with different 
extensions: The .NET file contains the netlist; the .CIR file contains 
simulation commands; and the .ALS file contains alias information.

Shortcuts: Keyboard: ALT, S, C
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View Netlist command

Marker List command

Options menu

Autobackup command on page 66

Preferences command on page 67

Design Template command on page 71

Design Properties command on page 72

Autobackup command

Available from: PSpice menu

Function:
Use this command to view the most recent simulation netlist for a 
selected or the current design.

Shortcuts: Keyboard: ALT, S, I

Available from: PSpice menu

Function:

From the Project Manager, choose Marker List from the PSpice menu.

Use this command to display or hide markers in the design. The Markers 
dialog box displays markers that exist in the profile. An empty check box 
beside a marker indicates that the marker is hidden. If a marker is 
hidden, it will not appear in Capture but it will still exist in the profile.

Shortcuts: Keyboard: ALT, S, L

Available from: Options menu
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Preferences command

More Preferences command

Function:

Determines the frequency, location, and the number of copies of 
autobackup done by Capture. 

The Multi-level backup Settings dialog box appears when you choose 
Autobackup option from the Options menu. 

Enter the values for the following fields to determine the duration, 
number of backups, and its storage.

Backup time (in minutes) - Enables you to determine the time after 
which Capture will perform automatic backup.

No of backups to keep - Enables you to determine the total number of 
backups that will be stored.

Directory for backup - Enables you to determine the storage location 
for the backup

Shortcuts: Keyboard: ALT, O, B

Available from: Options menu

Function:
Use this command to set your environment preferences for the current 
project (and all future projects) on your system. The options you specify 
affect the behavior of the software, and are saved in the .INI file.

Shortcuts: Keyboard: ALT, O, P

Available from: Options menu, Preferences submenu
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Function:

Use this command to set extended environment preferences for the 
current project (and all future projects) on your system. The options you 
specify affect the behavior of the software, and are saved in the .INI file.

Command Shell

These commands are related to the TCL command window in Capture.

■ Journaling: Select the option to enable journaling of the various 
Capture commands, including TCL commands.

■ Flush Commands: Select the option to print the journaling 
commands in a text file. By default, the text file is saved in the TEMP 
folder (<%TEMP%>\CAPTURELOG\<%DATE%>\ 
OrCaptureLogFile.captcl)

■ Display Commands: Select the option to enable display of Capture 
commands in Command Window.

Design and Libraries

These commands are related to Capture’s designs and libraries.

■ Content text instance properties: Select the option to rotate the 
instance part properties along with the instance part on the same 
axis.

■ Draw arrow on part input pins: Select the option to draw arrow on 
part’s input pins.

■ Enable communication with legacy tools: Select the option to 
enable message-based communication with the legacy tools, such 
as OrCAD Layout. 

Note: By default, message-based communication is not enabled in 
OrCAD Capture. Enable this option if you want OrCAD Capture to 
communicate with the legacy tool as it impacts OrCAD Capture’s 
performance.

■ Perform read only check on tab switch: Select the option to enable 
Capture to check the library and design files’ permissions on every 
switch of tab.

Note: Unselecting the option improves user experience as Capture 
ignores the permissions check on the design and library files.
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Functions

■ Save design name as UPPERCASE: Select the option to save the 
design file name (.dsn) in uppercase letters.

■ Enable global net ITC: Select the option to start cross probing of 
global nets.

■ Convert images to BMP format: Select the option to convert all 
format images to .bmp internally.

■ Path lookup timeout (in seconds): Specify the time out time in 
seconds if the design or library files are found at the configured 
locations.

■ Net Naming Options (requires application restart): The drop 
down menu options provides different options to select how Capture 
generates flat-net names for complex hierarchy designs. By default, 
flatname has a hierarchy block path. Following are the drop down 
options:

❑ Append hierarchy on collision: Appends hierarchical path to 
the conflicting flat nets only (for global nets, numeric ID is used). 
The flat net that is closest to the root design and is the only flat 
net at that level is not renamed.

❑ Always append hierarchy: Appends hierarchical path to all the 
flat nets except those in root schematic. For global nets, numeric 
ID is used as they do not have any hierarchical path.

❑ Append ID on collision: Appends numeric IDs to all the 
conflicting flat nets only. The flat net that is closest to the root 
schematic and is the only flat net at that level, is not renamed.

❑ Always append ID: Appends numeric IDs to all the flat nets 
except those in the root schematic.

Design Cache

■ Update Cache: Select the Default or Forced option to update cache 
in Capture. Selecting Forced will update the selected library even 
if it is older than the original library file in the Design Cache.
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Functions:

DRC

Select the Display Waived DRC check box to display all the waived 
DRCs on a schematic page.

NetGroup

The following options, which are related to NetGroups, will be set only for 
the current active design:

■ Never

■ Always

■ Only when mismatch (definition name mismatched instance name)

Netlist

This command is related to Netlisting in Capture.

■ Apply Allegro Character Limits on All Projects

Select this option to set the character limit globally for all the projects.

Schematic

These commands are related to Schematic page in Capture.

■ Schematic Descend

The following three modes are used for schematic descend:
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Design Template command

Default: Opens the default page of child schematic

First: Opens the first page of child schematic (alphabetical-wise)

Ask: Asks user to select one of the schematic page from the list of 
schematic pages.

■ Junction Mode

The following two modes are used for junctioning in Capture:

❑ Default

Select this option to place a junction at a straight wire break point.

❑ Junction on multiple connections on wire end

Select this option to create a junction when there are multiple 
connections on a wire end.

Note: It is recommended that in order to create a junction 
automatically on placing a wire, you should first select the Junction 
on multiple connections on wire end option and then place 
the wire.

■ Display underscore (_) on User Assigned Part References 
on Schematic Page

Select this option to display underscore (_) symbol on user-assigned 
part references on a schematic page.

■ Display underscore (_) on User Assigned Part References in 
Page Print

Select this option to display underscore (_) symbol on user-assigned 
part references in page or design print.

■ Distribute in a fixed area (may cause uneven distribution)

Select this option to distribute the selected objects in a fixed area.

Note: For the TCL commands for these options, see 

Available from: Options menu
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Design Properties command

Window menu

New Window command on page 73

Cascade command on page 73

Tile Horizontally command on page 73

Tile Vertically command on page 73

Close All Tabs of Active Project command on page 74

Close All Tabs of Active Project Except Current command on 
page 74

Arrange Icons command on page 74

1,2.... command on page 74

Close All Windows on page 75

Function:
Use this command to specify default settings for new projects, designs, 
and schematic pages. The values specified in this dialog box do not 
affect existing projects or designs.

Note: To change the properties of an active design, use the Design 
Properties command. To change the properties of an active schematic 
page, use the Schematic Page Properties command. You cannot change 
the default title block of an active schematic page.

Shortcuts: Keyboard: ALT, O, D

Available from: Options menu

Function:
Use this command in the project manager to globally set design related 
options throughout a design.

Note: To change the properties for objects in new designs, use the 
Design Template command.

Shortcuts: Keyboard: ALT, O, R
June 2020 72 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Project manager command reference
New Window command

Cascade command

Tile Horizontally command

Tile Vertically command

Available from: Window menu

Function:
Use this command to create a new window, which is a copy of the 
currently active window. This new window is another "view" on the same 
data, and you can scroll the two windows to different positions.

Shortcuts: Keyboard: ALT, W, N

Available from: Window menu

Function:
Use this command to "stack" all open Capture windows so that just their 
title bars are visible. The active window stays on top.

Shortcuts: Keyboard: ALT, W, C

Available from: Window menu

Function:
Use this command to arrange open Capture windows, one above 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, H

Available from: Window menu

Function:
Use this command to arrange open Capture windows, one beside 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, V
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Close All Tabs of Active Project command

Close All Tabs of Active Project Except Current 
command

Arrange Icons command

1,2.... command

Available from: Window menu

Function: Use this command to close all tabs of the active project.

Shortcuts: Keyboard: ALT, W, C

Available from: Window menu

Function:
Use this command to close all tabs of the active project except the tab 
that is currently active. This option is not available for the Project 
Manager tab.

Shortcuts: Keyboard: ALT, W, C

Available from: Window menu

Function:
Use this command to arrange the icons for minimized windows across 
the bottom of the session frame.

Shortcuts: Keyboard: ALT, W, A

Available from: Window menu
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Close All Windows

Help menu

PSpice for TI Help command on page 75

Known Problems and Solutions command on page 76

What’s New command on page 76

About PSpice for TI command on page 76

Documentation command on page 76

Note: To use the context-sensitive menu commands, select one or 
more items, then press the right mouse button. The contents of the 
menu differ depending on the objects selected.

PSpice for TI Help command

Function:

Use the numbers listed at the bottom of the Window menu to view which 
windows are currently open, and to determine which window is active. 
(The active window is indicated by a check mark.) When you choose a 
window from this list, Capture restores that window if it was in icon form, 
pops it to the front of the Capture session, and makes it the active 
window.

Shortcuts: Keyboard: ALT, W, n (n = 1, 2, . . .)

Available from: Window menu

Function: Use this command to close all open windows.

Available from: Help menu

Function: Use this command to display the Capture help window.

Shortcuts: Keyboard: ALT, H, H or F1
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Known Problems and Solutions command

What’s New command

About PSpice for TI command

Documentation command

Available from: Help menu

Function:
Use this command to display a document listing the known problems in 
this release of OrCAD Capture and tells you how to solve or work around 
these problems.

Shortcuts: Keyboard: ALT, H, K

Available from: Help menu

Function:
Use this command to display a document describing the new features 
and enhancements in this release.

Shortcuts: Keyboard: ALT, H, K

Available from: Help menu

Function:
Use this command to get the software version number, copyright 
information, registration number, and license information.

Shortcuts: Keyboard: ALT, H, A

Available from:
In the project manager or schematic page editor, from the Help menu, 
choose Documentation.

Function:

Use this command to launch the help landing HTML page, which 
contains links to all the documentation types (manuals and online help), 
product tutorial, and multimedia demonstrations shipped with this 
product release.

Shortcuts: Keyboard: ALT, H, D
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Pop-Up Menu

This section covers:

Add File command on page 78

Annotate command on page 78

Change Project Type command on page 78

Cleanup Cache command on page 78

Copy command on page 79

Cut command on page 79

Delete command on page 79

Design Properties command on page 79

Edit Object Properties command on page 79

Edit Page command on page 80

Edit selected object properties command on page 80

Find command on page 80

Lock command on page 80

Make Root command on page 80

New Page command on page 81

New Schematic command on page 81

Open File Location command on page 81

Paste command on page 81

Paste command on page 81

Properties command on page 81

Rename command on page 81
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Reports – Export Placement command on page 81

Reports – Export Properties command on page 81

Save command on page 82

Save As command on page 82

Save Project As command on page 82

Schematic Page Properties command on page 82

UnLock command on page 82

Add File command

See Project command on page 42

Annotate command

See Annotate command on page 55

Change Project Type command

Cleanup Cache command

See Cleanup Cache command on page 37

Available from:
In the project manager, from the pop-up menu for Design Resources or 
the DSN file.

Function:

Use this command to change the type of a project to any of the following

project types:

❑ Analog or Mixed A/D

❑ PC Board Wizard

❑ Programmable Logic Wizard

❑ Schematic.
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Copy command

See Copy command on page 39

Cut command

See Cut command on page 39

Delete command

Design Properties command

See Design Properties command on page 72

Edit Object Properties command

Available from: In the project manager, from the pop-up menu

Function:

Use this command to delete the selected schematic folders, schematic 
pages, parts, and symbols that are listed in the project manager window.

Caution

Deleting schematic folders, schematic pages, parts, and 
symbols is permanent. You cannot use the Undo 
command to bring back deleted items from the project 
manager.

Shortcuts

DELETE

BACKSPACE

DEL

Available from: In the project manager, from the pop-up menu
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Edit Page command

Edit selected object properties command

Find command

See Find command on page 49

Lock command

See Lock command on page 41

Make Root command

See Make Root command on page 33

Function:

Use this command to edit the properties of project objects in the project

manager.

The command is available for at the:

❑ design level

❑ folder level

❑ page level

Available from: In the project manager, from the pop-up menu for schematic pages

Function: Use this command to open a page for edit

Available from: In the project manager, from the pop-up menu for schematic pages

Function: Use this command to property editor for selected components
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New Page command

See New Schematic Page command on page 31

New Schematic command

See New Schematic command on page 31

Open File Location command

Paste command

See Paste command on page 40

Properties command

See Properties command on page 42

Rename command

See Rename command on page 33

Reports – Export Placement command

See Import Properties command on page 58

Reports – Export Properties command

See Export Properties command on page 57

Available from: In the project manager, from the pop-up menu for DSN folder

Function: Use this command to open the location of the design
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Save command

See Save command on page 26

Save As command

See Save As command on page 26

Save Project As command

See Save Project As on page 27

Schematic Page Properties command

UnLock command

See UnLock command on page 41

Available from: In the project manager, from the pop-up menu for schematic pages

Function: Use this command to open the Schematic Page Properties dialog box
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3
Schematic page editor and 
part editor command 
reference

This chapter covers:

■ File menu on page 83

■ Edit menu on page 92

■ View menu on page 114

■ Place menu on page 125

■ PSpice/Markers menu on page 144

■ Options menu on page 148

■ Window menu on page 150

■ Help menu on page 152

■ Pop-up menu on page 154

File menu

This section covers:

New command on page 84

Open command on page 86

Close command on page 88

Save command on page 88

Export Selection command on page 89
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Import Selection command on page 89

Print Preview command on page 90

Print command on page 90

Print Setup command on page 90

Print Area command on page 91

Import Design command on page 91

Export Design command on page 92

1,2,3,4 command on page 92

Exit command on page 92

New command

Available from: File menu

Function:

Use this command to create a new project, design, or library. Choose a 
command from the menu that appears:

Project

Design

Library

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see 1,2.... command).

You can open an existing project, design, library, or VHDL file using the 
Open command on the File menu.

If you click the Create document toolbar button from a schematic page 
editor, the New Page in Schematic dialog box appears.

If you click the Create document toolbar button from the part editor, the 
New Part Properties dialog box appears.

Shortcuts: Keyboard: ALT, F, N
June 2020 84 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Schematic page editor and part editor command reference
New Project command

New Design command

New Library command

New VHDL File command

Available from: File menu, New command

Function: Use this command to create a new project in Capture. 

Shortcuts:
Keyboard: 

ALT, F, N, P

Available from: File menu, New command

Function:
Use this command to create one schematic folder with one schematic 
page, which Capture opens in the schematic page editor.

Shortcuts:
Keyboard: 

ALT, F, N, D

Available from: File menu, New command

Function:
Use this command to create a new library (containing no parts or 
symbols) with a library cache folder.

Shortcuts: Keyboard: ALT, F, N, L

Available from: File menu, New command

Function:
Use this command to create a new VHDL File, opened in Capture's text 
editor.

Shortcuts: Keyboard: ALT, F, N, V
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New Verilog File command

New Text File command

Open command

Available from: File menu, New command

Function:
Use this command to create a new Verilog File, opened in Capture's text 
editor.

Shortcuts: Keyboard: ALT, F, N, V

Available from: File menu, New command

Function:
Use this command to create a new text file, opened in Capture's text 
editor.

Shortcuts: Keyboard: ALT, F, N, T

Available from: File menu

Function:

Use this command to open an existing project, design, library in a new 
window. Choose a command from the menu that appears:

■ Design

■ Library

■ Project

■

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see 1,2.... command).

Note: When you choose the Open button on the toolbar, a standard 
Windows Open dialog box appears, in which you can choose the type of 
file you want to open in the Files of type drop-down list. Among the listed 
choices are SDT Schematic (*.SCH) and SDT Library (*.LIB).

Shortcuts:
Capture Toolbar: 

Keyboard: ALT, F, O
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Open Project command

Open Design command

Open Library command

Open VHDL File command

Open Verilog File command

Available from: File menu, Open command

Function: Use this command to open an existing project.

Shortcuts: Keyboard: ALT, F, O, P

Available from: File menu, Open command

Function:
Use this command to open one schematic folder with one schematic 
page, which Capture opens in the schematic page editor.

Shortcuts: Keyboard: ALT, F, N, D

Available from: File menu, Open command

Function:
Use this command to open a library (containing no parts or symbols) 
with a library cache folder.

Shortcuts: Keyboard: ALT, F, O, L

Available from: File menu, Open command

Function: Use this command to open a VHDL File, opened in Capture's text editor.

Shortcuts: Keyboard: ALT, F, O, V

Available from: File menu, Open command
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Open Text File command

Close command

If you open a part editor via the Part command on the Edit menu, 
modify the part, and then close it, Capture asks if you want to update 
the current part only, ll parts of this type in the design, discard your 
changes, or cancel the Close command.

Save command

Function:
Use this command to open a Verilog File, opened in Capture's text 
editor.

Shortcuts: Keyboard: ALT, F, O, E

Available from: File menu, Open command

Function: Use this command to open an existing text file in a text editor

Shortcuts: Keyboard: ALT, F, O, T

Available from: File menu

Function:
Use this command to close the active window. If necessary, you are 
prompted to save your changes.

Shortcuts: Keyboard: ALT, F, C

Available from: File menu

Function:

Use this command to save the active, modified projects, designs, 
libraries, and VHDL files. You can save a design, library, VHDL file, or 
session log under a different name using the Save As command on the 
File menu.

Note: When you save a project, Capture automatically creates a backup 
with a .DBK file extension. When you save a library, Capture automatically 
creates a backup with a.OBK file extension. If you save only a schematic 
page or part, no backup is generated.
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Export Selection command

Import Selection command

Export ISCF command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+S

■ ALT, F, S

Available from: File menu

Function:

Use this command to export the selected objects on a schematic page to 
a design or library. You can later import them onto a schematic page 
using the Import Selection command on the File menu.

This is useful if you have portions of a schematic page that you want to 
use on different schematic pages.

Shortcuts: Keyboard: ALT, F, E

Available from: File menu

Function:
Use this command to import the contents of a file created with the Export 
Selection command on the File menu to the active schematic page.

Shortcuts: Keyboard: ALT, F, I

Available from: File menu, Export Command

Function:
Use this command to export the contents of selected design to Inter 
Schematic Export Format (ISCF).

Shortcuts: Keyboard: ALT, F, I
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Print Preview command

Print command

Print Setup command

Available from: File menu

Function:

Use this command to see how a schematic page or part will look when 
printed.

After setting the options in the Print Preview dialog box, click OK to 
preview the printed document. You can use the buttons at the top of the 
window to view different pages and to zoom in and out.

Note: Be prepared to wait if you attempt to print multiple pages or parts. 
Depending on the number and size of the pages or parts you are 
previewing, Capture may require extra time to display the selection.

Shortcuts: Keyboard: ALT, F, V

Available from: File menu

Function:
Use this command to print the active schematic page, the active part, or 
the selected items in the project manager.

Note: When you print multiple copies, the copies are grouped by page, 
not sorted by copy.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+P

■ ALT, F, P

Available from: File menu

Function:

Use this command to choose a printer, paper source, and orientation 
before printing. The Print Setup command displays the Print Setup 
dialog box, a standard windows dialog box for configuring your printer or 
plotter. For more information on setting up printers and plotters, refer to 
the documentation for your configured printer driver.
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Print Area command

Clear command

Import Design command

Tip

Many times, the options for your printer are not available in the 
standard setup dialog box. If you do not find the options you 
need, try the printer setup in the Windows Control Panel.

Shortcuts: Keyboard: ALT, F, R

Available from: File menu

Function:

Use this command in the schematic page editor to select and set or clear 
a specific area to print on your schematic page. Choose a command 
from the menu that appears:

■ Set

■ Clear

Shortcuts: Keyboard: ALT, F, A

Available from: File menu

Function:
Use this command to clear a print area setting from the active schematic 
page. The print area setting also clears automatically when you close the 
schematic page.

Shortcuts: Keyboard: ALT, F, A, C

Available from: File menu

Function:

Use this command to import EDIF, PDIF and PSpice designs. EDIF 
designs must be graphical EDIF designs, and not EDIF netlists. Not all 
imported PDIF parts may be edited in Capture. Such parts won't affect 
netlists.
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Export Design command

1,2,3,4 command

Exit command

Edit menu

This section covers:

Undo command on page 93

Available from: File menu

Function:

Use this command to export EDIF designs and DXF schematic pages. 
This command saves EDIF designs as graphical EDIF designs, and not 
EDIF netlists. DXF schematic pages are saved in AutoCAD's V12 file 
format.

Available 
from:

File menu

Function:
Use the numbers listed at the bottom of the File menu to open one of 
the last four projects or files. Choose the file you want to open.

Shortcuts: Keyboard: ALT, F, n (n = 1, 2, 3, or 4)

Available from: File menu

Function:

Use this command to exit the software. If necessary, you are prompted 
to save your changes.

You can also exit the software by choosing the Close command on the 
session frame Control menu (ALT, SPACEBAR, C).

Shortcuts:

Keyboard:

■ ALT+F4

■ ALT, SPACEBAR, C

■ ALT, F, X
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Redo command on page 94

Repeat command on page 95

Label State commands on page 96

Cut command on page 96

Copy command on page 97

Paste command on page 97

Delete command on page 98

Label command on page 99

Select All command on page 100

Part command on page 100

Properties command on page 101

Properties command on page 101

Part command on page 103

Mirror command on page 105

Rotate command on page 106

Lock command on page 107

UnLock command on page 107

Find command on page 107

Global Replace command on page 108

Align Command on page 109

Undo command

Available from: Edit menu
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Redo command

Function:

Use this command to reverse the effect of the last operation, if possible.

You can perform the undo and redo operation multiple times to return 
your design to any particular state, as described in .

The Undo command applies to the following actions:

■ Placing

■ Deleting

■ Moving

■ Resizing

■ Rotating

■ Mirroring

■ Pasting

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+Z

■ ALT, E, U

Available from: Edit menu

Function:
Use this command to reverse the effect of the most recent Undo 
command. You can undo and redo multiple commands to return your 
design to any particular state, as described in .

The Redo command applies to the following actions:

■ Placing

■ Deleting

■ Moving

■ Resizing

■ Rotating

■ Mirroring
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Repeat command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+Y

■ ALT, E, E

Available from: Edit menu

Function:

Use this command to repeat the last operation on the currently selected 
object, when the last operation can be repeated. The name of the 
command changes, depending on what the last repeatable operation 
was—for example, Repeat Rotate or Repeat Paste. This command is 
most useful for placing objects and creating arrays of objects quickly.

In the schematic page editor, the Redo command applies to the following 
actions:

■ Placing

■ Rotating

■ Mirroring

■ Moving 

■ Resizing

■ Pasting

In the part editor, the Redo command applies to the following actions:

■ Placing

■ Rotating

■ Mirroring

■ Pasting

Shortcuts:

Keyboard:

■ F4

■ ALT, E, R
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Label State commands

Set

Go To

Delete

Cut command

Available from: Edit menu

Function:
Use this command to specify a label for the current state of the active 
schematic page.

Available from: Edit menu

Function:
Use this command to specify the label of the schematic state to which 
you want to return.

Available from: Edit menu

Function: Use this command to specify a label state to delete.

Available from: Edit menu

Function:

Use this command to remove the selected object from the active window 
and put it on the Clipboard. This command is only available when an 
object is selected.

Cutting objects to the Clipboard replaces any objects previously stored 
there. Use the Paste command to copy objects to another page or part, 
or to another Windows application that supports pasting from the 
Clipboard.
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Copy command

Paste command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+X

■ ALT, E, T

Pop-up menu: Cut

Available from: Edit menu

Function:

Use this command to copy a selected object to the Clipboard without 
removing it from the active window. This command is available only if an 
object is selected.

Copying objects to the Clipboard replaces any objects previously stored 
there. Use the Paste command to copy objects to another page or part, 
or to another Windows application that supports pasting from the 
Clipboard.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+C

■ ALT, E, C 

Pop-up menu: Copy

Available from: Edit menu

Function:

Use this command to place any objects stored on the Clipboard into the 
active window. This command is unavailable if the Clipboard is empty.

Pasting objects from the Clipboard does not affect the Clipboard's 
contents. Use Paste to copy objects to another page or part, or to 
another Windows application that supports pasting from the Clipboard. 
You can only paste text into text boxes.
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Delete command

Note: If you copy a part into the Clipboard and then paste it onto a 
schematic page, Capture will automatically assign a unique reference 
designator to the pasted part when two conditions are met:

1. The Auto Reference option on the Miscellaneous tab of the 
Preferences dialog box is selected.

2. The pasted part has a reference designator assigned to it when it is 
copied to the Clipboard.

Capture assigns the reference designator, updated to the next available 
value (one greater than the highest value used on the schematic at that 
point.) If the pasted part has a default reference (for example, R?) 
Capture does not assign a unique reference designator to it. 

Important

In part editor, you can copy objects and paste them in the part 
editor only. Similarly, in symbol editor, you can copy objects and 
paste them in the symbol editor only. 

Shortcuts:

Capture Toolbar: 

Keyboard:

■ CTRL+V

■ ALT, E, P

Pop-up menu: Paste

Available from: Edit menu

Function:

Use this command to remove the selected object from the active window 
without putting it on the Clipboard. This command is available only if an 
object is selected.

Deleting objects does not affect the Clipboard's contents.
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Label command

Shortcuts:

Keyboard:

■ DEL

■ DELETE

■ BACKSPACE

■ ALT, E, D

Pop-up menu: Delete

Available from: Edit menu

Function:

Use this command to tag the schematic designs at different stages of 
development. This command is useful when you want to quickly jump to 
a particular state of schematic design. For example, consider the situation 
while developing a schematic:

1. Place a 7400 part.

2. Add the ATOD library to the design.

3. Place the 5962-8700 part on the schematic

4. Join the components.

5. Add the Discrete library to the schematic.

6. Place the 126ANS part on the schematic.

At this point you realize that instead of 5962-8700 part, the 5962-87786 
part should have been used. Now, to do so, you can either undo the last 
three steps. Alternately, you could have used the label state option to 
label the schematic at different stages of design. For example, you could 
have set a label, say stage2, after step 2. In such a scenario, you could 
have used the label and jumped straight to the state of the schematic as 
it was after step 2, thus saving yourself a lot of effort.

Note: A label can have a maximum of 31 characters.
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Select All command

Part command

Shortcuts:

Keyboard:

■ Set: Ctrl + Shift + F2

■ Goto: Ctrl + Shift + F5

■ Delete: Ctrl + Shift+ F7

Available from: Edit menu

Function: Use this command to select all items in the active window.

Shortcuts:

Keyboard:

■ CTRL+A

■ ALT, E, L

Available from: Edit menu, Browse command

Function:

Use this command to list the parts of the selected schematic pages in 
the browse window. The Browse Properties dialog box gives you the 
option to use instances or occurrences.

You can sort the parts in the browser spreadsheet by clicking the button 
at the top of each column in the browse window. Capture only displays 
the occurrences of the parts in the browse window.

You can select single or multiple parts and edit them with the Properties 
command. When you edit one part, a part editor window appears. When 
you select multiple parts, the Browse spreadsheet editor appears.

Shortcuts: Keyboard: ALT, B, P
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Properties command

Available from: Edit menu

In the project manager, use this command to view properties about the 
selected document. Using the Properties dialog box, you can access 
information general, type, and project about the file that is currently selected
in the project manager window. You can also change the file's type. A file or
project must be selected in the project manager window to access the 
Properties command.

In the schematic page editor, use this command to open the property editor,
where you can edit properties and other data for the selected objects.

The properties you can edit depend on the selected objects. The following 
lists the inherent properties you can edit and the dialog boxes in which you 
edit them:

Function:

Objects 

■ Arcs

■ Images (pictures)

■ Bookmarks

■ Buses Property editor

■ Bus entries

■ DRC markers

■ Ellipses

■ Hierarchical blocks

■ Hierarchical pins

■ Hierarchical ports

Dialog box

■ Edit Graphic dialog box

■ Not applicable

■ Edit Bookmark dialog box

■ Property editor

■ User Properties dialog box

■ View DRC Marker dialog box

■ Edit Filled Graphic dialog box
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■ IEEE symbols

■ Junctions

■ Lines

■ Multiple objects

■ Nets (wires and buses)

■ Net aliases

■ No connects

■ Off-page connectors

■ Parts

■ Pictures (images)

■ Place IEEE Symbol dialog box

■ Not applicable

■ Edit Graphic dialog box

■ Property editor or Browse spreadsheet
editor

■ Property editor

■ Property editor

■ Not applicable

■ Edit Off-Page Connector dialog box

■ Property editor

■ Not applicable

■ Part body borders

■ Pins (part editor)

■ Pins (schematic page 
editor)

■ Polygons

■ Polylines

■ Power, ground

■ Rectangles

■ Text

■ Title blocks

■ Wires

■ Not applicable

■ Pin Properties dialog box (part editor)

■ Property editor

■ Edit Filled Graphic dialog box

■ Edit Graphic dialog box

■ Property editor

■ Edit Filled Graphic dialog box

■ Place Text dialog box

■ Property editor

■ Property editor
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Part command

Note: You can edit homogeneous sets of the following objects in the 
spreadsheet editor:

■ Bookmarks

■ DRC markers

■ Hierarchical ports

■ Nets

■ Off-page connectors

■ Parts

■ Pins

Shortcuts:

Keyboard:

■ CTRL+E

■ ALT, E, I 

Mouse: Double-click on a part

Pop-up menu: Edit Properties

Available from: Edit menu

Function:

Use this command to open the selected part in a part editor window.

The part command edits the part in the design cache. After saving the 
part, you have the option to apply your changes to just one part or all 
parts with the same part value in the design. If you edit the one part only, 
a new part is created in the cache and all other parts with the same part 
value are left unchanged. Otherwise, the changes are applied to the part 
in the cache. To replace a part in the cache with another part, use the 
Replace Cache command.

Shortcuts:
Keyboard: ALT, E, A

Pop-up menu: Edit Part
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Reset Location command

Pin Name command

Pin Number command

Available from: Edit menu

Function:

Select the pin name and pin number text you had moved in the part 
editor and use this command to reset the pin name or pin number text 
movement. 

Choose a command from the menu that appears:

■ To reset a pin name movement, choose Pin Name 

■ To reset a pin number movement, choose Pin Number

This command also resets the display properties such as Bold, Italic, 
Color, Rotation, Justification, Font, and Font Size related to Pin 
Name and Pin Number.

Shortcut Pop-up menu: Reset Location

Available from: Edit menu, Reset Location command

Function:

Select the pin name text you had moved in the part editor and use this 
command to reset the pin name movement.

This command also resets the display properties such as Bold, Italic, 
Color, Rotation, Justification, Font, and Font Size related to Pin 
Name.

Shortcut Pop-up menu: Reset Location

Available from: Edit menu, Reset Location command

Function:

Select the pin number text you had moved in the part editor and use this 
command to reset the pin number movement.

This command also resets the display properties such as Bold, Italic, 
Color, Rotation, Justification, Font, and Font Size related to Pin 
Number.
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Mirror command

Horizontally command

Shortcut Pop-up menu: Reset Location

Available from: Edit menu

Function:

Use this command to mirror selected items in the schematic page editor 
or the part editor. Choose a command from the menu that appears:

■ Horizontally

■ Vertically

■ Both

Note: Multiple selected objects are mirrored and rotated as a group. They 
do not mirror or rotate around their individual axes. 

Note: Title blocks and text cannot be mirrored or rotated.

Shortcuts: Keyboard: ALT, E, M

Available from: Edit menu, Mirror command

Function:
Use this command to mirror selected objects from side to side (across 
the Y axis).

Note: Multiple selected objects are mirrored and rotated as a group. They 
do not mirror or rotate around their individual axes. 

Title blocks and text cannot be mirrored or rotated.

Shortcuts:

Keyboard:

■ H

■ ALT, E, M, H

Pop-up menu: Mirror Horizontally
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Vertically command

Both command

Rotate command

Available from: Edit menu, Mirror command

Function:
Use this command to mirror selected objects from top to bottom and 
from bottom to top (across the X axis).

Note: Multiple selected objects are mirrored and rotated as a group. They 
do not mirror or rotate around their individual axes. 

Note: Title blocks and text cannot be mirrored or rotated.

Shortcuts:

Keyboard:

■ V

■ ALT, E, M, V

Pop-up menu: Mirror Vertically

Available from: Edit menu, Mirror command

Function:
Use this command to mirror selected objects both horizontally and 
vertically. This is equivalent to rotating the objects by 180 degrees.

Note: Multiple selected objects are mirrored and rotated as a group. They 
do not mirror or rotate around their individual axes.

Note: Title blocks and text cannot be mirrored or rotated.

Shortcuts: Keyboard: ALT, E, M, B

Available from: Edit menu

Function:
Use this command to rotate selected objects counterclockwise in 
90-degree increments. Selected objects rotate as a set, not as individual 
objects rotating in place.

Note: Multiple selected objects are mirrored and rotated as a group. They 
do not mirror or rotate around their individual axes. 
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Lock command

UnLock command

Find command

Note: Title blocks and Non-TrueType fonts cannot be mirrored or rotated.

Shortcuts:

Keyboard:

■ R

■ ALT, E, O

Pop-up menu: Rotate

Available from:

Schematic page editor shortcut menu, when you select the schematic 
part.

Note: This command is disabled if the object is currently locked.

Function:

Use this command to lock an object on a schematic page.

Note: You can lock one or more objects on a schematic page or you can 
lock all the objects in design, folder or page.

Shortcuts: Pop-up menu: Lock

Available from:

Schematic page editor shortcut menu, when you select the schematic 
part.

Note: This command is disabled if the object is currently unlocked.

Function:

Use this command to unlock an object on a schematic page.

Note: You can unlock one or more objects on a schematic page or you 
can unlock all the objects in design, folder or page.

Shortcuts:
Keyboard: ALT, E, N

Pop-up menu: UnLock

Available from: Edit menu
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Global Replace command

Function:

Use this command to locate an object or string of text in the active 
window.

In the schematic page editor and project manager, the Find command 
finds all instances of the specified text search string, parts, part pins, 
DRC markers and constraints. The Find command supports wildcard 
searches. Use an asterisk (*) to match any string of characters, and a 
question mark (?) to match any single character.

In the session log, the Find command will find the next occurrence of the 
specified text search string from the current position. However, it does 
not support wildcard searches.

The Find window in part editor can search only pin and text, and it 
supports wildcard searches.

In the design variant schematic page, the Find command will find parts 
that are not present or parts with different property values attached to it.

Shortcuts:

Keyboard:

■ CTRL+F

■ ALT+E+F

Available from: Edit menu

Function:

Use this command to locate and replace an object or a string of text in 
the schematic editor.

The Global Replace command does not support wildcard searches.

In the schematic page editor, the Global Replace command will find all 
instances of the specified text search string.

Shortcuts:
Keyboard: 

ALT+E+B
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Align Command

Important

As you align or distribute objects, remember the following 
points:

❑ If the text is justified, align command has no impact on the 
justified text.

❑ Align command is not supported for the following objects:

❍ PSpice Markers

❍ DRC and ERC Markers

❍ Bookmarks

❍ Hierarchical Pins

❍ Part Pins

❍ Biaspoints

❍ Bus

❍ Bus Entry

❍ Wire

❍ NetGroup

❍ Locked Objects

❑ You need to select at least two objects to perform alignment 
or distribution.

❑ You can select different object types, such as parts, net 
aliases, and property texts, at same time to perform 
alignment or distribution.

❑ The following objects may connect during alignment or 
distribution, if the Drag Connected Object option is OFF:

❍ Global

❍ OPC

❍ Ports
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❍ Power/GND

❑ Objects that have their left side on a grid may not align 
properly. Set the Snap To Grid option OFF to align these 
objects properly.

❑ In Vertical Distribution, the objects are always vertically 
distributed in top-to-bottom direction. Similarly, in Horizontal 
Distribution, the objects are always horizontally distributed 
in left-to-right direction.

❑ By default, the Distribute in a fixed area check box in the 
Schematic Group section of the Extended Preferences 
Setup window is unchecked. To open this window, select 
Options – Extended Preferences. If the check box is 
unchecked, the objects in the virtual selection bounding box 
are evenly distributed and the bounding box might be 
compressed or expanded. If you check the box, the objects 
are distributed in a fixed area, but the distribution might be 
uneven.

Caution

When two parallel parts have one of the their pins on 
same grid and are connected through a net having 
net alias, any alignment task performed on these 
two parts may break the connectivity between them.

Align Left

Available from: Edit menu

Function:

Use this command to left align the selected objects with respect to the 
leftmost selected object.

In Mouse Mode:

Use this command to left align the selected objects with respect to the 
mouse click.
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Align Center

Align Right

Align Top

Available from: Edit menu

Function:

Use this command to center align the selected objects with respect to 
the virtual selection bounding box. The virtual selection bounding box is 
formed with respect to the leftmost and rightmost of the selected objects.

In Mouse Mode:

Use this command to center align the selected objects with respect to 
the mouse click.

Available from: Edit menu

Function:

Use this command to right align the selected objects with respect to the 
rightmost selected object.

In Mouse Mode:

Use this command to right align the selected objects with respect to the 
mouse click.

Available from: Edit menu

Function:

Use this command to top align the selected objects with respect to the 
topmost selected object.

In Mouse Mode:

Use this command to top align the selected objects with respect to the 
mouse click.
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Align Middle

Align Bottom

Distribute Horizontal

Available from: Edit menu

Function:

Use this command to middle align selected objects with respect to the 
virtual selection bounding box. The virtual selection bounding box is 
formed with respect to the topmost object and bottommost object of the 
selected objects.

In Mouse Mode:

Use this command to middle align the selected objects with respect to 
the mouse click.

Available from: Edit menu

Function:

Use this command to bottom align the selected objects with respect to 
the bottommost selected object.

In Mouse Mode:

Use this command to bottom align the selected objects with respect to 
the mouse click.

Available from: Edit menu

Function:

Use this command to horizontally distribute selected objects with equal 
spacing within the virtual selection bounding box. The virtual selection 
bounding box is formed with respect to the leftmost object and the 
rightmost object of the selected objects.

In Mouse Mode:

Use this command to horizontally distribute the selected objects with 
equal spacing between the two selected points on a schematic page.
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Distribute Vertical

Mouse Mode

Available from: Edit menu

Function:

Use this command to vertically distribute selected capture objects with 
equal spacing within the virtual selection bounding box. The virtual 
selection bounding box is formed with respect to the topmost object and 
the bottommost object of the selected objects.

In Mouse Mode:

Use this command to vertically distribute the selected objects with equal 
spacing between two selected points on a schematic page.

Available from: Edit menu
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View menu

This section covers:

Ascend Hierarchy command on page 115

Convert command on page 116

Function:

Use this command to enable or disable Mouse Mode. When Mouse 
Mode is enabled, the point where mouse is clicked on schematic page is 
taken as reference for alignment or distribution task.

Alignment using Mouse Mode:

1. Choose Edit - Align - Mouse Mode to set Mouse Mode ON.

2. Select the objects you want to align.

3. Select the alignment type (top, middle, bottom, left, center, right). As 
you select the alignment or distribution type, the shape of mouse 
pointer changes.

4. Click on the schematic page to align selected objects with respect to 
mouse click.

Distribution using Mouse Mode:

1. Choose Edit - Align - Mouse Mode to set Mouse Mode ON.

2. Select the objects you want to distribute.

3. Select the distribution type - horizontal or vertical. As you select the 
distribution type, the shape of mouse pointer changes.

4. Select the two points on the schematic between which the 
distribution is to performed.

a. Click to set the first point.

b. Click to set the second point.

As you set the second point on a schematic page, the distribution on 
selected objects is performed between the two selected points.
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Descend Hierarchy command on page 116

Go To command on page 117

Synchronize Up command on page 117

Synchronize Down command on page 118

Synchronize Across command on page 118

Previous Part command on page 118

Next Part command on page 118

Package command on page 119

Package command on page 119

Zoom command on page 120

Tool Palette command on page 122

Tool Palette command on page 122

Toolbar command on page 123

Status Bar command on page 123

Command Window command on page 123

Grid command on page 124

Grid References command on page 124

Selection Filter command on page 124

Invoke UI command on page 125

Ascend Hierarchy command

Available from: View menu
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Convert command

Descend Hierarchy command

Function:

Use this command to view the parent of the active schematic page.

If the parent schematic page is open in another window, that window 
becomes active; otherwise, it opens in a new schematic page editor 
window.

You can view and traverse the hierarchy in the project manager.

Shortcuts:

Keyboard:

■ SHIFT+A

■ ALT, V, A

Pop-up: Click right mouse button and choose Ascend Hierarchy

Available from: Convert tab in the part editor window

Function:
To display the convert view in the part editor window, select the Convert 
tab next to Normal tab in the bottom left of the canvas. This tab is 
available only when the parts in the package have a convert view. 

Available from: View menu

Function:

Use this command to view the schematic page. This command is 
available only when the selected part or hierarchical block has an 
attached schematic folder or file. If the attached schematic folder has not 
yet been created, this command creates a new page. If the child 
schematic folder is open in another window, that window becomes 
active. Otherwise, it opens in a new schematic page editor window.

You can view and traverse the hierarchy in the project manager.

Tip

Once you have attached a file and associated a text editor with 
it, you can use the Descend Hierarchy command to open that 
file. If you have an attached schematic folder as well as an 
attached file, Descend Hierarchy opens the schematic folder 
and not the file.
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Go To command

Synchronize Up command

Shortcuts:

Keyboard:

■ SHIFT+D

■ ALT, V, D

Pop-up menu: Descend Hierarchy

Available from: View menu

Function:
Use this command to center the view on a specific location, grid 
reference, or bookmark.

Tip

The Go To command is always available on the right mouse 
button context-sensitive menus in the part editor and schematic 
page editor. The Go To command, with the Relative option 
selected, is particularly useful for precise placement and 
spacing.

Shortcuts:

Keyboard:

■ CTRL+G

■ ALT, V, G

Pop-up menu: Go To

Available from: View menu / Shortcut menu

Function:
Updates the hierarchical blocks with all the changes made to the 
hierarchical ports of the underlying schematic of the selected 
hierarchical block.

Shortcuts:
Keyboard: Shift + U

Pop-up menu: Synchronize Up
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Synchronize Down command

Synchronize Across command

Previous Part command

Next Part command

Available from: View menu / Shortcut menu

Function:
Updates the underlying schematic with all the changes made to the 
hierarchical pins of the selected hierarchical block.

Shortcuts:
Keyboard: Shift + O

Pop-up menu: Synchronize Down

Available from: View menu / Shortcut menu

Function:
Updates all the instances of hierarchical block at the same level of 
hierarchy with the changes on the hierarchical pin of the selected 
hierarchical block.

Shortcuts:
Keyboard: Shift + C

Pop-up menu: Synchronize Across

Available from: View menu

Function:

Use this command to view the previous part in the package. In Part view, 
this command displays the previous part of the package in the part 
editor. In Package view, this command selects the previous part in the 
package.

Shortcuts:

Keyboard:

■ ALT, V, V

■ CTRL+B

■ SHIFT+TAB (PACKAGE VIEW ONLY)

Available from: View menu
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Previous Page command

Next Page command

Package command

Function:
Use this command to view the next part in the package. In Part view, this 
command displays the next part of the package in the part editor. In 
Package view, this command selects the next part in the package.

Shortcuts:

Keyboard:

■ ALT, V, X

■ CTRL+N

■ TAB (PACKAGE VIEW ONLY)

Available from: View menu

Function:
Use this command to open the previous page in the current schematic 
folder. The option is disabled for the first page in the folder.

Shortcuts: Keyboard: Shift+F10

Available from: View menu

Function:
Use this command to open the next page in the current schematic folder. 
The option is disabled for the last page in the folder.

Shortcuts: Keyboard: F10

Available from: View menu

Function:

Use this command in the part editor to view all the parts in a package in 
a new tab. Parts cannot be edited in package view.

You can zoom in and zoom out the parts using the shortcuts I and O.

Shortcuts: Keyboard: ALT, V, K
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Zoom command

In command

Available from: View menu

Function:

Use this command to change your view of the schematic page. Choose 
one of the commands listed:

■ In

■ Out

■ Scale

■ Area

■ All

■ Selection

■ Redraw

Shortcuts: Keyboard: ALT, V, Z

Available from: View menu, Zoom command

Function:

Use this command to zoom in on the schematic page or part. The zoom 
scale is multiplied by the current zoom factor.

Capture uses the following order to determine where the view of the 
zoom centers:

■ On the pointer location

■ On the selected item or items

■ In the center of the window (not the center of the schematic page or 
part)
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Out command

Scale command

Area command

Shortcuts:

Capture Toolbar: 

Keyboard:

■ I

■ ALT, V, Z, I

Pop-up menu: Zoom In

Available from: View menu, Zoom command

Function:
Use this command to zoom out from the schematic page or part. The 
zoom scale is divided by the current zoom factor.

Shortcuts:

Capture Toolbar: 

Keyboard:

■ O

■ ALT, V, Z, O 

Pop-up menu: Zoom Out

Available from: View menu, Zoom command

Function:
In the schematic page editor, use this command to zoom to a preset or 
user-defined scale. The new view centers on the selected objects, the 
pointer location, or the center of the previous view.

Shortcuts: Keyboard: ALT, V, Z, S

Available from: View menu, Zoom command

Function:
Use this command to make a specific area of the document as large as 
will fit in the window. You define the area by dragging a rectangle around 
it.
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All command

Selection command

Redraw command

Tool Palette command

Shortcuts:
Capture Toolbar: 

Keyboard: ALT, V, Z, A

Available from: View menu, Zoom command

Function:
Use this command to view the entire document in the active window. 
This command uses the size of the work area, not the limits of the 
objects.

Shortcuts:
Capture Toolbar: 

Keyboard: ALT, V, Z, L

Available from: View menu, Zoom command

Function:
In the schematic page editor, use this command to view all selected 
objects.

Shortcuts: Keyboard: ALT, V, Z, E

Available from: View menu, Zoom command

Function: In the schematic page editor, use this command to refresh the display.

Shortcuts:

Keyboard:

■ F5

■ ALT, V, Z, R

Available from: View menu
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Toolbar command

Status Bar command

Command Window command

Function:
Use this command to show or hide the tool palette. This setting is stored 
in your CAPTURE.INI file and thus affects the visibility of the palette in 
subsequent sessions.

Shortcuts: Keyboard: ALT, V, P

Available from: View menu

Function:

Use this command to show or hide the toolbar. This setting is stored in 
your .INI file and thus affects the visibility of the toolbar in subsequent 
sessions. You can move the toolbar anywhere on the screen by pressing 
the left mouse button over the toolbar, and then moving the mouse to the 
toolbar's new location. If the toolbar is moved to any edge of the window, 
the toolbar snaps into place. Otherwise, it floats on the screen wherever 
it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Shortcuts: Keyboard: ALT, V, T

Available from: View menu

Function:
Use this command to show or hide the status bar. This setting is stored 
in your .INI file and thus affects the visibility of the status bar in 
subsequent sessions.

Shortcuts: Keyboard: ALT, V, S

Available from: View - Toolbar menu
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Grid command

Grid References command

Selection Filter command

Function:

Use this command to open the TCL Command window in the OrCAD 
Capture workspace.

For details see the Command Window.

Available from: View menu

Function:

Use this command to show or hide the grid dots. You can show or hide 
the grid independently in each schematic page and part you have open.

You can also set the grid dots to show or hide in the Preferences dialog 
box.

Shortcuts: Keyboard: ALT, V, I

Available from: View menu

Function:

Use this command to show or hide the grid references.

You can also set the grid references to show or hide in the Design 
Template dialog box and the Schematic Page Properties dialog box.

Shortcuts: Keyboard: ALT, V, R

Available from:
View menu

Note: You can access this command only if a schematic page is open.

Function:
Use this command to control the selection of objects in a schematic 
page during a block-select operation.
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Invoke UI command

Place menu

This section covers:

Part command on page 127

PSpice Component command on page 127

Parameterized Part command on page 129

NetGroup command on page 129

Wire command on page 129

Shortcuts:

Keyboard:

■ CTRL+I

■ ALT, V, F

This command is also available from the schematic page editor pop-up 
menu.

Available from: View menu

Function:

Opens the Propagation Delay dialog box or the Relative Propagation 
Delay dialog box while editing these properties in the Property Editor 
window. 

This command is available only when you have selected the grid 
corresponding to the Propagation Delay/Relative Propagation Delay 
property in the Property Editor window.

You can also access the Invoke UI command by right-clicking the grid 
corresponding to the Propagation Delay/Relative Propagation Delay 
property in the Property Editor window.

Shortcuts:

Keyboard:

■ CTRL+U

■ ALT, E, V
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Bus command on page 131

Junction command on page 132

Bus Entry command on page 132

Net Alias command on page 133

Power command on page 133

Ground command on page 133

Off-Page Connector command on page 134

Hierarchical Block command on page 134

Hierarchical Port command on page 135

Hierarchical Pin command on page 135

No Connect command on page 136

Title Block command on page 137

Bookmark command on page 140

Text command on page 140

Line command on page 141

Rectangle command on page 141

Ellipse command on page 141

Arc command on page 142

Elliptical Arc command on page 142

Bezier curve command on page 142

Polyline command on page 143

Picture command on page 143

OleObject command on page 144
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Part command

PSpice Component command

Available from: Place menu

Function:

Use this command to place a part you select in the Place Part dialog 
box.

In the Place Part dialog box, you choose a part by selecting libraries to 
view. You may view parts from both Capture and SDT libraries. If you 
choose a part from an SDT library, Capture translates the library for you.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ P

■ ALT, P, P

Available from: Place menu
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Function:

Use this command to place a part with ideal SPICE model from the 
generic PSpice library on your schematic. The submenu items and the 
parts you can access are listed below:

■ PSpice Ground

■ Capacitor

■ Diode

■ Inductor

■ Resistor

■ Digital:

❑ Gates: AND, OR, NAND, NOR, XOR, INV

❑ Flip Flop: D, JK, RS, T

❑ ADC: 8Bit, 10Bit, 12Bit

❑ DAC: 8Bit, 10Bit, 12Bit

❑ Memory:

❍ RAM: 8kX1, 8KX8

❍ ROM: 32KX1

■ Discrete: Diode, NPN, PNP, NPN Darlington, PNP Darlington

■ Passive: R, C, L, Potentiometer, Coupling, Tline Ideal, Tline Lossy

■ Source:

❑ Controlled sources: VCVS, VCCS, CCVS, CCCS

❑ Current Sources: AC, DC, Pulse, Sine, Exponential, FM Sine

❑ Voltage Sources: AC, DC, Pulse, sine, Exponential, FM Sine

■ Search

■ Modeling Application: 

❑ Circuit Protection: TVS

❑ Diodes: Zener, LED

❑ Passives: Capacitor, Inductor
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Parameterized Part command

NetGroup command

Wire command

Shortcuts:

❑ Sources: Independent Sources, PWL Sources

❑ System Modules: Switch, Transformer, VCO

Keyboard:

■ ALT, P, S

Available from: Place menu

Function:
Use this command to place a parameterized part you select in the Place 
Part dialog box.

Shortcuts: Keyboard: ALT, P, D

Available from: Place menu

Function:

Use this command to place a NetGroup on a schematic page.

Note: You also use this dialog to add or modify associated NetGroup 
definitions.

Shortcuts: Keyboard: U

Available from: Place menu

Function:

Use this command to place a part you select in the Place Part dialog 
box.

In the Place Part dialog box, you choose a part by selecting libraries to 
view. You may view parts from both Capture and SDT libraries. If you 
choose a part from an SDT library, Capture translates the library for you.
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Auto Wire Two Points command

Auto Wire Multiple Points command

Auto Wire Connect to Bus

Shortcuts:

Draw Toolbar: 

Keyboard:

■ W

■ ALT, P, W

Available from: Place menu

Function:
Use this command to auto-wire two points (pins or wires) on a schematic 
page.

Shortcuts: Draw Toolbar: 

Available from: Place menu

Function:
Use this command to auto-wire multiple points (pins or wires) on a 
schematic page.

Shortcuts: Draw Toolbar: 

Available from: Place menu

Function:
Use this command to auto-wire any number of points on a schematic 
page to a bus on the page.

Shortcuts: Draw Toolbar: 
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Bus command

Available 
from:

Place menu

Function:

Use this command to place a bus. When placing a bus, you click the 
left mouse button to start the bus. Click the left mouse button to 
change the bus's direction or create a junction with another bus. 
Double-click the left mouse button or press ESC to end the bus, and 
place another bus. Press ESC again to exit the bus tool.

When placing buses, you are constrained to 90-degree angles. If 
you want to draw non-orthogonal buses, hold the SHIFT key down 
while placing the bus.

You may also use the keys B and E to start and end buses.

Important

As you place buses and wires, remember the following 
points:

❑ A bus and a wire can be connected only by name.

❑ If you begin or end a bus segment on a segment of a wire, 
a vertex is added to the wire, but no junction appears—the 
bus and wire are not connected.

❑ If you begin or end a wire segment on a segment of a bus, 
a vertex is added to the bus, but no junction appears—the 
wire and bus are not connected.

❑ Two buses or two wires can be connected physically.

❑ If you begin or end a bus segment on a segment of another 
bus, a vertex is added to the second bus, and a junction 
appears—the buses are connected.

❑ If you begin or end a wire segment on a segment of another 
wire, a vertex is added to the second wire, and a junction 
appears—the wires are connected.
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Junction command

Bus Entry command

Note: Bus names and aliases have the form X[m..n].

■ X represents the "basename" (how you think of the bus, 
perhaps)

■ m..n represents the range of signals carried by the bus.

Note that m may be less than or greater than n: both A[0..3] and 
A[3..0] are valid bus aliases. You can use two periods (..), a colon 
(:), or a dash (-) to separate m and n.

Capture ignores any spaces between the basename and the left 
bracket ([). For example, ADDR[0..31], ADDR[0:31], and 
ADDR[0-31] represent the same bus.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ B

■ ALT, P, B

Available from: Place menu

Function:

Use this command to place a junction to connect two nets, or remove a 
junction connecting two nets. Junctions can only connect wires to wires, 
or buses to buses. Junctions cannot connect wires to buses or buses to 
wires.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ J

■ ALT, P, J

Available from: Place menu

Function: Use this command to place a bus entry.
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Net Alias command

Power command

Ground command

Shortcuts:

Draw Toolbar: 

Keyboard:

■ E

■ ALT, P, E

Available from: Place menu

Function:
Use this command to place a net alias on the selected object. To quit 
placing net aliases, press ESC or choose the selection tool.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ N

■ ALT, P, N

Available from: Place menu

Function: Use this command to place a power symbol.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ F

■ ALT, P, O

Available from: Place menu

Function: Use this command to place a ground symbol.
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Off-Page Connector command

Hierarchical Block command

Shortcuts:

Draw Toolbar: 

Keyboard:

■ G

■ ALT, P, G

Available from: Place menu

Function:

Use this command to place an off-page connector, which connects to 
another page in the schematic folder, and to isolate power to a 
schematic folder. Net aliases of the same name connect wires to these 
nets.

Note: If you have single pin nets connecting to internal signals then use 
off-page connectors for making connections. The use of ports is 
recommended when you have multiple pin nets. 

Shortcuts:
Draw Toolbar: 

Keyboard: ALT, P, F

Available from: Place menu

Function:

Use this command to place a hierarchical block. A hierarchical block 
maps to a schematic folder, not a schematic page.

If you attach an existing schematic folder to a hierarchical block, Capture 
automatically creates the hierarchical pins that correspond with the 
schematic folder's hierarchical ports. If you descend hierarchy on a 
hierarchical block whose schematic folder doesn't yet exist, then Capture 
automatically creates the hierarchical ports that correspond with the 
hierarchical pins of the hierarchical block.

Shortcuts:
Draw Toolbar: 

Keyboard: ALT, P, H
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Hierarchical Port command

Hierarchical Pin command

Available from: Place menu

Function:

Use this command to place a hierarchical port. A hierarchical port is 
electrically connected by name to a hierarchical pin or signal "above" the 
schematic page. Hierarchical ports can connect laterally to other 
hierarchical ports.

If you attach an existing schematic folder to a hierarchical block, Capture 
automatically creates the hierarchical pins that correspond with the 
schematic folder's hierarchical ports. If you descend hierarchy on a 
hierarchical block whose schematic folder doesn't yet exist, then Capture 
automatically creates the hierarchical ports that correspond with the 
hierarchical pins of the hierarchical block.

Note: If you have multiple pin nets, use hierarchical ports for making 
connections. The use of off-page connectors is recommended when you 
have single pin nets connecting to internal signals. 

Shortcuts:
Draw Toolbar: 

Keyboard: ALT, P, I

Available from: Place menu

Function:

Use this command to place a hierarchical pin. You must select a 
hierarchical block to use this command. Hierarchical pins can only be 
placed inside hierarchical blocks. A hierarchical pin is electrically 
connected by name to a port or signal in the schematic folder attached to 
the pin's hierarchical block.

If you attach an existing schematic folder to a hierarchical block, Capture 
automatically creates the hierarchical pins that correspond with the 
schematic folder's hierarchical ports. If you descend hierarchy on a 
hierarchical block whose schematic folder doesn't yet exist, then Capture 
automatically creates the hierarchical ports that correspond with the 
hierarchical pins of the hierarchical block.

Shortcuts:
Draw Toolbar: 

Keyboard: ALT, P, R
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No Connect command

Pin command

Available from: Place menu

Function:

Use this command to place a no connect symbol. This object causes 
unused pins to be ignored by reports that show unconnected pins. 
Design rule checks and netlists won't report errors for pins with no 
connects placed on them. No connects do not affect connected pins, 
even if the Is No Connect property is set to TRUE. If the No Connect 
property is set to TRUE and the pin is unconnected, an X appears on the 
pin.

No connects can also be placed by setting the Is No Connect property of 
a pin to TRUE. No connects cannot be deleted using the Delete 
command. You must either set the pin property to FALSE, or connect a 
wire to the pin.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ X

■ ALT, P, C

Available from: Place menu

Function:

Use this command to place one or more pins on a part. A pin is placed 
with each click of the left mouse button. Press ESC or choose the 
selection tool to stop placing pins.

When you are placing the pin in the place mode, to edit the pin before 
placing it, use SHIFT+G.

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, P

■ SHIFT+G
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Pin Array command

Title Block command

Available from: Place menu

Function: Use this command to place an array of pins.

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, I

■ SHIFT+J

Available from: Place menu

Function:

Use this command to place optional title blocks.

You can set title block visibility in the Design Template and Schematic 
Page Properties dialog boxes. 

There are a number of default title block properties. You can set the 
values for these properties with the property editor. They are:
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■ Cage Code: Specifies the Cage Code.

■ Design Create Date: Specifies the date of creation for the design.

■ Design Create Time: Specifies the time of creation for the design.

■ Design File Name: Specifies the path and file name of the design file.

■ Design Modify Date: Specifies the date of the last modification to the 
design.

■ Design Modify Time: Specifies the time of the last modification to the 
design.

■ Design Name: Specifies the name of the design.

■ Doc: Specifies the document number.

■ Name: Specifies the name of the title block.

■ OrgAddr1: Specifies the first line of the organization's address.

■ OrgAddr2: Specifies the second line of the organization's address.

■ OrgAddr3: Specifies the third line of the organization's address.

■ OrgAddr4: Specifies the fourth line of the organization's address.

■ OrgName: Specifies the organization name.

■ Page Count: Specifies the number of schematic pages in the design.

■ Page Create Date: Specifies the date of creation for the schematic 
page.

■ Page Create Time: Specifies the time of creation for the schematic 
page.

■ Page Modify Date: Specifies the date of the last modification to the 
schematic page.

■ Page Modify Time: Specifies the time of the last modification to the 
schematic page.

■ Page Number: Specifies the number of the schematic page. The 
page number determines when it will be printed in relation to the 
other schematic pages of the design.
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■ Page Size: Specifies the page size of the schematic page, as was set 
at creation time.

■ RevCode: Specifies the revision.

■ Schematic Create Date: Specifies the date of creation for the 
schematic folder.

■ Schematic Create Time: Specifies the time of creation for the 
schematic folder.

■ Schematic Modify Date: Specifies the date of the last modification to 
the schematic folder.

■ Schematic Modify Time: Specifies the time of the last modification to 
the schematic folder.

■ Source Library: Specifies the path and file name of the library from 
where the title block was placed.

■ Schematic Page Count: Specifies the number of schematic pages in 
the given schematic folder.

■ Schematic Page Number: Specifies the order of the schematic page 
within the schematic.

■ Symbol Library: Specifies the name of the symbol for the title block 
in the Source Library.

■ Title: Specifies the title.

You can add the following property to display system generated 
information:

■ Path Name: Specifies the hierarchical blocks leading from the root to 
the child using the Name Property for each hierarchical block in the 
path.

You can use the property editor to add the following property to display 
the hierarchical path of the schematic on an instance of a title block:

■ Schematic Path: Displays the full hierarchical path to the schematic 
visible and printable on the page.

Note: Title blocks and text cannot be mirrored or rotated.

Shortcuts: Keyboard: ALT, P, K
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Bookmark command

Text command

IEEE Symbol command

Available from: Place menu

Function:
Use this command to place a bookmark. A bookmark is a reference point 
on a schematic page for finding a location.

Shortcuts: Keyboard: ALT, P, M

Available from: Place menu

Function:
Use this command to place comment text. To quit placing text, press 
ESC or choose the selection tool.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ T

■ ALT, P, T

Available from: Place menu

Function:

Use this command to place an IEEE symbol. When you select this 
command, the Place IEEE Symbol dialog box appears.

Click the left mouse button to place an IEEE symbol once you have 
selected a symbol. Press ESC, or click on the selection tool, to quit 
placing the selected symbol. You can choose the Properties command 
from the Edit menu, or the Edit Properties command from the right 
mouse button pop-up menu, to change the IEEE symbol without having 
to quit the IEEE symbol tool.

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, E

■ SHIFT+X
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Line command

Rectangle command

Ellipse command

Available from: Place menu

Function:

Use this command to draw a line. To place a line, you press the left 
mouse button to start the line. Without releasing the left mouse button, 
drag the pointer to the other end point for the line. Release the left 
mouse button.

You may also use the keys B and E to start and end lines.

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, L

■ SHIFT+L

Available from: Place menu

Function:

Use this command to draw a rectangle. Press the left mouse button and 
drag the pointer to define the rectangle. To quit drawing rectangles, 
press ESC, or click on the selection tool.

To draw a square, hold down the SHIFT key while drawing.

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, R

■ SHIFT+R

Available from: Place menu

Function:

Use this command to draw an ellipse. Press the left mouse button and 
drag the pointer to define the ellipse. To quit drawing ellipses, press 
ESC, or click on the selection tool.

To draw a circle, hold down the SHIFT key while drawing.
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Arc command

Elliptical Arc command

Bezier curve command

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, S, S

■ SHIFT+F

Available from: Place menu

Function:
Use this command to draw an arc. To quit drawing arcs, press ESC, or 
click the selection tool.

Shortcuts:
Draw Toolbar: 

Keyboard: SHIFT+T

Available from: Place menu

Function:
Use this command to draw an elliptical arc. To quit drawing arcs, press 
ESC, or click on the selection tool.

Shortcuts:
Draw Toolbar: 

Keyboard: SHIFT+T

Available from: Place menu

Function:

Use this command to draw a Bezier curve. To quit drawing arcs, press 
ESC, or click on the selection tool.

When drawing a Bezier curve, click the left mouse button to define the 
start point of the curve. The click the left mouse button to define the first 
control point, again the left mouse button to define the second control 
point of the curve. Finally, click the left mouse button to define the end 
point of the curve.
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Polyline command

Picture command

Shortcuts:

Draw Toolbar: 

Keyboard: 

■ ALT, P, Z

■ SHIFT+Q

Available from: Place menu

Function:

Use this command to draw a polyline or polygon. To quit drawing 
polylines or polygons, press ESC, or click the selection tool. Click the left 
mouse button once to place one segment of the line and start another. 
Double-click the left mouse button to end the line when drawing 
polylines, or single-click the left mouse button to end the line while 
drawing polygons.

When placing polylines in the schematic page editor, you are 
constrained to 90-degree angles. To place a non-orthogonal polyline, 
hold the SHIFT key down while placing the polyline. You may also use 
the keys B and E to start and end polylines.

Shortcuts:

Draw Toolbar: 

Keyboard:

■ Y

■ ALT, P, Y

Available from: Place menu

Function: Use this command to place images on the schematic or in part editor.

Shortcuts: Keyboard: ALT, P, U
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OleObject command

PSpice/Markers menu

This section covers:

Markers command on page 144

Marker List command on page 145

Voltage Level command on page 145

Voltage Differential command on page 146

Current Into Pin command on page 146

Power Dissipation command on page 146

Advanced command on page 147

Plot Window Templates command on page 147

Show All command on page 147

Hide All command on page 147

Delete All command on page 148

Markers command

Available from: Place menu

Function:

Use this command to place images on the schematic. This command 
displays the standard Insert Object Windows dialog box, in which you 
choose to create a new object or create an Ole reference for an existing 
object. 

After you select an object, the cursor switches to the draw mode where 
you drag and draw an rectangular area to fit the object.

Available from: PSpice menu
June 2020 144 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Schematic page editor and part editor command reference
Marker List command

Voltage Level command

Function:

Use this command to place markers in the design. You can place 
markers in your design to indicate the points for which you want to see 
simulation waveforms displayed in PSpice.

You can place markers:

■ before simulation to limit results written to the waveform data file, and 
automatically display those traces in the active Probe window.

■ during or after simulation, to automatically display traces in the active 
Probe window.

The color of the marker in Capture and its corresponding trace in the 
Probe window are the same. If you change the color of one or the other, 
its counterpart also changes.

To view the markers in the simulation results, the schematic must be 
open.

Marker types on the Advanced command submenu are only available 
after defining a simulation profile for an AC Sweep/Noise analysis.

You can also choose to show all, hide all, delete all, or list markers using 
this command.

Shortcuts: Keyboard: ALT, T, G

Available from: PSpice menu

Function:

From the Project Manager, choose Marker List from the PSpice menu.

Use this command to display or hide markers in the design. The Markers 
dialog box displays markers that exist in the profile. An empty check box 
beside a marker indicates that the marker is hidden. If a marker is 
hidden, it will not appear in Capture but it will still exist in the profile.

Shortcuts: Keyboard: ALT, S, L

Available from: PSpice menu, Markers submenu
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Voltage Differential command

Current Into Pin command

Power Dissipation command

Function:

From a schematic page, point to Markers on the PSpice menu.

Use this command to place voltage level markers on the schematic, in a 
location of your choice.

Shortcuts: Keyboard: ALT, S, M, V

Available from: PSpice menu, Markers submenu

Function:

From a schematic page, point to Markers on the PSpice menu.

Use this command to place voltage differential markers on the 
schematic, in a location of your choice.

Shortcuts: Keyboard: ALT, S, M, D

Available from: PSpice menu, Markers submenu

Function:

From a schematic page, point to Markers on the PSpice menu.

Use this command to place current into pin markers on the schematic, in 
a location of your choice.

Shortcuts: Keyboard: ALT, S, M, C

Available from: PSpice menu, Markers submenu

Function:

From a schematic page, point to Markers on the PSpice menu.

Use this command to place power dissipation markers on the schematic, 
in a location of your choice.

Shortcuts: Keyboard: ALT, S, M, P
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Advanced command

Plot Window Templates command

Show All command

Hide All command

Available from: PSpice menu, Markers submenu

Function:
From a schematic page, point to Markers on the PSpice menu.

Use this command to place markers for AC Sweep/Noise analysis.

Note: Marker types on the Advanced command submenu are only 
available after defining a simulation profile for an AC Sweep/Noise 
analysis.

Available from: PSpice menu, Markers submenu

Function:

From a schematic page, point to Markers on the PSpice menu.

Use this command to place a plot window template marker on the 
schematic. The marker will restore the associated template when you 
run the simulation in PSpice.

Shortcuts: Keyboard: ALT, S, M, T

Available from: PSpice menu, Markers submenu

Function:
From a schematic page, point to Markers on the PSpice menu.

Use this command to display all the markers on the schematic.

Shortcuts: Keyboard: ALT, S, M, S

Available from: PSpice menu, Markers submenu

Function:
From a schematic page, point to Markers on the PSpice menu.

Use this command to hide all the markers on the schematic
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Delete All command

Accessories menu

This section covers:

“Accessories command” on page 148

Accessories command

Options menu

This section covers:

Autobackup command on page 149

Preferences command on page 149

Shortcuts: Keyboard: ALT, S, M, H

Available from: PSpice menu, Markers submenu

Function:
From a schematic page, point to Markers on the PSpice menu.

Use this command to delete all the markers on the schematic.

Shortcuts: Keyboard: ALT, S, M, E

Available from: Accessories menu

Function:

You can use extensions to the Cadence-supplied functionality of Capture 
if you purchase software developed by associates of Cadence. These 
associates create .DLL files that address specific Capture functionality, 
such as customized netlisting. The associates configure their .DLL files 
so that they are listed as menu choices in the Accessories menu, which 
is available in either the project manager window or the schematic page 
editor window.
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Design Template command on page 150

Schematic Page Properties command on page 150

Autobackup command

Preferences command

Available from: Options menu

Function:

Determines the frequency, location, and the number of copies of 
autobackup done by Capture. 

The Multi-level backup Settings dialog box appears when you choose 
Autobackup option from the Options menu. 

Enter the values for the following fields to determine the duration, 
number of backups, and its storage.

Backup time (in minutes) - Enables you to determine the time after 
which Capture will perform automatic backup.

No of backups to keep - Enables you to determine the total number of 
backups that will be stored.

Directory for backup - Enables you to determine the storage location 
for the backup

Shortcuts: Keyboard: ALT, O, B

Available from: Options menu

Function:
Use this command to set your environment preferences for the current 
project (and all future projects) on your system. The options you specify 
affect the behavior of the software, and are saved in the .INI file.

Shortcuts: Keyboard: ALT, O, P
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Design Template command

Schematic Page Properties command

Window menu

New Window command on page 151

Cascade command on page 151

Tile Horizontally command on page 151

Tile Vertically command on page 151

Arrange Icons command on page 152

1,2.... command on page 152

Available from: Options menu

Function:
Use this command to specify default settings for new projects, designs, 
and schematic pages. The values specified in this dialog box do not 
affect existing projects or designs.

Note: To change the properties of an active design, use the Design 
Properties command. To change the properties of an active schematic 
page, use the Schematic Page Properties command. You cannot change 
the default title block of an active schematic page.

Shortcuts: Keyboard: ALT, O, D

Available from: Options menu

Function:
Use this command in the schematic page editor to set 
schematic-page-related options.

Shortcuts: Keyboard: ALT, O, R
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New Window command

Cascade command

Tile Horizontally command

Tile Vertically command

Available from: Window menu

Function:
Use this command to create a new window, which is a copy of the 
currently active window. This new window is another "view" on the same 
data, and you can scroll the two windows to different positions.

Shortcuts: Keyboard: ALT, W, N

Available from: Window menu

Function:
Use this command to "stack" all open Capture windows so that just their 
title bars are visible. The active window stays on top.

Shortcuts: Keyboard: ALT, W, C

Available from: Window menu

Function:
Use this command to arrange open Capture windows, one above 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, H

Available from: Window menu

Function:
Use this command to arrange open Capture windows, one beside 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, V
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Arrange Icons command

1,2.... command

Help menu

This section covers:

PSpice for TI Help command on page 153

Known Problems and Solutions command on page 153

What’s New command on page 153

About PSpice for TI command on page 153

Documentation command on page 154

Note: To use the context-sensitive menu commands, select one or 
more items, then press the right mouse button. The contents of the 
menu differ depending on the objects selected.

Available from: Window menu

Function:
Use this command to arrange the icons for minimized windows across 
the bottom of the session frame.

Shortcuts: Keyboard: ALT, W, A

Available from: Window menu

Function:

Use the numbers listed at the bottom of the Window menu to view which 
windows are currently open, and to determine which window is active. 
(The active window is indicated by a check mark.) When you choose a 
window from this list, Capture restores that window if it was in icon form, 
pops it to the front of the Capture session, and makes it the active 
window.

Shortcuts: Keyboard: ALT, W, n (n = 1, 2, . . .)
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PSpice for TI Help command

Known Problems and Solutions command

What’s New command

About PSpice for TI command

Available from: Help menu

Function: Use this command to display the Help window.

Shortcuts:

Keyboard:

■ F1

■ ALT, H, H

Available from: Help menu

Function:
Use this command to display a document listing the known problems in 
this release of OrCAD Capture and tells you how to solve or work around 
these problems.

Shortcuts: Keyboard: ALT, H, K

Available from: Help menu

Function:
Use this command to display a document describing the new features 
and enhancements in this release.

Shortcuts: Keyboard: ALT, H, K

Available from: Help menu

Function:
Use this command to get the software version number, copyright 
information, registration number, and license information.

Shortcuts: Keyboard: ALT, H, A
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Documentation command

Pop-up menu

This section covers:

Mirror Horizontally command on page 155

Mirror Vertically command on page 155

Rotate command on page 155

Edit Properties command on page 155

Edit Part command on page 155

Select Entire Net command on page 156

Descend Hierarchy command on page 156

Synchronize Up command on page 156

Synchronize Down command on page 157

Synchronize Across command on page 157

Connect to Bus command on page 157

User Assigned Reference – Set command on page 157

Update Design Hierarchy command on page 157

Selection Filter on page 157

Available from:
In the project manager or schematic page editor, from the Help menu, 
choose Documentation.

Function:

Use this command to launch the help HTML page, which contains links 
to all the documentation types (manuals and online help), product 
tutorial, and multimedia demonstrations shipped with this product 
release.

Shortcuts: Keyboard: ALT, H, D
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Zoom In command on page 158

Zoom Out command on page 158

Go To command on page 158

Delete command on page 158

Tooltip command on page 158

Lock command on page 158

UnLock command on page 158

Note: To use the context-sensitive menu commands, select one or 
more items, then press the right mouse button. The contents of the 
menu differ depending on the objects selected.

Mirror Horizontally command

See Horizontally command on page 105

Mirror Vertically command

See Vertically command on page 106

Rotate command

See Rotate command on page 106

Edit Properties command

See Properties command on page 101

Edit Part command

See Part command on page 103
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Select Entire Net command

Edit Wire Properties command

Descend Hierarchy command

See Descend Hierarchy command on page 116

Synchronize Up command

See Synchronize Up command on page 117

Available from: Popup menu

Function:

Use this command to select the entire net associated with the selected 
wire or bus. To select an entire net, you must first select a single wire or 
bus. The Select Entire Net command only works on the active schematic 
page.

Note: The Select Entire Net command is restricted to the active 
schematic page—it doesn't follow hierarchical blocks, hierarchical ports, 
or off-page connectors across schematic folders or schematic pages. For 
more information, see Tracing a net.

Remember that nets on a schematic page are electrically connected by 
name, by alias, or by connection to a named hierarchical port or off-page 
connector.

Shortcuts:
Keyboard: CTRL+SHIFT+W

Pop-up menu: Select Entire Net

Available from: Popup menu

Function:
Use this command to open the Edit Wire(s) dialog box to specify line 
width and style and color for the selected wire.
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Synchronize Down command

See Synchronize Down command on page 118

Synchronize Across command

See Synchronize Across command on page 118

Connect to Bus command

See Auto Wire Connect to Bus on page 130

User Assigned Reference – Set command

Update Design Hierarchy command

Selection Filter

Selection Filter command on page 124

Available from:
Pop-up with part selected in schematic page or Reference property in 
the Property Editor, User Assigned Reference – Set

Function:

Use this command to mark references as user assigned

OrCAD Capture marks a reference as user assigned if:

■ Reference is changed in the Property Editor

■ Reference is changed in the Schematic canvas

■ Reference is changed in board (Backannotation)

Shortcuts: Pop-up menu: User Assigned Reference – Set

Available from: Pop-up menu from the Hierarchy tab in the Project manager

Function: Use this command to update the design hierarchy for the current project.

Shortcuts: Pop-up menu: Update Design Hierarchy
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Zoom In command

See In command on page 120

Zoom Out command

See Out command on page 121

Go To command

See Go To command on page 117

Delete command

See Delete command on page 98

Tooltip command

Lock command

See Lock command on page 107

UnLock command

See UnLock command on page 107

Available from:

Schematic page editor shortcut menu, when you select the schematic 
part.

Note: The Tooltip menu item will not appear if you select a component on 
the schematic page and then invoke the pop-up menu.

Function:
Use this command to toggle the display on tooltips for pins, parts and 
nets on the schematic page.

Shortcuts: Pop-up menu: ToolTip
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Add or Remove Pins on NetGroup Block command

Available from: Schematic page when you select a NetGroup Block.

Function:
Use this command to open the Add/Remove the Pins on NetGroup Block 
dialog box, where you can add or remove the pins on a NetGroup Block.
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Session log command 
reference

This chapter covers:

■ File menu on page 161

■ View menu on page 166

■ Edit menu on page 168

■ Options menu on page 170

■ Window menu on page 171

■ Help menu on page 173

File menu

New command on page 162

Open command on page 162

Save command on page 163

Save As command on page 163

Print Preview command on page 164

Print command on page 164

Print Setup command on page 165

Import Design command on page 165

Exit command on page 166
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1,2,3,4 command on page 166

New command

Open command

Available 
from:

File menu

Function:

Use this command to open a new design, or library. Choose a 
command from the menu that appears:

■ Design

■ Library

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see 1,2.... command).

Shortcuts:

Toolbar: 

Keyboard:

■ ALT, F, N

Available 
from:

File menu

Function:

Use this command to open an existing project, design, library, in a 
new window. Choose a command from the menu that appears:

Design

Library

Project

The number of open windows you can have is only limited by your 
available system resources. You can use the Window menu to switch 
among open windows (see 1,2.... command).

Note: When you choose the Open button on the toolbar, a standard 
Windows Open dialog box appears, in which you can choose the type 
of file you want to open in the Files of type drop-down list. Among the 
listed choices are SDT Schematic (*.SCH) and SDT Library (*.LIB).
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Save command

Save As command

Shortcuts:

Toolbar: 

Keyboard:

■ ALT, F, O

Available 
from:

File menu

Function:

Use this command to save the active, modified projects, designs, 
libraries, and VHDL files. You can save a design, library, VHDL file, 
or session log under a different name using the Save As command 
on the File menu.

Note: When you save a project, Capture automatically creates a 
backup with a .DBK file extension. When you save a library, Capture 
automatically creates a backup with a.OBK file extension. If you save 
only a schematic page or part, no backup is generated.

Shortcuts:

Toolbar: 

Keyboard:

■ CTRL+S

■ ALT, F, S

Available 
from:

File menu

Function:

Use this command to save the active project, design, library, VHDL 
file, or session log under a different name or to save a new, 
unnamed project, design, library, VHDL file, or session log. You can 
save a design, library, schematic page, part, or session log with the 
Open command on the File menu.

The Save As command opens a standard Windows dialog box to 
save files.
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Print Preview command

Print command

Note: When you save a project, Capture automatically creates a 
backup with a .DBK file extension. When you save a library, Capture 
automatically creates a backup with a.OBK file extension. If you save 
only a schematic page or part, no backup is generated.

Note: When you use the Save As command, you are prompted to 
choose the file type from the Save As Type list in the Save As dialog 
box. You can choose to save the file in the current design database 
schema version or in a schema version that is one version prior to the 
application version you are currently using.

Shortcuts: Keyboard: ALT, F, A

Available 
from:

File menu

Function:

Use this command to see how a schematic page or part will look 
when printed.

After setting the options in the Print Preview dialog box, click OK to 
preview the printed document. You can use the buttons at the top of 
the window to view different pages and to zoom in and out.

Note: Be prepared to wait if you attempt to print multiple pages or 
parts. Depending on the number and size of the pages or parts you 
are previewing, Capture may require extra time to display the 
selection.

Shortcuts: Keyboard: ALT, F, V

Available 
from:

File menu

Function:
Use this command to print the active schematic page, the active 
part, or the selected items in the project manager.
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Print Setup command

Import Design command

Note: When you print multiple copies, the copies are grouped by 
page, not sorted by copy.

Shortcuts:

Toolbar: 

Keyboard:

■ CTRL+P

■ ALT, F, P

Available 
from:

File menu

Function:

Use this command to choose a printer, paper source, and orientation 
before printing. The Print Setup command displays the Print Setup 
dialog box, a standard windows dialog box for configuring your 
printer or plotter. For more information on setting up printers and 
plotters, refer to the documentation for your configured printer driver.

Tip

Many times, the options for your printer are not available in 
the standard setup dialog box. If you do not find the options 
you need, try the printer setup in the Windows Control 
Panel.

Shortcuts: Keyboard: ALT, F, R

Available 
from:

File menu

Function:

Use this command to import EDIF and PDIF designs. EDIF designs 
must be graphical EDIF designs, and not EDIF netlists. Not all 
imported PDIF parts may be edited in Capture. Such parts won't 
affect netlists.
June 2020 165 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Session log command reference
Exit command

1,2,3,4 command

View menu

This section covers:

Toolbar command on page 167

Status Bar command on page 167

Command Window command on page 167

Available 
from:

File menu

Function:

Use this command to exit the software. If necessary, you are 
prompted to save your changes.

You can also exit the software by choosing the Close command on 
the session frame Control menu (ALT, SPACEBAR, C).

Shortcuts:

Keyboard:

■ ALT+F4

■ ALT, SPACEBAR, C

■ ALT, F, X

Available 
from:

File menu

Function:
Use the numbers listed at the bottom of the File menu to open one of 
the last four projects or files. Choose the file you want to open.

Shortcuts: Keyboard: ALT, F, n (n = 1, 2, 3, or 4)
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Toolbar command

Status Bar command

Command Window command

Available 
from:

View menu

Function:

Use this command to show or hide the toolbars. This setting is 
stored in your .INI file and thus affects the visibility of the toolbars in 
subsequent sessions. You can move the toolbars anywhere on the 
screen by pressing the left mouse button over the toolbar, and then 
moving the mouse to the toolbar's new location. If the toolbar is 
moved to any edge of the window, the toolbar snaps into place. 
Otherwise, it floats on the screen wherever it is released.

If the toolbar is floating, you can hide it by choosing Toolbar from the 
View menu.

Shortcuts: Keyboard: ALT, V, T

Available from: View menu

Function:
Use this command to show or hide the status bar. This setting is stored 
in your .INI file and thus affects the visibility of the status bar in 
subsequent sessions.

Shortcuts: Keyboard: ALT, V, S

Available from: View - Toolbar menu

Function:

Use this command to open the TCL Command window in the OrCAD 
Capture workspace.

For details see the Command Window.
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Edit menu

This section covers:

Copy command on page 168

Select All command on page 168

Find command on page 169

Clear Session Log command on page 169

Copy command

Select All command

Available 
from:

Edit menu

Function:

Use this command to copy a selected object to the Clipboard without 
removing it from the active window. This command is available only if 
an object is selected.

Copying objects to the Clipboard replaces any objects previously 
stored there. Use the Paste command to copy objects to another 
page or part, or to another Windows application that supports 
pasting from the Clipboard.

Note: The Cut and Copy commands are unavailable in the part editor 
when you have one or more pins selected with other objects (such as 
arcs and lines).

Shortcuts:

Toolbar: 

Keyboard:

■ CTRL+C

■ ALT, E, C

Available 
from:

Edit menu

Function: Use this command to select all items in the active window.
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Find command

Clear Session Log command

Shortcuts: Keyboard: Ctrl+A

Available 
from:

Edit menu

Function:

Use this command to locate an object or string of text in the active 
window.

In the schematic page editor and project manager, the Find 
command finds all instances of the specified text search string, 
parts, part pins, DRC markers and constraints. The Find command 
supports wildcard searches. Use an asterisk (*) to match any string 
of characters, and a question mark (?) to match any single 
character.

In the session log, the Find command will find the next occurrence of 
the specified text search string from the current position. However, it 
does not support wildcard searches.

The Find window in part editor can search only pin and text, and it 
supports wildcard searches.

Shortcuts:

Keyboard:

■ CTRL+F

■ ALT, E, F

Available 
from:

Edit menu

Function: Use this command to clear the session log.

Shortcuts: Keyboard: ALT, E, S or CTRL+DEL
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Options menu

Preferences command on page 170

Design Template command on page 170

Autobackup command on page 170

Preferences command

Design Template command

Autobackup command

Available 
from:

Options menu

Function:

Use this command to set your environment preferences for the 
current project (and all future projects) on your system. The options 
you specify affect the behavior of the software, and are saved in the 
.INI file.

Shortcuts: Keyboard: ALT, O, P

Available 
from:

Options menu

Function:
Use this command to specify default settings for new projects, 
designs, and schematic pages. The values specified in this dialog 
box do not affect existing projects or designs.

Note: To change the properties of an active design, use the Design 
Properties command. To change the properties of an active 
schematic page, use the Schematic Page Properties command. You 
cannot change the default title block of an active schematic page.

Shortcuts: Keyboard: ALT, O, D

Available from: Options menu
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Window menu

Cascade command on page 171

Tile Horizontally command on page 172

Tile Vertically command on page 172

Arrange Icons command on page 172

1,2.... command on page 173

Close All Windows on page 173

Cascade command

Function:

Determines the frequency, location, and the number of copies of 
autobackup done by Capture. 

The Multi-level backup Settings dialog box appears when you choose 
Autobackup option from the Options menu. 

Enter the values for the following fields to determine the duration, 
number of backups, and its storage.

Backup time (in minutes) - Enables you to determine the time after 
which Capture will perform automatic backup.

No of backups to keep - Enables you to determine the total number of 
backups that will be stored.

Directory for backup - Enables you to determine the storage location 
for the backup

Shortcuts: Keyboard: ALT, O, B

Available 
from:

Window menu
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Tile Horizontally command

Tile Vertically command

Arrange Icons command

Function:
Use this command to "stack" all open Capture windows so that just 
their title bars are visible. The active window stays on top.

Shortcuts: Keyboard: ALT, W, C

Available 
from:

Window menu

Function:
Use this command to arrange open Capture windows, one above 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, H

Available 
from:

Window menu

Function:
Use this command to arrange open Capture windows, one beside 
another, so that all are visible.

Shortcuts: Keyboard: ALT, W, V

Available 
from:

Window menu

Function:
Use this command to arrange the icons for minimized windows 
across the bottom of the session frame.

Shortcuts: Keyboard: ALT, W, A
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1,2.... command

Close All Windows

Help menu

PSpice for TI Help command on page 174

Known Problems and Solutions command on page 174

What’s New command on page 174

About PSpice for TI command on page 174

Documentation command on page 175

Note: To use the context-sensitive menu commands, select one or 
more items, then press the right mouse button. The contents of the 
menu differ depending on the objects selected.

Available 
from:

Window menu

Function:

Use the numbers listed at the bottom of the Window menu to view 
which windows are currently open, and to determine which window 
is active. (The active window is indicated by a check mark.) When 
you choose a window from this list, Capture restores that window if it 
was in icon form, pops it to the front of the Capture session, and 
makes it the active window.

Shortcuts: Keyboard: ALT, W, n (n = 1, 2, . . .)

Available 
from:

Window menu

Function: Use this command to close all open windows.
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PSpice for TI Help command

Known Problems and Solutions command

What’s New command

About PSpice for TI command

Available 
from:

Help menu

Function: Use this command to display the Capture Help window.

Shortcuts:

Toolbar: 

Keyboard:

■ F1

■ ALT, H, H

Available 
from:

Help menu

Function:
Use this command to display a document listing the known problems 
in this release of OrCAD Capture and tells you how to solve or work 
around these problems.

Shortcuts: Keyboard: ALT, H, K

Available 
from:

Help menu

Function:
Use this command to display a document describing the new 
features and enhancements in this release.

Shortcuts: Keyboard: ALT, H, K

Available 
from:

Help menu
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Documentation command

Function:
Use this command to get the software version number, copyright 
information, registration number, and license information.

Shortcuts: Keyboard: ALT, H, A

Available 
from:

In the project manager or schematic page editor, from the Help 
menu, choose Documentation.

Function:

Use this command to launch the help HTML page, which contains 
links to all the documentation types (manuals and online help), 
product tutorial, and multimedia demonstrations shipped with this 
product release.

Shortcuts: Keyboard: ALT, H, D
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5
Command Window command 
reference

This chapter covers:

■ Command Window pop-up menu on page 177

Command Window pop-up menu

Font command on page 177

Background Color command on page 177

Text Color command on page 178

Save command on page 178

Clear All command on page 178

Font command

Background Color command

Available from: Pop-up menu

Function: Use this command to change the font of the Command window

Shortcuts: None

Available from: Pop-up menu
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Text Color command

Save command

Clear All command

Function:
Use this command to change the background color of the Command 
window

Shortcuts: None

Available from: Pop-up menu

Function: Use this command to change the text color of the Command window

Shortcuts: None

Available from: Pop-up menu

Function:
Use this command to save the commands in the Command window to a 
TCL file.

Shortcuts: None

Available from: Pop-up menu

Function:
Use this command to clear all the commands from the Command 
window

Shortcuts: None
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6
Window descriptions

The following is an exhaustive set of descriptions for the window 
types you may encounter using Capture. Each description is listed 
alphabetically, using the window title.

Browse window

The browse window displays the results of a browse of parts, nets, 
hierarchical ports, off-page connectors, DRC markers, and 
bookmarks.

When you browse a design or library, you can sort the results using 
the buttons at the top of the browse window. Each type of object 
offers a different set of buttons. When you click on one of these 
buttons, Capture alphabetically sorts the selection by the value of the 
corresponding property. To view a specific object, double-click on the 
item in the browse window. To add, delete, or change properties, 
select objects in the browse window, and then choose the Properties 
command from the Edit menu.

Parts

Reference Order by the part reference.

Value Order by the part value. If the part has 
no alias, this column is identical to 
Source Part.

Source Part Order by the source part. If the part is 
an alias, this column shows the original 
part.
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Nets

Hierarchical ports

Off-page connectors

Source Library Order by the source library. This column 
shows the path and library where the 
part exists.

Page Order by the schematic page the part is 
on.

Schematic Order by the schematic folder the part is 
in.

Name Order by the net alias name.

Net Name Order by the net name.

Page Order by the schematic page the net is 
on.

Schematic Order by the schematic folder the net is 
in.

Port Name Order by the hierarchical port name.

Port Type Order by the hierarchical port type.

Page Order by the schematic page the 
hierarchical port is on.

Schematic Order by the schematic folder the 
hierarchical port is in.

Off-Page Name Order by the off-page connector name.

Page Order by the schematic page the 
off-page connector is on.
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Bookmarks

DRC markers

Session frame window

The session frame contains the following components:

■ session log

■ project manager

■ browse window

■ schematic page editor

■ part editor

Schematic Order by the schematic folder the 
off-page connector is in.

Bookmark Name Order by the bookmark name.

Page Order by the schematic page the 
bookmark is on.

Schematic Order by the schematic folder the 
bookmark is in.

DRC Error Order by the DRC error message text. 
This is the text that appears in the 
session log, the DRC report, and the 
View DRC Marker dialog box.

DRC Detail Order by the object generating the error.

DRC Location Order by the absolute location of the 
error.

Page Order by the schematic page the DRC 
marker is on.
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As with other true Windows applications, each of these components 
can be reduced to an icon (minimized), opened (maximized), and 
resized. For more information on using Windows applications, see 
your Windows documentation. 

Session log window

The session log contains a record of events that occur during the 
current session of Capture. This window has a ruler with adjustable 
tabs, so you can format the way the information in the session log 
appears. This formatting only applies to the session log. It doesn't 
affect the way reports are formatted in other applications. You can set 
the session log ruler measurements to appear in U.S. or metric units 
by using the appropriate setting in the Regional Settings of your 
Control Panel.

The session log also includes results and messages from Capture 
utilities found on the Tools menu. If Capture reports an error or 
warning in the session log, you can get specific help on it by 
double-clicking on the message. In this case, Capture opens the file 
that contains the error and places the cursor at the location of the 
error. These files include netlists, CDS.LIB, HDL.VAR, and 
VHDL/Verilog models.

Note: The following Capture utilities are found on the Tools menu:

Annotate
Back Annotate
Update Properties
Create Netlist
Cross Reference
Bill of Materials
Export Properties
Import Properties

The session log is replaced every time you start Capture, so it is 
initially empty. You can clear the session log at any time by choosing 
Clear Session Log (ALT, E, S) from the Edit menu, or pressing 
CTRL+DEL.

You can minimize the session log by pressing CTRL+F4, or by 
choosing the Close button in the upper-right corner of the session log 
window. To open the session log, choose Session Log (ALT, W, 1) 
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from the Window menu. The session log records utility results and 
error messages even while it is minimized.

You can save the session log as an ASCII text file, and you can copy 
text from the session log onto the Clipboard. You cannot load a saved 
session log into Capture, and you cannot cut or paste text in the 
session log. 

Part editor window

You edit parts and symbols in the part editor window. This window 
has two view splitters. The splitter at the upper right divides the view 
horizontally. The splitter at the lower left divides the view vertically. 
Each view has its own scroll bars, so you can view separate areas on 
the same part.

You can create parts up to 32 by 32 inches.

Part View

You edit parts in this view.

Package View

You see the entire package in this view. You cannot edit parts in this 
view, but you can select parts to edit. This view has no view splitters.

The part editor tool palette is unavailable in this view. 

Property Editor window

The property editor window appears when you select some 
combination of parts, nets, pins, title blocks, aliases and globals in 
the schematic page editor, and then choose Properties from the Edit 
menu or choose Edit Properties from the pop-up menu. You can use 
the property editor window to edit part, net, pin, title block, global, 
port, and alias properties. The property editor displays all library 
definitions, instance properties, and occurrence properties for an 
object.
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Caution

Do not manually change the reference designators 
of heterogeneous parts for a complex hierarchical 
design. In case you want to change the reference 
designator for a part placed in the schematic page, 
delete the part and add it again. This way all the 
occurrences will get updated correctly.

New Property

Displays the Add New Property dialog box, depending on the 
property editor orientation, to add a new property column or row. To 
add the property to an object, you must enter a property value for a 
given object.

Apply

Applies the changes in the property editor to the schematic page. 
The Apply button does not dismiss the property editor. You can also 
apply the changes to the schematic page by closing the property 
editor.

Display

Displays the Display Properties dialog box to set the display option of 
the selected property and its value. You cannot display properties of 
an occurrence property using the Display Properties dialog box.

Delete Property

Deletes the editable property from the selected object or objects. 
(Properties that are not editable appear in italics.) If you select all of 
a property's cells and click the Delete Property button, the property 
will be removed from the selected objects but will remain in the filter. 
This is indicated by the hash marks that appear in the cell.
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Filter by

Specifies a filter by which to view the objects. Use the property editor 
filter to constrain the available properties. For example, the Capture 
filter displays common schematic capture properties available to 
most parts, while the Cadence-Allegro filter displays properties 
needed to send a design to PCB Editor. You can view all the 
properties available on the objects in the property editor by selecting 
the <Current properties> filter from the drop-down list.

Parts

Displays the parts of the selected objects. The Parts tab includes 
hierarchical blocks.

Schematic Nets

Displays the schematic nets of the selected objects. This tab includes 
constituent nets within buses.

Pins

Displays the pins of the selected objects. This tab includes 
hierarchical pins in hierarchical blocks.

Title Blocks

Displays the title blocks of the selected objects.

With the Title Blocks tab selected, you can add a property to the Title 
Block instance on a schematic page that will display the full 
hierarchical path to the schematic.

Globals

Displays selected globals for simultaneous editing of multiple names.
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Ports

Displays source symbol, source library, and type of port. Provides for 
simultaneous editing of multiple ports.

Aliases

Displays color, font, name, and rotation of net aliases. Use the 
Aliases tab to edit multiple aliases at one time.

Rows and columns

Each row displays an instance or an occurrence of an object. 
Instance rows appear with a white background. Occurrences appear 
in yellow below their associated instance row. Occurrence rows 
automatically appear when one or more of the occurrence property 
values are different from the instance property values.

Each column is a placeholder that you can use to add properties. The 
cells in the property editor show the property values for each instance 
or occurrence. A cell with hash marks in indicates that the property 
does not exist on the object that the cell represents. You can add a 
value by clicking inside the cell, typing the value, and pressing 
ENTER or clicking the Apply button. A property value in italics is a 
read only property cannot be edited.

Tip

Roll the mouse wheel up and down to scroll through 
vertically in the Property Editor.

Tip

Hold down the CTRL key and roll the mouse wheel to zoom 
in and zoom out.

Tip

Hold down the SHIFT key and roll the mouse wheel up and 
down to scroll through horizontally in the Property Editor.
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Tip

Click the mouse wheel button and drag the mouse wheel:

❑ To the right or left in the Property Editor window to scroll 
horizontally.

❑ Up or down in the Property Editor window to scroll vertically.

Short-cut keys

The following short-cut keys apply to the Property Editor:

Operation/command Short-cut key

Undo CTRL+Z

Copy CTRL+C

Paste CTRL+V

Cut CTRL+X

Find CTRL+F

Move to first cell in column PageUp/CTRL+<Up-Arrow>

Move to last cell in column PageDown/CTRL+<Down-Arrow>

Move to first cell in row CTRL+<Left-Arrow>

Move to last cell in row CTRL+<Right-Arrow>
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Project manager window

The project manager appears in the Capture session frame 
whenever you open or create a project. Use the project manager to 
collect and organize all the resources you need for your project 
throughout the design flow. These resources include schematic 
design files, part libraries, netlists, VHDL models, simulation models, 
timing files, stimulus files, and any other related information.

The project manager provides two views of a project. If you choose 
the File tab, you see a complete list of all project resources and files, 
organized in folders. If you choose the Hierarchy tab, you see the 
hierarchy view, which displays the hierarchical relationship among 
the various design modules. A design module is a structural block, 
typically represented as a distinct hierarchical entity, that defines the 
functionality of a particular portion of your design. A design module 
in Capture can be either a VHDL model or a schematic folder.

Each project may contain one design. This design may consist of any 
number of schematic folders, schematic pages, or VHDL models, but 
must have a single root module. The root module is the module that 
is defined as the top-level entity for the design. That is, all other 
modules in the design are referenced within the root module.

Within the project manager, you can expand or collapse the structure 
you are viewing by clicking on the plus sign or minus sign to the left 
of a folder. A plus sign indicates that the folder has contents that are 
not currently visible; a minus sign indicates that the folder is open and 
its contents are visible, listed below the folder. When you double-click 

Undo Edit (within a cell)  Esc

Select SHIFT+<Arrow key>

Move to top left cell in spreadsheet CTRL+Home

Move to bottom right cell in 
spreadsheet

CTRL+End

Select cell contents CTRL+F2

Close spreadsheet CTRL+F4

Operation/command Short-cut key
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on a schematic folder, Capture displays the schematic pages within 
that folder. If the folder is a VHDL model, Capture displays each 
defined entity in that model. When you double-click on a schematic 
page or a VHDL entity, you open that object in an appropriate editor. 
For example, double-clicking on a VHDL entity opens the VHDL 
model file at the location of that entity definition in Capture's VHDL 
editor.

Each project you open has its own project manager window. You can 
move or copy folders or files between projects by dragging them from 
one project manager window to another (as well as from the 
Windows Explorer). If you close a project manager window, you close 
the project.

File tab

The file tab shows all the files included in the project. These files may 
include VHDL models, netlists, schematic pages, simulation models, 
stimulus files, or any other files that contain information related to the 
project. The file view is organized in folders, each of which contains 
certain types of project files.

Hierarchy tab

The Hierarchy tab shows the hierarchical relationship among the 
various modules of the design.

Each instantiation of a particular module appears in the hierarchy 
view as part of a hierarchical "tree". The hierarchical view of the 
design is derived from the files that exist in the Design Resources 
folder.

Schematic page editor window

You edit schematic pages in the schematic page editor window. This 
window has two view splitters. The splitter at the upper right divides 
the view horizontally. The splitter at the lower left divides the view 
vertically. Each view has its own scroll bars, so you can view separate 
areas on the same page.
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Tip

Roll the mouse wheel up and down to scroll through 
vertically.

Tip

Hold down the CTRL key and roll the mouse wheel to zoom 
in and zoom out.

Tip

Hold down the SHIFT key and roll the mouse wheel up and 
down to scroll through horizontally.

Tip

Click the mouse wheel button and drag the mouse wheel:

❑ To the right or left in the schematic page editor to scroll 
horizontally.

❑ Up or down in the schematic page editor to scroll vertically. 

Text editor window

Use the text editor to create or edit text files such as VHDL or Verilog 
files and simulation models. You can set syntax for VHDL and Verilog 
to appear in different colors in the Text Editor tab in the Preferences 
dialog box.

You can open the text editor by choosing Open from the File menu, 
by selecting a text file in the project manager and choosing Edit from 
the pop-up menu, or by dragging the file from the Explorer into the 
session frame. You can only open ASCII text files using the text 
editor.

The text editor has the following features:
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Help

Saving and Printing

Editing text

Searches

Blocks and marks

Help Topics F1

Save CTRL+S

Print CTRL+P

Join Line ALT+J

Split Line ALT+S

Copy CTRL+C

Paste CTRL+V

Cut CTRL+X

Cut line to clipboard CTRL+Y

Undo CTRL+Z

Redo CTRL+A

Delete DELETE

Toggle insert/overwrite mode INSERT

Search Forward CTRL+F

Search Backward CTRL+SHIFT+F

Select up one line SHIFT+UP ARROW

Select down one line SHIFT+DOWN ARROW

Select left one character SHIFT+LEFT ARROW
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Select right one character SHIFT+RIGHT ARROW

Select left one word CTRL+SHIFT+LEFT ARROW

Select right one word CTRL+SHIFT+RIGHT 
ARROW

Select to end of line SHIFT+END

Select to end of file CTRL+SHIFT+END

Select to beginning of line SHIFT+HOME

Select to beginning of file CTRL+SHIFT+HOME

Select one page down SHIFT+PAGE DOWN

Select to end of file CTRL+SHIFT+PAGE DOWN

Select one page up SHIFT+PAGE UP

Select to beginning of file CTRL+SHIFT+PAGE UP
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Cursor control

Pop-up menu

A pop-up menu is available in the text editor window. Click the right 
mouse button to bring up the pop-up menu. The following commands 
are available in this menu:

■ Cut command

■ Copy command

■ Paste command

■ Delete command

■ Select All command

■ Undo command

■ Find command

Move cursor up one line UP ARROW

Move cursor down one line DOWN ARROW

Move cursor left one character LEFT ARROW

Move cursor right one 
character

RIGHT ARROW

Move cursor left one word CTRL+LEFT ARROW

Move cursor right one word CTRL+RIGHT ARROW

Move cursor to end of line END

Move cursor to beginning of 
line

HOME

Page up PAGE UP

Page down PAGE DOWN

Move cursor to beginning of file CTRL+HOME

Move cursor to beginning of file CTRL+PAGE UP

Move cursor to end of file CTRL+END

Move cursor to end of file CTRL+PAGE DOWN
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Browse Spreadsheet editor window

You use the Browse spreadsheet editor to perform the following 
tasks:

■ Create a new property

■ Copy a value from one property to another property

■ Remove a user-defined property

■ Replace property values

You can display the Browse spreadsheet editor from the project 
manager, schematic page editor, or the part editor. 

From the project manager - Select the schematic design and select 
the Browse command from the Edit menu. You can select a 
component from the resulting popup menu. To display the Browse 
spreadsheet editor, select the component and click Properties from 
the Edit menu. You can change the properties of the following 
components from the Browse spreadsheet editor.

■ Parts (including hierarchical blocks)

■ Nets (including constituent nets within a bus) occurrences

■ Flat Netlist

■ Hierarchical ports

■ Off-page connectors

■ Title blocks

■ Bookmarks

■ DRC markers

From schematic page editor - Select the schematic page in the 
project manager and select the Browse command from the Edit 
menu. You can select a component from the resulting popup menu. 
To display the Browse spreadsheet editor, select the component and 
click Properties from the Edit menu. You can change the properties 
of the following components from the Browse spreadsheet editor.

■ Parts (including hierarchical blocks)
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■ Nets (including constituent nets within a bus) occurrences

■ Hierarchical ports

■ Off-page connectors

■ Title blocks

■ Bookmarks

■ DRC markers

From the part editor (while in Part View) - You can edit the following 
properties from the Browse spreadsheet editor:

■ Pin properties

The Browse spreadsheet editor browses the entire design for the 
objects you select, then displays their properties. Each property 
appears as a column heading in the spreadsheet. Each row is an 
object located by the editor.

It is important to note that, in the Browse spreadsheet editor you can 
edit only occurrences. The only exception being in the part editor, 
where you can only edit instances. To edit instance properties, you 
must use the property editor.

Note: You can use the CTRL + C keys to copy a value from a cell and 
the CTRL + V keys to paste onto another cell in the Browse 
spreadsheet editor. Also, you can use the CTRL+ INSERT keys to 
copy a value from a cell in the Browse spreadsheet editor and paste 
it onto a cell in Microsoft Excel worksheet or use the SHIFT+ INSERT 
keys to paste values copied from Microsoft Excel onto a cell in the 
Browse spreadsheet editor.

Command Window

OrCAD Capture includes a scripting functionality that allows you to 
execute a Capture command through a command prompt in the 
Capture command window.

Every user action performed in Capture is logged in the form of a 
command. This command that logged is registered with a TCL 
interpreter. When the command is played back, Capture uses the 
TCL interpreter to retrieve the command and execute it in the resident 
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application. However, this process is completely abstracted from the 
Capture. This makes logging and replaying of a set of commands an 
intuitive and simple task.

To execute a command, you type the command at the command 
prompt and press Enter.

Also, if you perform an operation in the Capture interface, the 
associated command is registered with the TCL interpreter and the 
command is logged in the Command window.

Finally, every command that is registered with the interpreter is 
logged in a captcl file. You can then use this file to re-run a complete 
set of commands. You can do this from the Capture command 
window or from the Operating System command prompt by passing 
the script name (including location) as an argument to capture.

Project Manager folders

The project manager is a tool that allows you to collect and organize 
all the resources you need for your project throughout the design 
flow. These resources include schematic pages, part libraries, and 
netlists, and may also include VHDL models, simulation models, 
timing files, stimulus files, and other related information.

When the project is first created, the project manager creates a 
design file with the same name as the project. It also creates a 
schematic folder within the design file, and a schematic page within 
the folder. You can create a new design to replace the design created 
by the project manager

Folder Description

Design Cache A local library contained in each project that 
contains all the parts and symbols used in the 
design.

Library Lists the library files and related files included in 
the current project. These files include library 
(*.OLB) files, simulation and synthesis (*.VHD) 
files, *.STL files, and *.SML files.
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Outputs Stores output files generated by Capture tools, 
such as Create Netlist, Design Rules Check, 
Cross reference reports, Bill of Materials, Export 
Properties, and Generate Part etc.

Referenced Projects Stores any projects referenced from within the 
current project. 
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Introduction

The following list contains a mapping of the Capture Color IDs 
to their corresponding RGB values.

Capture Color ID RGB Value Color Sample

1 255, 255, 128

2 128, 255, 128

3 0, 255, 128

4 128, 255, 255

5 0, 128, 255

6 255, 128, 192

7 255, 128, 255

8 255, 0, 0

9 255,255, 0
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10 128,255,0

11 0, 255, 64

12 0, 255, 255

13 0, 128, 192

14 128, 128, 192

15 255, 0, 255

16 128, 64, 64

17 255, 128, 64

18 0, 255, 0

19 0, 128, 128

20 0, 64, 128

21 128, 128, 255

22 128, 0, 64

23 255, 0, 128

24 128, 0, 0

25 255, 128, 0

26 0, 128, 0

27 0, 128, 64

Capture Color ID RGB Value Color Sample
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28 0, 0, 255

29 0, 0, 160

30 128, 0, 128

31 128, 0, 255

32 64, 0, 0

33 128, 64, 0

34 0, 64, 0

35 0, 64, 64

36 0, 0, 128

37 0, 0, 64

38 64, 0, 64

39 64, 0, 128

40 0, 0, 0

41 128, 128, 0

42 128, 128, 64

43 128, 128, 128

44 64, 128, 128

45 192, 192, 192

Capture Color ID RGB Value Color Sample
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46 64, 0, 64

47 255, 255, 255

48 Windows Default 
Color

Capture Color ID RGB Value Color Sample
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Dialog box descriptions

The following is an exhaustive set of descriptions for the dialog boxes 
you may encounter while using Capture. Each description is listed 
alphabetically, using the dialog box title.

Add file to Project Folder dialog box

Use this dialog command to add files to a project. You can select 
multiple files to add using the CTRL key. The title bar of the dialog box 
displays the folder into which the files will be added (the folder 
currently selected in the project manager window).

To open this dialog

Choose Project (see Project command) from the Edit menu.

Add New Property dialog box

Use this dialog to add a new property to the selected object (or 
objects).

Use this control... To do this...

Look in Browse the hierarchical drive and directory structure for 
your system.

File name Select or type the name of the project or file(s) that you 
want to add to the Project Folder.

Files of type Filter files by extension.
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To open this dialog

In the property editor window, click the New Property button.

Note: You can narrow your selection of objects by selecting one or 
more object columns/rows in the property editor before opening this 
dialog box. When you enter a name and value, then click OK or Apply, 
the property is applied to the selected objects.

Add to Project dialog box

To open this dialog

Choose Library from the File - New menu with the focus away from 
the currently open schematics or the project manager.

The dialog box prompts you to either add the new library to the 
currently open projects or to a new project.

Use this control... To do this...

Name Displays the name of the new property column or row to 
add in the property editor.

Value Displays the value of the new property column or row to 
add to selected objects and in the property editor. If you 
enter the name of an existing property in the Name text 
box, its current value appears in this text box.

Display [ON/OFF] Select the check box to display the Display Properties 
dialog box.

Always show this column/row in 
this filter

Select the check box to save the new column/row in the 
current filter. You cannot save a new column or row in the 
<Current properties> filter.
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Annotate dialog box

To open this dialog

Select a design (.DSN) in the Project manager then

Choose Annotate from the Tools menu.

OR

Choose the Annotate button on the Capture toolbar.

Packaging tab

Use this tab... To do this...

Annotate parts and group parts together that have 
common characteristics. Packaging is a key step that 
should be done before netlisting to a PCB board design 
tool such as PCB Editor.

Generate a reuse module or renumber the reference 
designators in a reuse module in Capture. Reuse 
modules may be netlisted then used in PCB Editor or 
used in Capture as library parts or as hierarchical blocks.

Use this control... To do this...
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Refdes control required Check this option, if you want to specify a part reference 
range for each schematic page or a hierarchical block in 
the root-level of your design. 

Important

This functionality works independently from the 
existing annotation behavior of Capture.

Important

If you are using the Refdes control required 
option for a project, then the Auto reference 
placed part option in the Miscellaneous tab of 
the Preferences dialog box will not honor the 
range specified in the grid.

For more description about how to use this option to 
specify a part reference range for a schematic page or a 
hierarchical block, see Customizing part references in a 
design.

Scope

■ Update entire design

■ Update selection

Specify whether to ll the part references in the design (or 
library), or just the selected schematic pages.

■ Schematic Pages

■ Hierarchical Blocks

Note: These options are available only when you select 
the Refdes control required check box.

Note: The Scope options changes to Schematic Pages or 
Hierarchical Blocks depending on whether your design is 
a flat design or a hierarchical design.

Grid (for specifying part 
reference range)

■ Pages or H-Blocks column

Note: This grid appears only when you select the Refdes 
control required check box.

Displays all the schematic pages or hierarchical blocks in 
the root schematic folder of your design depending on 
whether your design is a flat design or a hierarchical 
design.
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■ Start Value and End Value 
columns

Specify a numeric value greater than 0 in the cell 
corresponding to the schematic page name or 
hierarchical block name.

Tip

Use the Tab key to move from the Start Value 
column to End Value column.

You can also use the Arrow keys to move around in 
the grid.

You can use the column handle ( ) to resize the 
rows and columns in the grid.

Note: A valid range must have both the Start and 
End Values and the End Value must be greater than 
the Start Value.

Action

Incremental reference update If checked, Capture incrementally updates parts with a 
question mark in the part reference. For example, parts 
with reference designators of U?A will be numbered U1A, 
U1B, U1C, and so on. Part reference and package 
information is not updated on existing parts.

Unconditional reference update If checked, Capture updates all parts in the selected 
schematic pages. Both part reference and package 
information may be updated on existing parts. Parts on 
different schematic pages are not packaged together.

Reset part references to “?” Specifies to reset all the part references to "U?"

Add intersheet references Specifies to add intersheet references to the design.

Delete intersheet references Specifies to remove all intersheet references from the 
design.

Note: If your design contains multiple heterogeneous 
parts that are the same part in the package, you will need 
to update their part references after every time you reset 
all part references to "U?" or group them using a grouping 
property. For more information, see Working with Parts.
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Annotation Type Specifies the sequence in which the components on the 
design are annotated.

The Annotation Sequence list contains three options that 
you can use to decide the sequence in which the objects 
on your design are annotated - Default, Left to Right & 
Top to Bottom.

Mode Specifies to update either instances or occurrences. 
Capture automatically sets this option based on the 
project type. All designs default to use instances. If a 
PCB or schematic design is complex or has occurrence 
properties, the default shifts to occurrences. Capture 
recommends the preferred mode, which you can 
override.

Physical Packaging Specifies the properties that must match for Capture to 
group parts into a single package. Value and Source 
Library properties are the default property string, but you 
can use any combination you like.

The value in Additionally From INI is updated using the 
value specified by you in the Capture.ini file 
AnnotateAdditionalPropertyString property. For 
example, to specify PartGroup as the value, set it in 
Capture.ini as 
AnnotateAdditionalPropertyString={PartGrou
p}. You can also specify more than one value such as 
{Value}{Source Package}. If you change this value 
in the field, Capture.ini will be updated accordingly.

Note: Do not use {GROUP} as a property string in 
combined property strings text box. This may cause 
problems while annotating your design for a PCB Editor 
tool, like Allegro PCB Editor. The GROUP property is 
used in PCB Editor for a specific purpose.
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For example, you might want to use Value and Voltage. 
Say your design uses both Tantalum capacitors and 
ceramic disk capacitors. First, you could assign ".01uF" 
to the part Value property for all the capacitors. Then, you 
could define a user property called "Voltage" for all 
capacitors in the design, and assign it the value "100V" or 
"25V" as appropriate. To annotate your design, type 
"{Value} {Voltage}" (without the quotation marks) in the 
Part Value property combine text box.

In this example, Capture groups the parts with "C?" as 
the part reference, and ".01uF" as the part value, but it 
separates the 100V Tantalum capacitors from the 25V 
ceramic disk capacitors.

Additionally From INI Specifies a combined property string that gets added in 
the Capture.ini file under the Preferences section, such 
as 
AnnotateAdditionalPropertyString=<property 
name>. For example, adding {ROOM} in the Additionally 
From INI field has the following entry under the 
Preferences section: 
AnnotateAdditionalPropertyString={ROOM}

Once added, any project opened in Capture will have this 
property.

Reset reference numbers to 
begin at 1 in each page

Specify whether to number parts within the context of the 
schematic folder. When this option is selected, Capture 
begins numbering parts at 1 for every selected page. 
Otherwise, Capture continues numbering after the 
highest referenced part in the selected schematic pages.

Annotate as per PM page 
ordering

Specify whether to perform the annotation on the basis of 
order of pages/ folders in the Project Manager window. If 
there are multiple folders and multiple pages in each 
folder then the root folder is annotated first followed by its 
pages. Alphabetic order is followed to determine the 
sequence of pages in a folder.

Annotate as per page ordering 
in the title blocks

Specify whether to perform annotation according to 
numbers on the page numbers specified in the title 
blocks of the schematic pages. 
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Archive Project dialog box

To open this dialog

In the Project manager, choose Archive Project (see Archive Project 
command) from the File menu.

Do not change the page number Check this option if you have chosen to annotate as per 
page ordering in the title blocks option, changed the page 
numbers in the title blocks, but do not want to change the 
page ordering on reannotation.

Include non-primitive parts Specifies whether to annotate non-primitive parts or to 
reset non-primitive part references to “?”. Select this 
option to avoid netlisting duplicate reference errors when 
you want to simulate a design or generate a new part.

Preserve designator Specifies that the designator information of a 
homogeneous part during unconditional or reset 
annotation is to be preserved.

Preserve User Assigned Valid 
References

Specifies that the user assigned reference designator 
during annotation is to be preserved.

Note: You can explicitly mark a reference as user 
assigned by choosing User Assigned Flag – Set from the 
pop-up menu for the Reference property in the Property 
Editor or from the pop-up menu of a part in the schematic 
page. Any references changed using Property Editor, 
Schematic Editor, or during backannotation are marked 
as changed and are preserved on selecting this and the 
previous option.

Use this control... To do this...
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Library files Note: Archive library files and related files located in the 
Library folder of the project manager. These files include 
library (*.OLB) files, simulation and synthesis (*.VHD) 
files, *.STL files, and *.SML files. The PSpice model 
libraries are archived as follows:

❑ Profile-level model libraries are archived under 
their respective profiles and referenced as 
.\<library_name>.lib. For example, when a 
profile; AC containing a model library diode.lib 
is archived, the diode.lib is copied under the 
folder AC and the simulation settings is modified 
as: .\diode.lib.

❑ Design-level model libraries are archived under 
.\<design_name-pspicefiles>\<des
ign_name>\<library_name>.lib. For 
example, when a design called histo containing 
a model library bipolar.lib is archived, the model 
library bipolar.lib is copied under folder 
histo-pspicefiles\histo and the 
simulation settings is modified as: 
.\histo-pspicefiles\histo\bipola
r.lib.

❑ In case of global-level model libraries:

❍ a copy of model library is created under the 
existing <design_name>.lib, if it exists

❍ a new <design_name>.lib file is created 
and a copy of model library is added to the 
<design_name>lib and the simulation 
setting is modified as design-level library.

Include TestBench Include any testbench which is part of the current project.

Output files Archive output files generated by Capture tools.

For example, cross reference reports (*.XRF files), EDIF 
netlists (*.EDN files) and PSpice project .DAT files, would 
be archived.

Referenced projects Recursively save any projects referenced from within the 
current project.
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Attach Implementation dialog box

To open this dialog

Choose Attach Implementation

■ From the New Part Properties dialog box.

OR

■ From the Edit Part Properties dialog box

Archive directory Specify the drive and directory for the project to be 
archived in.

Use the ... button to display the Select Directory dialog 
box where you can locate and select a new drive, 
directory, or both.

Create single archive file Activate the File name text box for specifying the name of 
the compressed archive file.

File name Specify a name for the compressed archive file. The 
default name is <projectname-current date>.

Add more files Add more files and folders to be archived.

Browse for Specify whether you want to add more files or directories 
to your archive. 

Select the Directories option to add a directory or the 
Files option to add more files to your archive.

Additional Files/Directories Specify files and directories you want to be archived. 

Use the ... button to select the files and directories you 
want to archive.

Use this control... To do this...
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Implementation Type Specify the type of implementation from one of the following:

Schematic View Indicates that the attached implementation is a 
schematic. Capture automatically generates the appropriate 
hierarchical pins for the hierarchical block based on the 
hierarchical ports.

VHDL Indicates that the attached implementation is a VHDL 
entity. Capture automatically generates the appropriate 
hierarchical pins for the hierarchical block based on the port 
declarations in the VHDL entity.

Verilog Indicates that the attached implementation is a Verilog 
model. Capture automatically generates the appropriate 
hierarchical pins for the hierarchical block based on the port 
declarations in the Verilog model.

EDIF Indicates that the attached implementation is an EDIF 
netlist. If your design includes EDIF implementations for 
hierarchical blocks, you must specify the hierarchical pins for the 
hierarchical block; Capture will not generate them from the EDIF 
netlist. Also, if your design includes EDIF implementations, you 
can simulate them, but you cannot compile or build them.

Project Indicates that the attached implementation is a Capture 
programmable logic project. You must specify the hierarchical 
pins for the hierarchical block; Capture will not generate them.

Attaching an implementation does not automatically add that file, 
project, or schematic folder to the project. You must specifically 
add the implementation to the project with the Project command.

Implementation Specify the name of the attached object.

Implementation Path Specify the path and name of the library or file where the 
attached object is located.
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Advanced Annotation

To open this dialog

Select the Capture design file in the Project Manager, choose Tools 
– Annotate, and click Advanced Annotation.

Note: The Advanced Annotation option appears only in Capture 
Schematic designs, that is, the Capture designs that have 
occurrences.
, 

Use this control... To do this...

Design Hierarchy

Select the Design Hierarchy option to select a design or 
its pages to apply advanced annotation.

Property Block

Select a property from the drop-sown list to apply 
advanced annotation on those objects that have the 
selected property in their properties.

Reference Range for

Prefix Specify the Part Prefix

Instance Count Specify the number of instances that have the same 
prefix

Start Specify the start of the Reference Range

End Specify the end of the Reference Range

Auto Fill Prefix Automatically fills all the prefixes that are present in the 
design

Add Row Adds a row to define Prefix, Instance Count, Start, and 
End

Delete Row Deletes a row that contains Prefix, Instance Count, Start, 
and End

Delete All Delete all the rows that contains Prefix, Instance Count, 
Start, and End

Apply Applies the changes made to the selected
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Dialog box descriptions
Inherited Ranges

Specifies the inherited ranges from the top-level, such as 
Capture design

Action

Incremental reference update If checked, Capture incrementally updates parts with a 
question mark in the part reference. For example, parts 
with reference designators of U?A will be numbered 
U1A, U1B, U1C, and so on. Part reference and package 
information is not updated on existing parts.

Unconditional reference update If checked, Capture updates all parts in the selected 
schematic pages. Both part reference and package 
information may be updated on existing parts. Parts on 
different schematic pages are not packaged together.

Reset part references to “?” Specifies to reset all the part references to "U?"

Annotation Type Specifies the sequence in which the components on the 
design are annotated.

The Annotation Sequence list contains three options that 
you can use to decide the sequence in which the objects 
on your design are annotated - Default, Left to Right & 
Top to Bottom.

Annotation Scheme

Annotate as per page ordering 
in the title blocks

Specify whether to perform annotation according to 
numbers on the page numbers specified in the title 
blocks of the schematic pages. 

Annotate as per page ordering 
in the title blocks

Specify whether to perform annotation according to 
numbers on the page numbers specified in the title 
blocks of the schematic pages.
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Dialog box descriptions
Combined Property String Specifies the properties that must match for Capture to 
group parts into a single package. Value and Source 
Library properties are the default property string, but you 
can use any combination you like.

Note: Do not use {GROUP} as a property string in 
combined property strings text box. This may cause 
problems while annotating your design for a PCB Editor 
tool, like Allegro PCB Editor. The GROUP property is 
used in PCB Editor for a specific purpose.

For example, you might want to use Value and Voltage. 
Say your design uses both Tantalum capacitors and 
ceramic disk capacitors. First, you could assign ".01uF" 
to the part Value property for all the capacitors. Then, 
you could define a user property called "Voltage" for all 
capacitors in the design, and assign it the value "100V" 
or "25V" as appropriate. To annotate your design, type 
"{Value} {Voltage}" (without the quotation marks) in the 
Part Value property combine text box.

In this example, Capture groups the parts with "C?" as the 
part reference, and ".01uF" as the part value, but it 
separates the 100V Tantalum capacitors from the 25V 
ceramic disk capacitors.

Additional from INI

Include Non-Primitive Parts Specifies whether to annotate non-primitive parts or to 
reset non-primitive part references to “?”. Select this 
option to avoid netlisting duplicate reference errors when 
you want to simulate a design or generate a new part.

Preserve Designator Specifies that the designator information of a 
homogeneous part during unconditional or reset 
annotation is to be preserved.
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Dialog box descriptions
Preserve User Assigned Valid 
References

Specifies that the user assigned reference designator 
during annotation is to be preserved.

You can explicitly mark a reference as user assigned by 
choosing User Assigned Flag – Set from the pop-up 
menu for the Reference property in the Property Editor or 
from the pop-up menu of a part in the schematic page. 
Any references changed using Property Editor, 
Schematic Editor, or during backannotation are marked 
as changed and are preserved on selecting this and the 
previous option.
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Dialog box descriptions
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Bill of Materials dialog box

To open this dialog

Choose Bill of Materials (see Bill of Materials command) from the 
Tools menu.

Use this control... To do this...

Scope Select the scope of the bill of materials. The scope can 
cover the entire design, or the selected schematic folders 
and pages.

Mode Include either instances or occurrences. Capture 
automatically sets this option based on the project type. 

Line Item Definition

Header Specify a header that Capture inserts on each page. If 
this is left blank, Capture assumes there is no header.

For example, "Item\tQuantity\tPart" creates a header that 
displays column entries of "Item", "Quantity", and "Part" 
each separated by a tab character.

Combined property string Specify the properties that must match for Capture to 
group them in the bill of materials. Typically, this text box 
should be set to "{Value}" (without the quotation marks).

To insert a tab, use the \t character sequence. For 
example, "{Reference}\t{Value}" prints a part's reference, 
a tab character, and the part's value.

To create separate listings for 100V and 25V .01uF 
capacitors, for example, set the Part Value combined 
property string to "{Value} {Voltage}" (without the 
quotation marks), where Voltage is a user property in 
which you store the appropriate voltage values.

Place each part entry on a 
separate line

Specify that each part entry appears on a separate line in 
the bill of materials report file. When this option is 
selected, the quantity of parts sharing the same Part 
Value appear on one line, then each part is listed below. 
When this option is not selected, all the parts with the 
same Part Value are listed on one line.
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Browse File dialog box

The Browse File dialog box appears when you choose the Browse 
button from any dialog box with a Browse button.

Include File

Merge an include file with report Specify whether to merge an include file with the report. 
For more information about include files, see .

Combined property string Specify a lookup string to match in the include file.

Include file Specify the path and name of the include file.

Report

Report File Specify the bill of material's output file. 

View Output Open the bill of materials report file in a text editor.

Browse Display a standard Windows dialog box for selecting files.

Use this control... To do this...

Look in Specifies the drive and directory to locate the file in.

File name Specifies the name of the file to look for.

Files of type Specifies the type of files to look for.

Open as read-only Specifies to open the file as a read-only file.
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Color dialog box

The Color dialog box appears when you click on a color in the Colors 
tab in the Preferences dialog box.

Create Directory dialog box

To open this dialog

Click the Create Dir button in the Select Directory dialog box.

Create PSpice Project dialog box

To open this dialog

Choose the OK button on the New Project dialog box after selecting 
the Enable PSpice Simulation check box.

Use this control... To do this...

Basic colors Shows the color of the object selected in the Colors tab.

To change the color, click the left mouse button on a 
different color and then click OK.

Custom colors This feature is disabled in Capture.

Define custom colors This feature is disabled in Capture.

Use this control... To do this...

Current Directory Shows the current directory. The new directory will be a 
subdirectory to the current directory.

Name Specify the name of the new directory to be created 
below the current directory.
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You need to select one of two options in this dialog box.

Configure Properties dialog box

To open this dialog

Right-click and select Configure Properties in the Find Results 
window and search browser window.

Use this control... To do this...

Create based upon an 
existing project

When you select this option, you indicate that you want to 
use an existing Capture project file (.OPJ) as an initial 
starting point for an analog or mixed signal project.

If you select this option, you need to also select a project 
file, using either the drop-down menu or the Browse 
button to the right.

After selecting this option and choosing the OK button, a 
new project appears. This new project is identical to the 
existing project you previously selected in the following 
respects: 

■ It has the same name.

■ It contains the same configured libraries and designs. 

■ It contains renamed copies of simulation profiles, 
local simulation files, model libraries, include files, 
and marker files (.MRK).

Create a blank project By selecting this option and choosing the OK button, you 
create a new project that is capable of being simulated in 
PSpice AD.

Use this control... To do this...

Left Arrow Remove the property from the Find window 

Right Arrow Add the property to the Find window
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Up Arrow To move the property to be displayed up in the Configure 
Properties window

Down Arrow To move the property to be displayed down in the 
Configure Properties window
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Delete Part Property dialog box

To open this dialog

In the Project manager, select the design (.DSN) a schematic folder, 
or a schematic page then choose Delete Part Property from Edit 
menu.

Design Properties dialog box

To open this dialog box

1. Right-click a design (.DSN) in the project manager.

2. Choose Design Properties from the pop-up menu.

Alternatively:

1. Select a design in project manager.

2. Select Options – Design Properties (see Design Properties 
command).

Use this control... To do this...

Property Name Type the name of the property you want to remove.

Use this tab... To do this...

Fonts Change the fonts for objects with text. A standard 
Windows Font dialog box appears when you click on the 
font display of an item.

Hierarchy Specify default settings of primitive or nonprimitive for 
hierarchical blocks and parts. These options affect parts 
and hierarchical blocks that have the Primitive property 
set to default. When parts are marked as primitive, you 
cannot descend into them, even if they have attached 
schematic folders.
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SDT Compatibility Define the mapping to use when saving designs in SDT 
format. Capture uses the properties specified in this tab 
to define the part field lines when it creates an SDT.CFG 
during translation.

To make SDT part fields carry over into Capture 
properties, you need to specify them in the SDT.CFG file. 

Also, specify which properties will be reported in the 
.INF file when creating a netlist using the VST tab in the 
Create Netlist dialog box.

Miscellaneous Specify if you want to display the power pins in the 
design. This tab also displays the following information:

■ Design name

■ Root schematic name

■ Unique ID for design

■ Creation time

■ Modification time

■ Date format

The Date Format field shows the format of the 
modification date and/or time of each schematic page in 
its title block. This drop-down list also provides a list of 
date formatting options to select from. To change the 
format in which the date and time is displayed:

a. Click the down arrow to expand the list.

b. Select a format.

c. Click OK.
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Design Template / Design Properties 
dialog box

To open the Design Template dialog box

Select Design Template (see Design Template command) from the 
Options menu.

To open the Design Properties dialog box

Select a design (.DSN) in the project manager then choose Design 
Properties (see Design Properties command) from the Options 
menu.

Use this tab... To do this...

Fonts

(available in both Design 
Template and Design Properties 
dialog box)

Change the fonts for objects with text. A standard 
Windows Font dialog box appears when you click on the 
font display of an object.

These options are set once per design. Once a design is 
created, use the Design Properties command to change 
these options for a particular design.

Title Block

(available only in Design 
Template dialog box)

Enter the title, organization name and address, 
document number, revision, and CAGE code into the title 
block.

Also enter the path and filename of the library containing 
the title block, and the title block name.

These options affect each new page. The 
OrCAD-supplied title block resides in the CAPSYM.OLB 
library. For more information about title blocks, see .

Page Size

(available only in Design 
Template dialog box)

Specify the units of measure used in the schematic page 
editor. Also, change the width and height of a schematic 
page, as well as spacing between pins in a design. For 
more information, see Page Size tab.
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Grid Reference

(available only in Design 
Template dialog box)

Choose between alphabetic and numeric, and between 
ascending and descending for both horizontal and 
vertical grid references.

Also set the grid count for both horizontal and vertical 
grid references, set the width of the grid references, and 
set title block visibility. For more information, see Grid 
Reference tab.

Hierarchy

(available in both Design 
Template and Design Properties 
dialog box)

Specify default settings of primitive or nonprimitive for 
hierarchical blocks and parts for future designs. These 
options are set once per design, and affect parts and 
hierarchical blocks that have the Primitive property set to 
Default. When parts are marked as primitive, you cannot 
descend into them, even if they have attached schematic 
folders.

Miscellaneous

(available only in Design 
Properties dialog box)

Specify if you want to display the power pins in the 
design. This tab also displays the following information:

■ Design name

■ Root schematic name

■ Unique ID for design

■ Creation time

■ Modification time

■ Date format

The Date Format field shows the format of the 
modification date and/or time of each schematic page in 
its title block. This drop-down list also provides a list of 
date formatting options to select from. To change the 
format in which the date and time is displayed:

a. Click the down arrow to expand the list.

b. Select a format.

c. Click OK.
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Fonts tab

Change the fonts for objects with text. A standard Windows Font 
dialog box appears when you click on the font display of an object.

These options are set once per design. Once a design is created, 
use the Design Properties command to change these options for a 
particular design.

Title Block tab

Enter the title, organization name and address, document number, 
revision, and CAGE code into the title block.

Also enter the path and filename of the library containing the title 
block, and the title block name.

These options affect each new page. The OrCAD-supplied title block 
resides in the CAPSYM.OLB library. For more information about title 
blocks, see Setting up the default title block.

Grid Reference tab

To open this dialog

Select Design Template (see Design Template command) from the 
Options menu.

Set these options for future schematic pages. Changing these 
options won't affect schematic pages you've already created.

SDT Compatibility

(available in both Design 
Template and Design Properties 
dialog box)

Define the mapping to use when saving designs in SDT 
format. It can be changed for individual designs in the 
SDT Compatibility tab of the Design Properties dialog 
box. The Part Field to Property mapping fields are used 
only when you save a Capture design in an SDT format. 
To make SDT part fields carry over into Capture 
properties, you need to specify them in the SDT.CFG file. 

Use this control... To do this...
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Page Size tab

To open this dialog

Select Design Template (see Design Template command) from the 
Options menu.

Set these options for future schematic pages. Changing these 
options won't affect schematic pages you've already created.

Horizontal and Vertical

Count Specify the number of divisions in the horizontal or 
vertical grid references.

Alphabetic and Numeric Specify whether the grid references are alphabetic or 
numeric.

Ascending and Descending Specify whether the grid references ascend or descend.

Width Specify the width of the grid reference division. The width 
here is not the distance between grid reference division, 
but the amount of space taken up in the schematic page 
editor.

Border Visible

Displayed Specify whether the border is visible on the screen.

Printed Specify whether the border is visible on paper.

Grid Reference Visible

Displayed Specify whether the grid references are visible on the 
screen.

Printed Specify whether the grid references are visible on paper.

Title Block Visible

Displayed Specify whether the title block is visible on the screen.

Printed Specify whether the title block is visible on paper.

ANSI grid references Specify if schematic pages use the ANSI Standard grid 
references.

Use this control... To do this...
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Hierarchy tab

Specify default settings of primitive or non-primitive for hierarchical 
blocks and parts for future designs. These options are set once per 
design, and affect parts and hierarchical blocks that have the 
Primitive property set to Default. When parts are marked as primitive, 
you cannot descend into them, even if they have attached schematic 
folders.

SDT Compatibility tab

Define the mapping to use when saving designs in SDT format. It can 
be changed for individual designs in the SDT Compatibility tab of the 
Design Properties dialog box. The Part Field to Property mapping 
fields are used only when you save a Capture design in an SDT 

Units Specify the unit of measurement for future designs. 
Select either inches or millimeters.

This only affects the schematic page editor. It doesn't 
affect the part editor, which is always measured in grid 
units.

New Page Size Specify the size of schematic pages for future designs. 
The first five choices are A to E if the unit measurement 
is inches, or A4 to A0 if the unit measurement is 
millimeters.

Width Specify the width of future schematic pages in the 
indicated unit measurement. The values specified here 
for page sizes A to E and A4 to A0 are set values in the 
Schematic Page Properties dialog box.

Height Specify the height of future schematic pages in the 
indicated unit measurement. The values specified here 
for page sizes A to E and A4 to A0 are set values in the 
Schematic Page Properties dialog box.

Pin-to-Pin Spacing Specify the spacing between pins in the indicated unit 
measurement. Also specify grid spacing. For example, a 
pin-to-pin spacing of 0.1 inches means that the dots or 
lines on your grid will be 0.1 inches apart.
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format. To make SDT part fields carry over into Capture properties, 
you need to specify them in the SDT.CFG file. 

Display Properties dialog box

To open this dialog

In the schematic page editor:

■ Click the Display button in the User Properties dialog box.

OR

■ Select a part on a schematic page and choose Properties (see 
Properties command) from the Edit menu. In the Property Editor 
window, click the Display button.

Use this control... To do this...

Name Specifies the property's name.

Value Specify the property's value.

Display Format Specify the visibility for the property name and value.

Font Displays the font name and point size.

Change Display a standard Windows Font dialog box so you can 
change the font, font style, and font size of the property.

Use Default Use the default value for the property. The default value 
is set in the Design Template / Design Properties dialog 
box (see Design Template command).

Color Specify the property's color.

Rotation Specify the rotation of the property.
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Note: You can use the Display Properties dialog box to set the 
display option of an instance property and its value, but you cannot 
use it to display properties of an occurrence property.

Note: If you have justified a text on a library symbol using the 
pre-SPB 17.2 release (HotFix 009), you need to reopen the text 
properties dialog for the particular text and click OK using HotFix 009 
or later. Once done, new justification settings will replace the old 
settings.

 Table 8-1: Text Justification

Text Justification Specify the text justification for displayed property text as 
Default, Left, Center, and Right at library level and 
schematic level. The default text justification is the legacy 
Capture behavior as performed in Capture 16.5. For 
more information on Text Justification, see Table 8-1: Text 
Justification table on page 235.

Note: You can override the text justification set at the 
library level from schematic level. Once overridden, 
update cache will not update the text justification set at 
schematic level.

Note: Text justification in a design saved using 16.6 
HotFix of Capture will not be preserved if the design is 
opened and saved using Capture 16.6 and earlier 
releases.

Text
Justification

Text after 0 
degree  
rotation is

Text after 90 
degree 
rotation is

Text after 180 
degree  
rotation is

Text after 270 
degree  
rotation is

Default Left Justified Right Justified Left Justified Right Justified 

Left Always Left Justified

Center Always Center Justified

Right Always Right Justified
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Distributions dialog box

To open this dialog

Select the Monte Carlo/Worst Case option, from the Analysis tab of 
the Simulate Settings dialog box, and click the Distributions button.

Design XML dialog box

To open this dialog

Select File – Export – Design XML.

Use this control... To do this...

Existing distributions Display a list of existing distributions for tolerances, 
defined by you. These are only used with Monte Carlo 
and sensitivity/worst-case analyses.

Distribution name Specify the name of a new distribution.

Distribution curve values Specify up to 100 curve values for the distribution. Each 
curve value is defined by two values in the form (x,y), 
where x is the deviation and y is the probability. The 
deviation must be between -1 and 1. The probability must 
be zero, or positive.

Delete Delete the selected distribution from the existing 
distributions list.

Save Save the distribution defined by the distribution name 
and curve values options.

Use this control... To do this...

DSN File Specify the Capture design file path.

XML File Specify the XML file name path. The default XML file 
name is design file name with .xml file extension.

Log file Select to specify the log file name path. The default log 
file name is design file name with .log file extension.
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Design Difference dialog box

To open this dialog

Select Tools – Compare Designs.

View Output Select to view the output in Capture after XML 
generation.

XML Schema Displays non-editable XML schema file path. Click View 
to view the XML schema file.

Use this control... To do this...

Design 1

Design Specify the Capture design file path

Schematic Specify the Schematic name from the selected Capture 
design file

Page Specify the Schematic page name from the selected 
Capture Schematic

Design 2

Design Specify the Capture design file path

Schematic Specify the Schematic name from the selected Capture 
design file

Page Specify the Schematic page name from the selected 
Capture Schematic

HTML Creation
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HTML Type Select one of the following options:

■ Portable(Standalone) - The portable html file has all 
the JavaScript files included in the HTML itself. The 
portable html file can be opened in any other 
machine, but is big in size compared to the 
lightweight html.

■ Lightweight (Cadence hierarchy dependent) - The 
lightweight html file do not contain all the JavaScript 
files but has links pointing to the installed Cadence 
hierarchy. The html file is small in size compared to 
the portable one, but cannot be opened in other 
machine.

HTML Path Specify the output HTML file path. The default path for 
the HTML file is the temp folder.

HTML Base File Name Specify the name of the output HTML file. The default 
name of the HTML is <First Design>_vs_<Second 
Design>.html.

Open With Select one of the following options to open the output 
html file:

■ Internet Explorer

■ Custom - Use other browsers, such as Google 
Chrome and Mozilla FireFox.

Note: It is strongly recommended to view the generated 
design difference HTML file in one of the flowing 
browsers, but Google Chrome is preferred:

❑ Internet Explorer (version 11 onwards)

❑ Google Chrome (version 45 onwards)

If browser except the recommended ones is selected 
in the Design Difference dialog box, ensure that it 
supports HTML5 Canvas. 
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Edit Bookmark dialog box

To open this dialog

Select a bookmark on a schematic page, then choose Properties 
(see Properties command) from the Edit menu.

Edit Filled Graphic dialog box

To open this dialog

On a schematic page

Double-click on a closed polyline, an ellipse, a rectangle.

OR

Select a closed object and choose Properties (see Properties 
command) from the Edit menu.

Edit Graphic dialog box

To open this dialog

In a schematic page editor,

Use this control... To do this...

Name Change the name of the bookmark.

Use this control... To do this...

Fill Style Choose the fill style.

Line Style & Width Choose the line style and width.

Color Choose the color of the line. This option is not available 
in the part editor.
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Double-click a line.

OR

Select a line and choose Properties (see Properties command) from 
the Edit menu.

Edit Hierarchical Port dialog box

To open this dialog

In the schematic page editor, select a hierarchical port and choose 
Properties (see Properties command) from the Edit menu.

Edit Net Alias dialog box

To open this dialog

Select a net alias in the schematic page editor and choose Properties 
(see Properties command) from the Edit menu.

Use this control... To do this...

Line Style & Width Choose the line style and width.

Color Choose the color of the line. This control is not available 
in the part editor.

Use this control... To do this...

Name Change the name of the hierarchical port.

Type Select the hierarchical port type from the list of pin types. 

Use this control... To do this...

Alias Change the net alias name.

Color Choose the color of the net alias.
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Edit Off-Page Connector dialog box

To open this dialog

In the schematic page editor, select an off-page connector, and 
choose Properties (see Properties command) from the Edit menu.

Edit Part Properties dialog box

To open this dialog
While placing a part on a schematic page editor, right-click and 
choose Edit Properties from the pop-up menu.

Rotation Specify the rotation of the net alias or text.

Font

Change Display a Font dialog box so you can select a font.

Use Default Change the font to the default font specified in the Design 
Template / Design Properties dialog box.

Use this control... To do this...

Name Change the name of the off-page connector.

Use this control... To do this...

Part Value Change the part value name.

Part Reference Specify the part reference.

Primitive

Default Use the default primitive setting. The default setting is set 
in the Hierarchy tab of the Design Template dialog box 
(see Design Template command).

Yes Indicate the part is a primitive.
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Note: Be careful not to create recursion in your design. Capture 
cannot prevent recursion, and the Design Rules Check command 
does not report it.

Recursion causes Capture to process infinitely as it tries to expand 
the design, resulting in the loss of any changes you've made to your 
design since it was last saved.

Note: Except for occurrence properties, the schematics of 
externally-referenced libraries and designs should not be edited. You 
should view them as read-only designs. Trying to edit, then save, 
these designs from within your schematic can introduce errors such 
as duplicate reference designators and other problems.

When saving schematics with externally-referenced libraries or 
designs, occurrence properties are saved but altered instance values 
are not. If you want to change externally-referenced libraries or 
designs you should first close the referencing design. Then, open the 
referenced library or design, make the necessary changes, and save 
and close the referenced library or design. At this point, you can 
reopen the original design and reference the modified design.

No Indicate the part is nonprimitive and descends in 
hierarchy.

Graphic Specify whether Capture displays the normal view or the 
convert view of the part. The convert view option is only 
available for parts with convert views.

Packaging

Parts per Pkg Indicates the number of parts in the package.

Part Select a part from the package list.

PCB Footprint Specify the PCB footprint name, if assigned.

Power Pins Visible Specify the visibility of the part's power pins.

User Properties Display the User Properties dialog box so you can modify 
the part's properties.

Attach Implementation Display the Attach Implementation dialog box so you can 
attach a schematic folder to create hierarchy. You must 
specify the schematic folder's name, but you only need to 
specify the schematic folder's library or path name if the 
schematic folder is not in the current project.
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Note: When you attach a schematic folder to a part or hierarchical 
block, you can specify a full path and filename in the Library text box. 
So, although you can specify a library that hasn't been saved, you 
should not try to descend into the attached schematic folder until the 
library that contains the schematic folder has been saved.

If you don't specify a full path and filename in the Library text box, 
Capture expects to find the attached schematic folder in the same 
design as the part of hierarchical block to which it is attached. If the 
specified schematic folder doesn't exist in either the design or library, 
Capture creates the schematic folder when you descend hierarchy 
on the part or the hierarchical block.

For compatibility with future versions of Windows, Capture preserves 
the case of the path and filename as you specify them in the Library 
text box.

Edit Text dialog box

To open this dialog

Select a text object and choose Properties from the Edit menu.

Use this control... To do this...

Text Change the text to display.

Color Choose the color of the text. Text that is placed in the 
part editor uses the part body color.

Rotation Specify the rotation of the text.

Font

Change Display a Font dialog box so you can select a font.

Use Default Change the font to the default font specified in the Design 
Template / Design Properties dialog box.
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Edit Wire(s) dialog box

To open this dialog

In a schematic page editor,

Select a wire and choose Edit Wire Properties from the pop-up menu

Export Properties dialog box

To open this dialog

In the Project manager, choose Export Properties from the Tools 
menu.

Use this control... To do this...

Line Style & Width Choose the line style and width.

Color Choose the color of the line. This control is not available 
in the part editor.

Use this control... To do this...

Scope Process the entire design or just the selected 
documents.

Contents Export part properties or part and pin properties, or flat 
net properties.

Mode Export either instance properties or occurrence 
properties.

Specifies to export either instance properties or 
occurrence properties. Capture recommends a preferred 
mode, which you can override.

Export File Specifies the name of the export output file. For more 
information about property files, see .

Browse Displays a standard Windows dialog box for selecting 
files.
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Export Selection dialog box

To open this dialog

In the schematic page editor, choose one or more objects, then 
choose Export Selection (see Export Selection command) from the 
File menu.

Extended Preferences Setup

To open this dialog

Select Options – Extended Preferences.

Or 

Select Options – Preferences. In the Preferences dialog box, click 
the More Preferences button.

Use this control... To do this...

Export Selection Name Specify the export name of the selected object or 
objects.

Library Specify a path, and a design or library name for the 
export selection.

Browse Display a standard Windows dialog box for selecting files.

Use this control... To do this...

Command Shell These commands are related to the TCL command win-
dow in Capture.
June 2020 245 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Journaling Select the option to enable journaling of the various 
Capture commands, including TCL commands.

Use the following TCL command to enable or disable 
journaling:

SetOptionBool Journaling TRUE/FALSE

Flush Commands Select the option to print the journaling commands in a 
text file. By default, the text file is saved in the TEMP 
folder (<%TEMP%>\CAPTURELOG\<%DATE%>\ 
OrCaptureLogFile.captcl)

Use the following TCL command to flush the output of 
the journaling commands:

SetOptionBool FlushImmediate TRUE/FALSE

Display Commands Select the option to enable display of Capture commands 
in Command Window.

Use the following TCL command to enable or disable the 
display of capture commands in Command Window:

SetOptionBool DisplayCommands TRUE/FALSE

Enable Customer Experience 
Improvement Program (CEIP)

Select this option to take part in the Customer 
Experience Improvement Program (CEIP) in Capture. 
When you participate in this program, your system will 
automatically send basic, anonymous information to 
Cadence Design Systems about how you use various 
Capture features. This information is combined with other 
CEIP data to help Cadence solve problems and improve 
the products and features that customers use most often. 
Cadence does not collect your design data or personal 
information.

Design and Libraries These commands are related to Capture’s designs and 
libraries.

Content text instance properties Select the option to rotate the instance part properties 
along with the instance part on the same axis.

TCL Command: SetOptionBool 
RotateInstPropInContext TRUE/FALSE
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Draw arrow on part input pins Select the option to draw arrow on part’s input pins.

TCL Command: SetOptionBool DrawPinsArrows 
TRUE/FALSE

Enable communication with 
legacy tools

Select the option to enable message-based 
communication with the legacy tools, such as OrCAD 
Layout. 

TCL Command: SetOptionBool EnableLegacyITC 
TRUE/FALSE

Note: By default, message-based communication is not 
enabled in OrCAD Capture. Enable this option if you want 
OrCAD Capture to communicate with the legacy tool as it 
impacts OrCAD Capture’s performance.

Perform read only check on tab 
switch 

Select the option to enable Capture to check the library 
and design files’ permissions on every switch of tab.

TCL Command: SetOptionBool 
CheckReadOnlyOnViewActivate TRUE/FALSE

Note: Unselecting the option improves user experience 
as Capture ignores the permissions check on the design 
and library files.

Save design name as 
UPPERCASE

Select the option to save the design file name (.dsn) in 
uppercase letters.

TCL Command: SetOptionBool 
SaveAsUpperCaseDsnName TRUE/FALSE

Enable global net ITC Select the option to start cross probing of global nets.

TCL Command: SetOptionBool 
EnableGlobalNetITC 1/0

Convert images to BMP format Select the option to convert all format images to .bmp 
internally.

TCL Command: SetOptionBool 
SaveImageAsBitmap TRUE/FALSE

Path lookup timeout (in 
seconds)

Specify the time out time in seconds if the design or 
library files are found at the configured locations.

TCL Command: SetOptionUInt 
PathLookupTimeout <valuse in seconds>
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Net Naming Options (requires 
application restart) 

The drop down menu options provides different options 
to select how Capture generates flat-net names for 
complex hierarchy designs. By default, flatname has a 
hierarchy block path. 

TCL Command: SetOptionUInt NetNameMode 
<1,2,3,4>

where 

1: Always append hierarchy

2: Append hierarchy on collision

3: Always append ID

4: Append ID on collision

Following are the drop down options:

■ Never

■ Always

■ Only when mismatch

Append hierarchy on collision Appends hierarchical path to the conflicting flat nets only 
(for global nets, numeric ID is used). The flat net that is 
closest to the root design and is the only flat net at that 
level is not renamed.

Always append hierarchy Appends hierarchical path to all the flat nets except those 
in root schematic. For global nets, numeric ID is used as 
they do not have any hierarchical path.

Append ID on collision Appends numeric IDs to all the conflicting flat nets only. 
The flat net that is closest to the root schematic and is 
the only flat net at that level, is not renamed.

Always append ID Appends numeric IDs to all the flat nets except those in 
the root schematic.

Design Cache
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Update Cache Select the Default or Forced option to update cache in 
Capture. Selecting Forced will update the selected 
library even if it is older than the original library file in the 
Design Cache.

TCL Command: SetOptionString 
ForceUpdateCache NONE/TRUE

DRC

Display Waived DRC Select the Display Waived DRC check box to display all 
the waived DRCs on a schematic page.

TCL Command: SetOptionBool 
DisplayWaivedDRC 1/0

Use Global DRC Settings Select the Use Global DRC Settings check box to use the 
same DRC settings for all different designs.

NetGroup The following options, which are related to NetGroups, 
will be set only for the current active design:

■ Never

■ Always

■ Only when mismatch (definition name mismatched 
instance name)

Netlist These command are related to Netlisting in Capture.

Apply Allegro Character Limits 
on All Projects

Select this option to set the character limit globally for all 
the projects.

TCL Command: SetOptionString 
AllegroCharLimitInINI TRUE/FALSE

Schematic These commands are related to Schematic page in 
Capture.
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Schematic Descend The following three modes are used for schematic 
descend:

■ Default: Opens the default page of child schematic

■ First: Opens the first page of child schematic 
(alphabetical-wise)

■ Ask: Asks user to select one of the schematic page 
from the list of schematic pages.

TCL Command: SetOptionString 
DescendSchPage ASK/FIRST_PAGE/DEFAULT

Junction Mode The following two modes are used for junctioning in 
Capture:

■ Default: Select this option to place a junction at a 
straight wire break point

■ Junction on multiple connections on wire end : Select 
this option to place a junction at 3 point connections.

Display underscore (_) on User 
Assigned Part References on 
Schematic Page

Select this option to display underscore (_) symbol on 
user-assigned part references on a schematic page.

TCL Command: SetOptionString 
HIGHLIGHT_USER_EDIT_REFERENCES_ON_PAGE 
TRUE/FALSE

Display underscore (_) on User 
Assigned Part References in 
Page Print

Select this option to display underscore (_) symbol on 
user-assigned part references in page or design print.

TCL Command: SetOptionString 
HIGHLIGHT_USER_EDIT_REFERENCES_ON_PRINT 
TRUE/FALSE

Distribute in a fixed area (may 
cause uneven distribution)

Select this option to distribute the selected objects in a 
fixed area.

TCL Command: SetOptionString 
ObjectGridDistribution 
UnevenDistributionWithSameExtents/Distrib
utionWithAutomaticExtent
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Configured Files These commands are related to customization of design 
configuration files.

By default, the read-only path is displayed in the 
Configuration Files tab. When you click edit, the files get 
stored at your system’s home directory and are opened 
in a text editor for any modification. 

Once the changes are made, the saved files are stored at 
system’s home directory(%HOME%).

allegro.cfg The allegro.cfg file’s path

PrefProp.txt The PrefProp.txt file’s path

edif2cap.cfg The edif2cap.cfg file’s path

cap2edif.cfg The cap2edif.cfg file’s path

Part and Symbol Editor

Snap to grid - Graphical objects Select if graphical objects such as Line, Polyline, 
Rectangle, Ellipse, Arc, and Picture, which can be placed 
and moved on the selected grid type, Fine or Master.

This setting is saved in CAPTURE.INI and it is used 
whenever you start the next Capture session.

If you have selected Master:

■ The snap-to-grid setting (on or off) in the toolbar is 
applied. 

■ Pressing the SHIFT key while dragging the objects 
toggles the grid type.

If you have selected Fine:

■ The snap-to-grid setting in the toolbar is set to off, 
that is, the object will move on Fine grid.

■ Pressing SHIFT key while dragging the objects will 
not change the grid type. 
June 2020 251 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Edit Comment Text dialog box

In the part editor, use this dialog box to add comment text on the part. 

To modify the text, double-click the text. The Edit Comment Text 
dialog box opens. Change the text and click OK.

To modify the text properties:

1. Select the text.

The Text Properties section appears in the Property Sheet 
pane. 

2. Modify the font, font size, font style, or the justification of the 
selected text.

Snap to grid - Text objects Specify if text objects and display property object can be 
placed and moved on the selected grid type, Fine or 
Master.

This setting is saved in CAPTURE.INI and it is used 
whenever you start the next Capture session.

If you have selected Master:

■ Snap-to-grid setting (on or off) in the toolbar is 
applied. 

■ Pressing the SHIFT key while dragging the object 
toggles the grid type.

If you have selected Fine:

■ The snap-to-grid setting in the toolbar is set to off, 
that is object will move on Fine grid.

■ Pressing SHIFT key while dragging the objects will 
not change the grid type. 

Enable the Paste Options mode Select this option if you want the open the Paste Options 
dialog box before pasting copied pins. This allows you to 
edit the pin information before pasting the pin.

For information on how to use this dialog box, see Paste 
Options dialog box.
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Font dialog box

To open this dialog

Click the Change button in the Edit Net Alias dialog box, the Place 
Net Alias dialog box, the Edit Text dialog box, the Place Text dialog 
box, or the Display Properties dialog box.

OR

Click in a font box on the Fonts tab of the Design Properties dialog 
box, the Fonts tab of the Design Template / Design Properties dialog 
box, or the Miscellaneous tab of the Preferences dialog box.

Find dialog box

To open this dialog

Select Edit – Find, or see Find command.

Note: The Find dialog box options depend on the active window.

Use this control... To do this...

Font Specifies the font for the text.

Note: Be sure to use a monospaced font (for example, 
Courier) as the default font for the text editor or the source 
editor. If you use a true-type font, the editor may distort the 
appearance of the text, making it difficult to read.

Font Style Specifies the font style for the text.

Size Specifies the text size.

Sample Shows a sample of how the text will appear, based upon 
the font, style and size.

Script Specifies the script used for the font.

Use this control... To do this...
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Find What Specify the search string.

Use an asterisk (*) to match any string of characters, and a question 
mark (?) to match any single character.

Match Case Specify if the search must match the case of the string.

If this option is not selected, lowercase and uppercase letters will be 
treated the same in the search.

Scope Specify the properties to search for.

Important

In the part editor, only Pins and Text is available as the 
options for scope.

However in project manager or schematic page editor, you can 
specify any of the following scopes:

■ Parts

■ Nets

■ Title Blocks

■ Off-page Connectors

■ Flat Nets

■ Power/GND

■ Bookmarks

■ Hierarchical Ports

■ Text

■ DRC Markers

■ Parts Pin
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Generate Part dialog box

To open this dialog

In the Project manager, choose Generate Part (see Generate Part 
command) from the Tools menu.

Note: To create a pin on a symbol using the Generate Part utility, the 
pin must have a pin to port mapping in the pin file.

Use this control... To do this...

Netlist/Source file Specifies the netlist or schematic file that Capture uses to 
generate the new symbol. Typically, this is the netlist that is 
associated with the timing information derived from the vendor 
fitter tool. You can enter the path and name of the file directly, or 
use the Browse button to select it.
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Netlist/source file type Specifies the format of the netlist or other source file that 
Capture uses to generate the symbol. If you select a netlist file 
name using the Browse button, Capture assigns a default 
vendor file type based on the netlist file extension. Otherwise, 
you must select a file type from the drop-down list. You can 
choose from the following netlist or file types:

■ Actel Pin File. This file is typically created by the Actel 
Designer tool.

■ Altera Pin File. This file is created by the Altera MAX+PLUS 
II.

■ APD BGA/Die-Text File. This file is created by the 
Advanced Package Design tool.

■ Capture Schematic/Design. A source design or library file 
from an external file or from the current design. This is 
automatically set when a schematic folder, which is in a 
design (.DSN) file or library (.OLB) file, is selected in the 
project manager at the time the Generate Part dialog box is 
opened.

■ EDIF Netlist. Altera's MAX+PLUS II tool generates an EDIF 
netlist. You can also use EDIF files from any other source to 
generate a symbol.

■ Lattice JEDEC File. This file is created by Lattice ISP 
products

■ Lattice Pin File. This file is created by the Lattice ispExpert 
tool.

■ Lucent ORCA Pad File. This file is created by the Lucent 
ORCA tool.

■ PSpice Model Library. Used by the PSpice simulator. You 
can create your own PSpice model libraries using the 
PSpice Model Editor or use the model libraries that ship with 
PSpice and install in the Library directory.

■ Verilog Netlist. Used for board simulation and for FPGA 
projects. You can use these netlists to generate a symbol.

■ VHDL Netlist. Some vendor tools generate VHDL netlists 
(with embedded timing information) during place and route. 
You can use these netlists to generate a symbol.
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Netlist/source file type 
(contd.)

■ Xilinx M1 Pad File. This file is created by the Xilinx M1 tool.

■ Xilinx Pin File. This file is created by Xilinx place and route 
tool set.

■ XNF Netlist. XNF netlists are the results of the XACTstep 
place and route tool.

Primitive Assigns No, Yes, or Default value to the Primitive property. This 
option is only available for the Capture Schematic/Design source 
file type. If the value is set to No, you can descend the hierarchy 
of the placed part instance to see the source schematic.

Copy schematic to 
library

When this check box is selected, Capture places a copy of the 
source schematic in the new library created in the Outputs 
directory of the project manager when a part symbol is 
generated using a schematic source file. This option is only 
available for the Capture Schematic/Design source file type. If 
the part name does not match the source schematic name, the 
resulting part and schematic will have the same name.

Part name Specify the name that Capture assigns to the newly generated 
symbol. If you selected a netlist file name using the Browse 
button, Capture assigns a default symbol name to this text box 
that corresponds to the netlist name. Otherwise, you must enter 
the symbol name directly.

Destination part library Specifies the name that Capture assigns to the symbol library 
that will contain the new symbol. If you selected a netlist file 
name using the Browse button or a schematic file in the project 
manager, Capture assigns a default symbol library name to this 
text box that corresponds to the netlist or schematic name and 
adds a .OLB extension. You can accept the default entry, enter 
the path and name of the file directly, or use the Browse button 
to select it.

Create new part Specifies to create a new part using the specified netlist.
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Pick symbols manually

(This check box is 
available only when you 
have a PSpice project 
open)

(This check box is 
disabled if the PSpice 
Model Library item is not 
selected from the 
Netlist/source file type 
drop-down list)

Associate a PSpice model to a Capture symbol. When you click 
the OK button in the Generate Part dialog box, the Model Import 
Wizard appears allowing you to associate a PSpice model to an 
existing symbol.

Update pins on existing 
part in library

Specifies to update the pins on an existing part using the 
specified netlist, rather than create a new part.

Sort pins

Ascending order Specify that the pins are sorted in ascending order.

Descending order Specify that the pins are sorted in descending order.

Additional pins

Specify the number of 
additional pins on part

Check to specify the number of pins Capture creates for the 
part. By default, Capture creates only the number of pins 
required such that each input and output specification in the 
netlist has a unique pin. However, if you are using a particular 
device, you may want to specify a number of pins that differs 
from the number of input and output specifications in the netlist.

Number of pins Specify the number of pins that Capture generates for the part. 
This option is only available if you have activated the Specify the 
number of pins on part check box. Any unused pins on the 
symbol (pins for which there is no input or output specification in 
the netlist) are considered I/O pins.

Retain alpha-numeric 
pin-numbers. Device is 
pin grid array type 
package.

Check to retain the alphanumeric pin names for the part (for 
example, "P20"). This is useful for parts that model Xilinx pin 
grid array type packages. If the Vendor file type in this dialog box 
is anything other than Xilinx Pin File or Xilinx Pad File, this 
option is ignored.

Implementation
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Go To dialog box

To open this dialog

Select View – Go To, or see Go To command.

Note: The grid reference and bookmark options are not available in 
the part editor.

Implementation type Specify the type of implementation. The implementation types 
available to choose from are the same as those available in the 
Attach Implementation dialog box.

The most common Implementation type used with the parts 
created from PLD vendor pin reports is either <none> or Project 
(which creates a hierarchy of projects for system simulation). 
Implementation types signify the following:

■ <none> Primitive library part.

■ EDIF Non-primitive library part. Contents defined by an 
EDIF netlist generated by a third party EDA tool.

■ Project Primitive library part. Associated with the Simulation 
Resources of an OrCAD Express project for system-level 
simulation.

■ Schematic View Non-primitive library part. Contents 
defined by a schematic folder/page.

■ VHDL Non-primitive library part. Contents defined by a 
VHDL model.

Implementation name Specify the name of the attached object.

Implementation file Specify the path and name of the library or file of the attached 
object.

FPGA Setup Open the FPGA Options dialog box. Using this dialog box, you 
can specify settings for FPGA symbols, FPGA pins, FPGA pin 
swapping, and pin shape or pin direction.
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Location tab

Grid Reference tab

Bookmark tab

Goto Label State dialog box

To open this dialog

In the schematic page editor, choose Label State - Goto from the Edit 
menu.

Use this control... To do this...

X and Y Specify the X and Y coordinates for the jump.

Location Type: Absolute and 
Relative

Specify if the jump is absolute (to the indicated 
coordinates), or relative (using the coordinates as an 
offset to the pointer's current position).

Use this control... To do this...

Horizontal Specify a horizontal grid reference.

Vertical Specify a vertical grid reference.

Use this control... To do this...

Name Specify a jump to a bookmark. Bookmarks are made 
using the Bookmark command on the Place menu.

Note: The Go To command is used to go to bookmarks 
on the currently active schematic page.

Use this control... To do this...

Enter Label Specifies the label of the state to which you want to 
return the schematic.
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Go To Line dialog box

To open this dialog

In the text editor, choose Go To from the Edit menu.

Use this control... To do this...

Line Number Specifies the line number to view in the text editor 
window.
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Markers dialog box

To open this dialog

In the Project manager, choose Marker List from the PSpice menu.

OR

In a PSpice schematic page, point to Markers on the PSpice menu 
and choose List.

Use this control... To do this...

Markers List Display or hide markers on your design. Select the check 
box next to the listed marker to display markers on the 
schematic.

If the check box next to a marker is not selected, it is 
hidden and will not display in Capture. However, the 
marker still exists in the profile. This feature is useful for 
printing a design for documentation.

Go To If only one marker is selected, click this button to open 
the schematic page that contains the marker.

Note: Removing any or all markers from the list removes 
them from the schematic. You cannot undo the Remove or 
Remove All operation.

Remove All Remove all markers from the list and from the design.

Remove Remove the selected markers from the list and from the 
design.
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Monte Carlo Worst-Case Output File 
Options dialog box

To open this dialog

Select the Monte Carlo/Worst Case option, from the Analysis tab of 
the Simulation Settings dialog box, and click the More Settings 
button.

Use this control... To do this...

Find Find the indicated function on the values of the output 
variable and reduce these to a single value. The value is 
the basis for the comparisons between the nominal and 
subsequent runs. The following functions are available:

■ YMAX. Find the absolute value of the greatest 
difference in each waveform from the nominal run.

■ MAX. Find the maximum value of each waveform.

■ MIN. Find the minimum value of each waveform.

■ RISE_EDGE. Find the first occurrence of the 
waveform crossing above the threshold value. The 
waveform must have one or more points at or below 
the threshold value, followed by one above. The 
output value listed is the first point that the waveform 
increases above the threshold value.

■ FALL_EDGE. Find the first occurrence of the 
waveform crossing below the threshold value. The 
waveform must have one or more points above the 
threshold value, followed by one below. The output 
value listed is the first point that the waveform 
decreases below the threshold value.

Threshold value Specify the value used in the RISE_EDGE and 
FALL_EDGE functions.

Evaluate only when the sweep 
variable is in the range

Specify a beginning and ending range to evaluate the 
sweep variable in.

List model parameter values in 
the output file for each turn

List the model parameter values in the output file for each 
run of the Monte Carlo/Worst Case analysis.
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Multi-level Backup Settings dialog box

To back up your design, enter the values to determine the duration, 
number of backups and storage location.

To open this dialog

Choose Autobackup option from the Options menu.

Use this control... To do this...

Backup time (in minutes) Enables you to determine the time after which Capture 
will perform automatic backup.

No of backups to keep Enables you to determine the total number of backups 
that will be stored.

Directory for backup Enables you to determine the storage location for the 
backup.
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New Alias dialog box

To open this dialog

Click the New button in the Part Aliases dialog box.

New Page in Schematic dialog box

To open this dialog

Select a schematic folder in the Project manager and choose New 
Schematic Page from the Design menu.

New Part Properties dialog box

To open this dialog

Select a library in the project manager and choose New Part (see 
New Part command) from the Design menu.

Use this control... To do this...

Name Specify the name of the new alias.

Use this control... To do this...

Name Specify the schematic folder or schematic page name.

Use this control... To do this...

Name Specify the name of the part. This is used as the default 
part value when the part is placed on a schematic page. 
Part names can be up to 31 characters long.

Note that the “!” character cannot be used in the part 
name.
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Part Reference Prefix Specify the part reference prefix, such as "C" for 
capacitor or "R" for resistor. For example:

C?1(capacitor)

R?1 (resistor)

PCB Footprint Specify the PCB footprint name to be included for this 
part in the netlist. Contains a value for a device 
consisting of zero or more pads, other objects, and a 
name.

Create Convert View Specify whether the part has a convert. You might use 
the convert to define a DeMorgan equivalent. A part with 
this option specified will have two views (a normal and a 
convert) you can switch between once the part is placed.

Multiple-Part Package

Parts per Pkg If there are multiple parts in the package, specify the 
number of parts in the package.

Package Type If the part is a package, specify whether all the parts in 
the package have the same graphical representation 
(homogeneous) or different graphical representations 
(heterogeneous).

Note: The package type can only be set at creation time. 
These options are not available when you edit the part 
later.

You should not cut and paste parts between 
homogeneous and heterogeneous packages.

Part Numbering If the part is a multiple-part package, specify whether 
parts in the package are identified by letter or number. 
For example:

■ U?A (alphabetic)

■ U?1 (numeric)

Part Aliases Display the Part Aliases dialog box to add or remove 
aliases. Part aliases show up in a library represented by 
the part symbol with a horizontal line through the center.
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Note: Be careful not to create recursion in your design. Capture 
cannot prevent recursion, and the Design Rules Check command 
does not report it.

Recursion causes Capture to process infinitely as it tries to expand 
the design, resulting in the loss of any changes you've made to your 
design since it was last saved.

Note: If you attach external schematic folders or other files to 
hierarchical blocks in a design or parts in a library, be sure to include 
the attachments when you pass the design or library to a board 
fabrication house or to another engineer. Attached schematic folder 
and other files are not carried along automatically when you copy or 
move a part, schematic folder, or schematic page to another library, 
design, or schematic folder. Only the "pointers" to the attached 
schematic folder and files—that is, their names and the names of the 
designs or libraries that contain them—are carried along.

Attached files work much like their counterparts in email—they do not 
provide an alternative definition of the part (as do attached schematic 
folders).

Note: When you attach a schematic folder to a part or hierarchical 
block, you can specify a full path and filename in the Library text box. 
So, although you can specify a library that hasn't been saved, you 
should not try to descend into the attached schematic folder until the 
library that contains the schematic folder has been saved.

If you don't specify a full path and filename in the Library text box, 
Capture expects to find the attached schematic folder in the same 
design as the part of hierarchical block to which it is attached. If the 
specified schematic folder doesn't exist in either the design or library, 
Capture creates the schematic folder when you descend hierarchy 
on the part or the hierarchical block.

Attach Implementation Display the Attach Implementation dialog box so you can 
attach a schematic folder to create hierarchy. You must 
specify the schematic folder's name, but you only need to 
specify the schematic folder's library or path name if the 
schematic folder is not in the current project.

Pin Number Visible Specify whether the pin number (s) for the part should be 
displayed when you open the part in the Part editor 
window or view the part in the package view.
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For compatibility with future versions of Windows, Capture preserves 
the case of the path and filename as you specify them in the Library 
text box.

Note: You can access this dialog box after you place a new part. To 
change the part parameters, change to package view and choose the 
Package Properties command from the Options menu.

Note: Once you have attached a file and associated a text editor with 
it, you can use the Descend Hierarchy command to open that file. If 
you have an attached schematic folder as well as an attached file, 
Descend Hierarchy opens the schematic folder and not the file.

New Project dialog box

To open this dialog

Choose New – Project (see Project command) from the File menu.

New Property dialog box

To open this dialog

Click the New button on the User Properties dialog box.

OR

Click the New button on the Edit Part Properties dialog box.

Use this control... To do this...

Name Specify the name of the new project.

Location Specify the path where you want the new project files to 
be saved, or use the Browse button to locate the 
directory. 
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Note: Property names and values can have up to 256 characters 
each.

New Schematic dialog box

To open this dialog

Select a design (.DSN) in the Project manager and choose New 
Schematic command from the Design menu.

New Simulation dialog box

To open this dialog

For a PSpice project in the Project manager, choose New Simulation 
Profile (see New Simulation Profile command) from the PSpice 
menu.

Use this control... To do this...

Name Specify the new property's name.

Value Specify the new property's value.

Use this control... To do this...

Name Specify the schematic folder or schematic page name.

Use this control... To do this...

Name Specify the name for the new profile. This is not a file 
name.

Inherit From Specify a simulation model to inherit properties from. The 
list box displays all of the simulation models in designs 
open in Capture.

Root Schematic Shows selected schematic to act as the root for the 
simulation profile.
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New NetGroup / Modify NetGroup dialog 
box 

The New NetGroup or Modify NetGroup dialog boxes displays when 
you click the Add NetGroup or Modify NetGroup buttons on the 
NetGroup dialog box.

Rename NetGroup Member dialog box

The Rename NetGroup Member dialog displays when you click the 
Rename NetGroup button on the New NetGroup or Modify NetGroup 
dialog boxes.

Use this control... To do this...

NetGroup Name Enter the name of the NetGroup.

Note: This text box is disabled in the Modify NetGroup 
dialog.

Apply Use this button to save the name of the NetGroup.

Note: You cannot add members to a NetGroup, until you 
have applied the NetGroup name.

Add Add a member (NetGroup, bus, or scalar) to the 
NetGroup.

Delete Delete a NetGroup member.

Rename Rename a NetGroup member.

UP Move the NetGroup member position up.

Down Move the NetGroup member position down.

Use this control... To do this...

Name Enter the name of the NetGroup member to rename.

Note: When you rename a NetGroup member that is a 
NetGroup, you need to choose the name of a NetGroup 
that already exists in this design. Also, the NetGroup to 
which you rename this member to, must not already exist 
in the current NetGroup.
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Open dialog box

Use this command to open projects or files.

This is a standard Windows Open dialog box in which you can locate 
and select the project or file of your choice.

To open this dialog

Choose Open from the File menu.

Use this control... To do this...

Look in Browse the hierarchical drive and directory structure for 
your system.

File name Select or type the name of the project or file.

Files of type Filter files by extension.
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Property Sheet Pane

This pane contains the following sections related to part and pins:

■ Package Properties

■ Part Properties

■ Pin Properties

■ Text Properties

■ Basic Attributes

Note: In an existing part, depending upon the object selected, the 
required section in the property pane opens.

This pane has the following functions: 

■ Display Properties

■ Delete Current Section

■ Add Convert View

■ Delete Convert View

■ Edit Pins
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Package Properties

To open this section in the Property Sheet pane

When you select a part in the part editor, and related package 
properties appear in the Package Properties section of the 
Property Sheet pane.

Use this control... To do this...

Part Numbering Displays the numbering format (Alphabetic or 
Numeric) that is added as suffix to the current part 
reference for the new or selected part. 

If Alphabetic is selected, you can create a maximum 
of 26 sections.

If Numeric is selected, you can create a maximum of 
1024 sections.

This field has a drop-down list using which you can 
change the part numbering format after part creation or 
during part editing.

Package Type Displays whether all the parts in the package have the 
same graphical representation (homogeneous) or 
different graphical representations (heterogeneous).

The package type can only be set at creation time. This 
option is not available when you edit the part later.

You should not cut and paste parts between 
homogeneous and heterogeneous packages.

PCB Footprint Specify the PCB Footprint name to be included for this 
part in the netlist. Contains a value for a device 
consisting of zero or more pads, other objects, and a 
name.

PCB Footprint is a reserved property name. If you want 
to make its value visible on the schematic page, you must 
do so in the property editor.

Part Reference Prefix Specify the part reference prefix, such as C for capacitor 
or R for resistor.
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Part Properties

To open this section in the Property Sheet pane

Open or select a part in the part editor, and the related part properties 
appear in the Part Properties section of the Property Sheet pane.

Section Count Specify the number of parts in the package. The Section 
Count field shows the count specified in the Parts per 
Pkg or No. of Sections field during part creation. 

If Alphabetic is selected in Part Numbering (while 
part creation), section names will start with A.

Note: If you create a single-section part with 
Alphabetic numbering, section name is not 
displayed and it is automatically converted into a part 
with Numeric numbering. 

If Numeric is selected in Part Numbering (while part 
creation), section names will start with 1.

You can modify the number of sections after part 
creation.

Part Aliases Click the Update button to open the Update Alias dialog 
box, which is used to add and edit part aliases.

Use this control... To do this...

Name Displays both the name and normal or convert view of 
the part. The part name appears to the left of the period, 
and the view appears to the right. This property is 
read-only.

suffix Is used to indicate if the view is Normal or Convert for 
the current section of the part. This is a read-only 
property.

Implementation Path Specify the filename and directory to the child schematic.

Click  icon to browse the location of the child 
schematic.
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Pin Properties

To open this section in the Property Sheet pane

Select a pin in the part editor, and the properties related to the pin 
appear in the Pin Properties section of the Property Sheet pane. 

Implementation Specify the name of the child schematic for the part.

Implementation Type Specify the implementation type. For information about 
various implementation types, see Attach 
Implementation dialog box. 

Value Specify the part value. If this is not specified when you 
place the part in a schematic folder, Capture uses the 
part name.

Pin Name Visible Select this option to specify if the pin names are visible in 
the schematic page editor and part editor.

Pin Number Visible Select this option to specify if the pin numbers are visible 
in the schematic page editor and part editor.

Pin Name Rotate Select this option to specify if the pin names and pin 
numbers rotate with top and bottom pins.

Click this icon to add user-defined properties.

You can add any user-defined properties in this section. 
Some of the commonly used properties are available in 
the drop-down list.

You can also delete an existing user-defined property. 
Click the Delete icon ( ) next to any user-defined part 
property to delete it.

Any user property added to the current section of the 
part is applied to all sections.

Use this control... To do this...

Name Specify the pin name. You can create a pin name with an 
overbar by adding a backslash (\) after every letter in the 
pin name.
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Note: Bus pins cannot be used directly as netlisting pins. Their main 
purpose is to make it possible to use nonprimitive parts more easily 
by connecting large numbers of signals to a child schematic folder.

Note: You can place one pin on a part that represents all pins for a 
bus. Such a pin is called a bus pin. Bus pins use the same naming 
convention as buses.

■ You can use bus pins in most cases where you can use scalar 
pins. For example:

❑ Off-page connectors

❑ Hierarchical ports

❑ Hierarchical pins of nonprimitive parts and hierarchical 
blocks

Number Specify the pin number. The pin number does not need 
to be a number; it can be alphabetic. If it ends in a 
number, it is incremented by one after each pin is placed.

The pin number has a limit of 32 characters. Characters 
that exceeds this limit will be truncated.

Shape Select the pin shape from the list of pin shapes. 

Type Select the pin type from the list of pin types. 

Pin Visible Specify the pin visibility on the schematic page. Only 
power pins can be set to not visible.

Order Specify the order in which pin is placed in a part. This is a 
read-only property.

User Properties Click the add icon,  in this section to add a 
user-defined property. 

You can also delete an existing user-defined property. 
Click the Delete icon ( ) next to any user-defined pin 
property to delete it.

Any pin property added to the current section of a 
homogeneous part is applied to all sections in the same 
view (Normal or Convert).

For a heterogeneous part, pin properties are not copied 
to other sections.
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■ Do not use pins in the following situations:

❑ Hierarchical pins of primitive parts and hierarchical blocks

❑ Any design that you intend to use with your board layout tool

Text Properties

To open this section in the Property Sheet pane

Select a comment text in the part editor, and related text properties 
appear in the Text Properties section of the Property Sheet pane.

Basic Attributes

To open this section in the Property Sheet pane

Select any object in the part editor. All properties related to the object 
(text, graphical, or position-related) appear in this section. Some of 
the properties are listed in the following table:

Use this control... To do this...

Text Displays the text. 

Font Displays the current font style and also allows you to 
change it from the drop-down list.

Font Size Displays the current font size and also allows you to 
change it from the drop-down list.

Bold Select this check box to modify the text format.

Italic Select this check box to modify the text format.

Justification Specify the text justification for the comment text as 
Default, Left, Center, or Right.

Use this control... To do this...

<Object Name> Displays the value of the selected object.
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Display Properties

Click the Display Property icon ( ) next to any part property to 
specify the visibility for the property name and value. It allows you to 
set the display option of the selected property and its value, such as 
Do Not Display, Value Only, and Name Only.

Rotation Displays the rotation of the selected object.

Location Displays the X and Y coordinates of the selected object 
on the canvas.

Font Displays the current font style of the selected object. You 
can also change the font style from the drop down list. 

Color Displays the color of the selected object and also allows 
you to change it from the drop-down list.

Font Size Displays the current font size. You can also change the 
font size from the drop down list.

Bold Select this check box to make the object value bold.

Italic Select this check box to italicize the object value.

Justification Specify the justification for the object value as Default, 
Left, Center, or Right.
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Delete Current Section

Click the Delete Current Section button to delete the current 
section of the part.

Important

This button is disabled for a part with a single section and 
for a heterogeneous part with only two sections.

To select any specific section of a heterogeneous part, click the 
drop-down at the left bottom corner of the canvas.

Add Convert View

Click the Add Convert View button to specify the convert view for a 
part.

Delete Convert View

Click the Delete Convert View button to delete the convert view for 
a part.

Edit Pins

To open this dialog box, do any one of the following:

■ Click the Edit Pins button in the Property Sheet pane.

■ Select the desired pins, right-click and select Edit Pins from the 
pop-up menu.

■ Select the desired pins, and choose Edit – Edit Pins.

■ Press SHIFT+H.

This dialog box enables you to view pin information according to pin 
selection. You can view pin information for:

■ All the pins of all the sections

■ All the pins of the current section
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■ Selected pins only

Use this control... To do this...

Pin Number Select this check box to show the <Section Name>: 
Pin Number column.

Pin Group Select this check box to show the Pin Group column.

Pin Ignore Select this check box to show the <Section Name>: 
Pin Ignore column.

Order Select this check box to show the Order column.

Pin Type Select this check box to show the <View>: Pin Type 
column.

Pin Shape Select this check box to show the <View>: Pin Shape 
column.

<View>: Pin Name Displays the name of the pin.

<Section>: Pin Number Displays the pin number in this section.

<Section>: Pin Ignore Select to ignore the pin in this section.

Order Shows the order in which the pins are placed in 
a section.

Pin Group Specify a value for each swappable (input) pin of the 
part.
Valid input can be integers from 0 to 126.

<View>: Pin Shape Select the pin shape from a list of pin shapes.

<View>: Pin Type Select the pin type from a list of pin types.

<View>: Pin Visible Specify the pin visibility when the part is placed on the 
schematic page. 

Only power pins can be set to not be visible.
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Operations in the Edit Pins dialog box

This table lists the various operations you can perform in the Edit Pins 
dialog box.

Operation Function

Press F2 Edit the current cell.

Press Tab Shift to the next cell across the row.

Press SHIFT+Tab Shift to the next cell across the row in 
the reverse direction.

Press Enter Apply changes to the current cell and 
shift to the next row.

Press CTRL+C and 
CTRL+V

■ Copy and paste data in the same 
table.

Or 

■ Copy and paste data from Microsoft 
Excel.

In the edit pins table:

■ Pasting data from one cell into 
multiple cells copies the data to all 
the target cells.

■ Pasting data from many cells to 
multiple cells populates data only 
from the copied cells.

Drag the plus sign 
that appears at the 
bottom-right corner 
of a cell to copy 
its contents into 
multiple cells.

Use the range extender to populate 
other cells of a column with the same 
value.
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Operations between Part Editor Canvas and Edit Pins Dialog 
Box

The following table lists the various operations you can perform 
between the canvas and the Edit Pins dialog box.

Paste Options dialog box

To open this dialog box

Select a check box 
to display a 
column.

Clear the check box 
to hide a column.

Select the required column header 
check boxes above the edit pins table to 
show or hide the required columns.

Important

Selection of the check boxes is 
maintained within a session of 
the part editor.

Double-click a 
column header.

Sort column data in ascending or 
descending order.

Operation Description

Select the required pins 
on canvas and open the 
Edit Pins dialog box.

Only the selected pins and their 
corresponding information is displayed 
in the table.

The size of the Edit Pins dialog box 
gets adjusted according to the number 
of pins selected. 

Select all the pins on the 
canvas and open the Edit 
Pins dialog box.

Pin information of all the pins of the 
current section is displayed.

If you do not select any 
pin and open the Edit 
Pins dialog box.

All the pins for all the sections appear in 
the table.

Operation Function
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1. Ensure that the setting Enable the Paste Options mode is 
selected in the Extended Preferences Setup window.

2. Select any number of pins.

or

Select any graphical object with any number of pins selected 
along with it.

3. Copy the selection.

4. Select Edit – Paste, press CTRL+V, or right-click and select 
Paste. 

If you copy only pins, the Paste Options dialog box opens 
immediately. 

If you copy any graphical object along with the pins, the Paste 
Options dialog box opens after you place the copied graphical 
object(s).

The pin location of the copied part is retained only if the 
destination part has no pins else the copied pins are pasted as 
a pin array.

5. Modify the pin information from the required section.

6. Click the Paste button. 

7. Click to place the pin at the required location.

Part Aliases dialog box

To open this dialog box

Click the Part Aliases button in the New Part Properties dialog box.

Use this control... To do this...

Alias Names Select an alias name from the displayed list.

New Open the New Alias dialog box to add new aliases.

Delete Delete the selected alias from the list.
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Part Search dialog box

To open this dialog

Click Part Search in the Place Part dialog box.

Place Bookmark dialog box

To open this dialog

In the schematic page editor, choose Bookmark (see Bookmark 
command)from the Place menu.

Use this control... To do this...

Part Name Specify the part name to search for. Use an asterisk (*) to 
match any string of characters, and a question mark (?) 
to match any single character.

Libraries Displays the location of all libraries for the part specified 
in Part Name. After Capture has searched for the part 
and located it, select the part from one of the libraries 
and click OK. If the library is configured in the Place Part 
dialog box, then Capture closes this dialog box, and 
selects the part in the Place Part dialog box.

Library Path Specify the path containing libraries for Capture to 
search through. Set this to your library directory.

Begin Search Begin searching for the part specified by Part Name, and 
in the directory specified by Library Path.

Browse Display a standard Windows dialog box for selecting files.

Use this control... To do this...

Name Specifies the bookmark's name.
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Place Ground dialog box

To open this dialog

In the schematic page editor

Choose Ground (see Ground command) from the Place menu.

OR

Click the Ground button on the Draw Electrical toolbar.

Use this control... To do this...

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of power symbols and ground symbols in 
the libraries selected in the Libraries list box that match 
what's entered in the Symbol text box. When you select 
an object in this list, its name appears in the Symbol text 
box, and its graphic appears in the preview box. Select 
an object from the list of symbols available in the 
selected libraries.

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Note: The CAPSYM.OLB, which is the default library in 
Capture now includes the PSpice ground (0) symbol. Use 
the ‘0’ symbol to place a PSpice ground 0 symbol in your 
design. If your design does not have a PSpice ground (0) 
symbol, then the PSpice analog simulation may not run. 
To place a PSpice ground ‘0’ symbol in your design, see 
Placing PSpice ground 0 symbols for PSpice simulations.

Preview box Displays the graphic of the selected object.

Name Specify the object's name.

../cap_ug/designing_for_other_EDA_applications.html#Placing_ground_symbols_in_PSpice
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Place NetGroup dialog box

The NetGroup dialog displays when you choose NetGroup from the 
Place menu.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.

Use this control... To do this...

Add NetGroup Click this button to open the New NetGroup dialog to 
create a NetGroup.

Modify NetGroup Click this button to open the Modify NetGroup dialog to 
modify a NetGroup.

Note: You need to click the check mark next to a 
NetGroup name to open the associated NetGroup 
definition in this dialog.

Delete NetGroup Click this button to delete selected NetGroups.

Import NetGroups Click this button to import NetGroups definition Xml files.

Instance Name Enter the instance name of a named NetGroup to place 
on the schematic page.

Place NetGroup Block Check this box to place the NetGroup as a block on the 
schematic page.

Place Unnamed NetGroup Check this box to place the NetGroup as an unnamed 
NetGroup block on the schematic page.
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Place Off-Page Connector dialog box

To open this dialog

In the schematic page editor

Choose Off-Page Connector (see Off-Page Connector command) 
from the Place menu.

OR

Click the Off-Page Connector button on the Draw toolbar.

Use this control... To do this...

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of off-page connectors in the libraries 
selected in the Libraries list box that match what's 
entered in the Symbol text box. When you select an 
object in this list, its name appears in the Symbol text 
box, and its graphic appears in the preview box. Select 
an object from the list of symbols available in the 
selected libraries.

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Preview box Displays the graphic of the selected object.

Name Specify the object's name.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.
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Place Hierarchical Block dialog box

To open this dialog

In the schematic page editor

Choose Hierarchical Block (see Hierarchical Block command) from 
the Place menu.

OR

Click the Hierarchical Block button on the Draw toolbar.

NetGroup OffPage Place the off-page connector as a named NetGroup 
off-page connector.

Note: Select the NetGroup, to be used, from the 
drop-down list of NetGroups.

Show UnNamed NetGroup Place the off-page connector as an unnamed NetGroup 
off-page connector.

Use this control... To do this...

Reference Specify the hierarchical block's name.

Primitive

Default Use the default primitive setting, which for hierarchical 
blocks is nonprimitive. The default setting for hierarchical 
blocks is set in the Hierarchy tab of the Design Template 
dialog box (see Design Template command).

Yes Indicate the hierarchical block is a primitive.

No Indicate the hierarchical block is nonprimitive and 
descends in hierarchy.

User Properties Display the User Properties dialog box so you can modify 
the hierarchical block's user defined properties.

Implementation
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Implementation Type Schematic View Indicate that the attached 
implementation is a schematic folder. Capture 
automatically generates the appropriate hierarchical pins 
for the block based on the hierarchical ports.

VHDL Indicate that the attached implementation is a 
VHDL entity. Capture automatically generates the 
appropriate hierarchical pins for the hierarchical block 
based on the port declarations in the VHDL entity.

EDIF Indicate that the attached implementation is an 
EDIF netlist. If your design includes EDIF 
implementations for hierarchical blocks, you must specify 
the hierarchical pins for the block; Capture will not 
generate them from the EDIF netlist. Also, if your design 
includes EDIF implementations, you can simulate them, 
but you cannot compile or build them.

Project Indicate that the attached implementation is a 
Capture programmable logic project. You must specify 
the hierarchical pins for the hierarchical block; Capture 
will not generate them.

PSpice Model Indicate that the attached implementation 
is a PSpice model file. You must specify the hierarchical 
pins for the block; Capture will not generate them.

PSpice Stimulus Indicate that the attached 
implementation is PSpice stimulus file. You must place 
the hierarchical pins on the block. Capture will not 
generate them.

Verilog Indicate that the attached implementation is a 
Verilog model. Capture automatically generates the 
appropriate hierarchical pins for the hierarchical block 
based the Verilog model.

Attaching an implementation does not automatically add 
that file, project, or schematic folder to the project. You 
must specifically add the implementation to the project 
with the Project command (Edit menu).

Implementation name Specify the name of the attached schematic folder, VHDL 
entity, netlist, or project for the hierarchical block.



OrCAD Capture Reference Guide

June 2020 297 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

Note: If you attach external schematic folders or other files to 
hierarchical blocks in a design or parts in a library, be sure to include 
the attachments when you pass the design or library to a board 
fabrication house or to another engineer. Attached schematic folder 
and other files are not carried along automatically when you copy or 
move a part, schematic folder, or schematic page to another library, 
design, or schematic folder. Only the "pointers" to the attached 
schematic folder and files—that is, their names and the names of the 
designs or libraries that contain them—are carried along.

Attached files work much like their counterparts in email—they do not 
provide an alternative definition of the part (as do attached schematic 
folders).

Note: Be careful not to create recursion in your design. Capture 
cannot prevent recursion, and the Design Rules Check command 
does not report it.

Recursion causes Capture to process infinitely as it tries to expand 
the design, resulting in the loss of any changes you've made to your 
design since it was last saved.

Note: When you attach a schematic folder to a part or hierarchical 
block, you can specify a full path and filename in the Library text box. 
So, although you can specify a library that hasn't been saved, you 
should not try to descend into the attached schematic folder until the 
library that contains the schematic folder has been saved.

If you don't specify a full path and filename in the Library text box, 
Capture expects to find the attached schematic folder in the same 
design as the part of hierarchical block to which it is attached. If the 
specified schematic folder doesn't exist in either the design or library, 
Capture creates the schematic folder when you descend hierarchy 
on the part or the hierarchical block.

For compatibility with future versions of Windows, Capture preserves 

Path and filename Specify the path and filename for the library of the 
attached object. Use the Browse button to locate the file, 
or supply both the path and filename. If the attached 
object is in the same design as the hierarchical block you 
are placing, leave this option unspecified.
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the case of the path and filename as you specify them in the Library 
text box.

Note: Once you have attached a file and associated a text editor with 
it, you can use the Descend Hierarchy command to open that file. If 
you have an attached schematic folder as well as an attached file, 
Descend Hierarchy opens the schematic folder and not the file.

Place Hierarchical Pin dialog box

To open this dialog

In the schematic page editor

Choose Hierarchical Pin (see Hierarchical Pin command) from the 
Place menu.

OR

Click the Hierarchical Pin button on the Draw toolbar.

Note: Bus pins cannot be used directly as netlisting pins. Their main 
purpose is to make it possible to use nonprimitive parts more easily 
by connecting large numbers of signals to a child schematic folder.

Note: You can place one pin on a part that represents all pins for a 
bus. Such a pin is called a bus pin. Bus pins use the same naming 
convention as buses.

Note: You can use bus pins in most cases where you can use scalar 
pins. For example:

Use this control... To do this...

Name Specify the hierarchical pin's name.

Type Select the pin type from the list of pin types. 

Width Specify if the pin connects to a bus or a wire. If bus is 
specified, the hierarchical pin must connect to a bus; 
otherwise, it must connect to a wire.

User Properties Display the User Properties dialog box so you can edit 
the pin's properties.
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■ Off-page connectors

■ Hierarchical ports

■ Hierarchical pins of nonprimitive parts and hierarchical blocks

■ Do not use pins in the following situations:

■ Hierarchical pins of primitive parts and hierarchical blocks

■ Any design that you intend to use with your board layout tool

Place Hierarchical Port dialog box

To open this dialog

In the schematic page editor

Choose Hierarchical Port (see Hierarchical Port command) from the 
Place menu.

OR

Click the Hierarchical Port button on the Draw toolbar.

Use this control... To do this...

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of hierarchical ports in the libraries 
selected in the Libraries list box that match what's 
entered in the Symbol text box. When you select an 
object in this list, its name appears in the Symbol text 
box, and its graphic appears in the preview box. Select 
an object from the list of symbols available in the 
selected libraries.

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Preview box Displays the graphic of the selected object.
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Place IEEE Symbol dialog box

To open this dialog

In the part editor, do one of the following:

■ Select Place – IEEE Symbol, see IEEE Symbol command.

■ Click the IEEE Symbol button on the Draw toolbar.

Place Net Alias dialog box

To open this dialog

In the schematic page editor

Choose Net Alias (see Net Alias command) from the Place menu.

Name Specify the object's name.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.

NetGroup Port Place the hierarchical port as a named NetGroup port.

Note: Select the NetGroup, to be used, from the 
drop-down list of NetGroups.

Show UnNamed NetGroup Place the hierarchical port as an unnamed NetGroup 
port.

Use this control... To do this...

IEEE Symbols Select a symbol from the list of available symbols.

Preview box Displays the graphic of the selected symbol.
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OR

Choose the Place net alias button on the Draw toolbar.

OR

Press the N key.

Click the Off-Page Connector button on the Draw toolbar.

Use this control... To do this...

Alias Enter the net alias name in the text box.

Color Specify the color of the net alias.

Rotation Specify the rotation of the net alias or text.

Font

Change Display the Font dialog box so you can select a font.

Use Default Change the font to the default font specified in the Design 
Template dialog box.

NetGroup

NetGroup Aware Aliases Select to assign a NetGroup to a bus. Select an existing 
NetGroup from the list or edit to add a new NetGroup. 
The width of the alias is the same as the specified 
NetGroup.

Use this control... To do this...

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of off-page connectors in the libraries 
selected in the Libraries list box that match what's 
entered in the Symbol text box. When you select an 
object in this list, its name appears in the Symbol text 
box, and its graphic appears in the preview box. Select 
an object from the list of symbols available in the 
selected libraries.
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Place Part dialog box

To open this dialog

In the schematic page editor

Choose Part (see Part command) from the Place menu.

OR

Click the Part button on the Draw toolbar.

Place Part Pane

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Preview box Displays the graphic of the selected object.

Name Specify the object's name.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.

NetGroup Port Place the off-page connector as a named NetGroup 
off-page connector.

Note: Select the NetGroup, to be used, from the 
drop-down list of NetGroups.

Show UnNamed NetGroup Place the off-page connector as an unnamed NetGroup 
off-page connector.

Use this control... To do this...
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Part Specify the name of the part. Use an asterisk (*) to match 
any string of characters, and a question mark (?) to 
match any single character.

Part List Displays a list of parts in the libraries selected in the 
Libraries list box that match what's entered in the Part 
text box. When you select a part in this list, its name 
appears in the Part text box, and its graphic appears in 
the preview box. Select a part from the list of parts 
available in the selected libraries.

Note: You can filter the part list, using the Filter button 
described below.

Filter Display the Specify Part Filter dialog box that allows you 
to restrict part searches in part libraries based on specific 
criteria. 

For example, if you are a PSpice user, you can restrict 
your part library search such that only parts with 
associated PSpice simulation models will be listed in the 
Part List.

Libraries Select one or more libraries from the list of available 
libraries. The part list displays the parts from the selected 
libraries. You also select libraries from the Libraries list 
box to remove them from the list.

Graphic Select either Normal or Convert view. All parts have a 
normal view. Some parts have a convert view that can be 
used for things such as a DeMorgan equivalent part.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

../cap_ug/Glossary.html#DeMorgan_equivalent
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Remove Library Remove the selected library or libraries from the libraries 
list box.

Reload Library Parts Reloads the Capture library parts in the selected library.

Note: As you reload the library parts, remember the 
following points:

■ To see the updated part, reselect library part in Place 
Part dialog. To update library with newly added or 
deleted parts, reload the library in Place Part dialog.

■ To enable the library parts update on selection, select 
the Refresh part on selection option in Preferences – 
Miscellaneous tab.

Packaging

Parts per Pkg Displays the number of parts in the package.

Part Select the part in the package to place on the schematic 
page.

Type A package may be either homogeneous or 
heterogeneous.

Preview box Displays the graphic of the selected part.
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Application indicator This feature uses icons to indicate whether the selected 
part has certain properties. The icon displayed for each 
property is described below. Note that, in the case of the 
Implementation Type property, only Implementation Type 
properties with values of “Schematic View” or “VHDL” are 
indicated with an icon.

Property: PCB Footprint. Value: Various values related 
to PCB layout.

Property: Implementation Type. Value: “Schematic View”

Property: Implementation Type. Value: “VHDL”

Property: Implementation Type. Value: “Verilog”
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Search Part

The Search for Part section of the Place Part dialog box is viewed if 
you click the Expand button.

Place Pin Array dialog box

To open this dialog

In the part editor, do one of the following:

■ Select Place – Pin Array or see Pin Array command.

■ Click the Pin Array button on the Draw toolbar.

Property: PSpice Template. Value: PSpice syntax for 
part netlist entry

This icon is not associated with any property. It indicates 
that the part is associated with a template-based 
parameterized PSpice model.

Search For Enter the part name (you can include wildcard 
characters) to search through the libraries for a specific 
part or parts.

Path Enter the path of the library to search for the part. You 
can use the Browse button to select the library.

Libraries Displays a list of libraries in which you searched for parts.

Add Add libraries from the search library list to the Place Part 
library list.

Use this control... To do this...
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Starting Name Specify the name for the pin array. If the name ends with 
a digit (0--9), each pin in the array is incremented by the 
value specified in the Pin# Increment for Next Pin 
field.

You can create a pin name with an overbar for a negated 
pin by adding a backslash (\) after every letter in the pin 
name.

When you open this dialog box to add more pin arrays, 
you can see that Starting Name is automatically 
incremented from the last usage of the pin array.

Starting Number Specify the starting number for the pin array. Pin 
numbers can be alphanumeric. If a pin number ends in a 
number, it is incremented by the value specified in the 
Pin# Increment for Next Pin field.

When you open this dialog box to add more pin arrays, 
you can see that Starting Number is automatically 
incremented from the last usage of the pin array.

Number of Pins Specify the number of pins in the pin array.

Pin Spacing Specify the spacing between pins for the pin array.

Shape Select the pin shape from the list of pin shapes. 

When you open this dialog box to add more pin arrays, 
you can see that last selection of pin shape is retained.

Type Select the pin type from the list of pin types. 

When you open this dialog box to add more pin arrays, 
you can see that last selection of pin type is retained.

Pin Visible Specify the pin visibility when the part is placed on the 
schematic page. Only power pins can be set to not 
visible.

Additional Options

Pin# Increment for Next Pin Specify the increment for the next pin number in the pin 
array.

Pin# Increment for Next Section Specify the increment between pin numbers for the next 
section. This is valid only for homogeneous parts.
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Place Pin dialog box

To open this dialog

In the part editor, do one of the following:

■ Select Place – Pin, or see Pin command.

■ Click the Pin button on the Draw toolbar.

Use this control... To do this...

Name Specify the pin name. You can create a pin name with an 
overbar by adding a backslash (\) after every letter in the 
pin name.

If the name ends with a digit (0--9), each pin name is 
automatically incremented, by the value specified in the 
Pin# Increment for Next Pin field. You can see that the 
pin name value is automatically incremented from the 
last usage of the pin.

Number Specify the pin number. Pin numbers can be 
alphanumeric.

If it ends in a number, it is incremented by the value 
specified in the Pin# Increment for Next Pin field. You 
can see that the pin number value is automatically 
incremented from the last usage of the pin.

Shape Select the pin shape from the list of pin shapes.

When you open this dialog box to add more pins, you can 
see that last selection of pin shape is retained.

Type Select the pin type from the list of pin types.

When you open this dialog box to add more pins, you can 
see that last selection of pin type is retained.

Width Specify whether the pin connects to a bus or a wire. If 
bus is specified, the pin must connect to a bus; 
otherwise, it must connect to a wire.

Pin Visible Specify the pin visibility when the part is placed on the 
schematic page. Only power pins can be set to not 
visible.
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Note: Bus pins cannot be used directly as netlisting pins. Their main 
purpose is to make it possible to use nonprimitive parts more easily 
by connecting large numbers of signals to a child schematic folder.

Note: You can place one pin on a part that represents all pins for a 
bus. Such a pin is called a bus pin. Bus pins use the same naming 
convention as buses.

You can use bus pins in most cases where you can use scalar pins. 
For example:

■ Off-page connectors

■ Hierarchical ports

■ Hierarchical pins of nonprimitive parts and hierarchical blocks

Do not use pins in the following situations:

■ Hierarchical pins of primitive parts and hierarchical blocks

■ Any design that you intend to use with your board layout tool

Place Power dialog box

To open this dialog

In the schematic page editor

Choose Power (see Power command) from the Place menu.

OR

Click the Power button on the Draw toolbar.

User Properties Click this button to open the User Properties dialog box, 
so you can add or edit any user-defined property.

Additional Options

Pin# Increment for Next Pin Specify the increment for the next pin.

Pin# Increment for Next Section Specify the increment between pin numbers for the next 
section. This is valid only for homogeneous parts.
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OR

Press the F key.

Place Text dialog box

To open this dialog

In the schematic page editor, do one of the following:

■ Select Place – Text, or see Text command.

■ Click the Text button on the Draw toolbar.

Use this control... To do this...

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of power symbols and ground symbols in 
the libraries selected in the Libraries list box that match 
what's entered in the Symbol text box. When you select 
an object in this list, its name appears in the Symbol text 
box, and its graphic appears in the preview box. Select 
an object from the list of symbols available in the 
selected libraries.

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Preview box Displays the graphic of the selected object.

Name Specify the object's name.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.
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■ Press the T key.

Place Title Block dialog box

To open this dialog

In the schematic page editor

Choose Title Block (see Title Block command) from the Place menu.

OR

Click the Title Block button on the Draw toolbar.

Use this control... To do this...

Text Enter the text in the text box.

Color Specify the color of the text. Text that is placed in the part 
editor uses the part body color.

Rotation Specify the rotation of the text.

Font

Change Display a Font dialog box so you can select a font.

Use Default Change the font to the default font specified in the Design 
Template dialog box.

Text Justification Specify the text justification for the comment text as 
Default, Left, Center, and Right. The default text 
justification is the legacy Capture behavior as performed 
in Capture 16.5. For more information on Text 
Justification, see Table 8-1: Text Justification table on 
page 235.

Note: Text justification in a design saved using 16.6 
HotFix of Capture will not be preserved if the design is 
opened and saved using Capture 16.6 and earlier 
releases.

Use this control... To do this...
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Preferences dialog box

To open this dialog

In the schematic page editor or part editor, choose Preferences (see 
Preferences command) from the Options menu.

Symbol Specify a symbol to select and view. Use an asterisk (*) 
to match any string of characters, and a question mark 
(?) to match any single character.

Symbol List Displays a list of title blocks in the libraries selected in the 
Libraries list box that match what's entered in the Symbol 
text box. When you select an object in this list, its name 
appears in the Symbol text box, and its graphic appears 
in the preview box. Select an object from the list of 
symbols available in the selected libraries.

Libraries Select one or more libraries from the list of available 
libraries. The symbol list displays the objects from the 
selected libraries. You also select libraries from the 
Libraries list box to remove them from the list.

Preview box Displays the graphic of the selected object.

Name Specify the object's name.

Add Library Display a standard Windows Open dialog box for adding 
a library to the Libraries list box. You can add a library in 
SDT format. If you do, you can save the library in the 
Capture format (.OLB).

Remove Library Remove the selected library or libraries from the libraries 
list box.

Use this tab... To do this...

Application Theme Click the drop-down list to select the theme of the 
application.

Schematic Theme Click the drop-down list to select the theme of the 
schematic page.
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Colors/Print Define the default color of objects such as aliases, wires, 
design variants, part not present, and pins. A standard 
Windows default Color dialog box appears when you 
click on the color of an item.

The check boxes next to the objects control whether the 
objects will be printed or plotted. If an object's box is 
selected, the object can be printed or plotted. Objects 
always appear on your screen, regardless of the setting 
of their check boxes.

The Use Defaults button resets colors to the default 
colors shipped with Capture.

Note: The border and grid references of schematic pages 
use the color specified for title blocks.

Important

Color specified in part editor for Pin Name, Pin 
Number, Part Properties, Part Reference Prefix, 
Part Value, and any user-defined property 
overrides the color selected in the Preferences 
dialog box.

Grid Display Control the behavior and appearance of the grid display 
for both the schematic page editor and the part editor. 
See Grid Display tab for more information.

Pan And Zoom Set auto scrolling options and zoom factor for both the 
schematic page editor and the part editor. See Pan and 
Zoom tab for more information.

Select Specify selection options, change the maximum number 
of objects you can drag, and set tool palette visibility for 
both the schematic page editor and the part editor. For 
more information, see Select tab

Miscellaneous Specify the fill style, line style, and line width for both the 
schematic page editor and the part editor. Also specify 
the line color for the schematic page editor. You can also 
define the session log font, set text rendering, set auto 
recovery intervals, and enable intertool communication. 
For more information, see Miscellaneous tab.



OrCAD Capture Reference Guide

June 2020 314 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

Color/Print tab

Use these options to specify the color settings for the different object 
types on a schematic page.

Grid Display tab

Use these options to specify the appearance of the grid for your 
working area. You use this dialog box to set grid properties for both 
the schematic page grid and the part and symbol grid.

Text Editor Specify font and color information for the text editor. Also 
specify tab setting in terms of character spacing, and 
highlighting options. For more information, see Text 
Editor tab.

Board Simulation Specify the hardware development language to be used 
during board level simulation. 

Use this control... To do this...

Basic colors Shows the color of the object selected in the Colors tab.

To change the color, click the left mouse button on a 
different color and then click OK.

Custom colors This feature is disabled in Capture.

Define Custom Colors This feature is disabled in Capture.

Use this control... To do this...

Visible Specify whether the schematic page or part's grid is 
visible or hidden on the screen.

Grid Style Specify whether the grid appears as grid dots or lines in 
the editor.



OrCAD Capture Reference Guide

June 2020 315 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

Note: Ensure that the Pointer snap to grid check box is selected 
and the Connectivity Elements is set to Coarse while placing 

Grid spacing Specify the grid spacing on the schematic page as a 
fraction of pin-to-pin spacing.

For example, a setting of 1/2 specifies that the grid 
spacing on the schematic page is set to exactly half the 
specified pin-to-pin spacing.

Pointer snap to grid Specify whether the pointer snaps to the grid in the 
editor. This check box is selected by default.

Fine

(only for schematic page 
editor)

Specify whether connectivity (part, bus) and drawing 
objects, like Line, Polyline, Text, Rectangle, Ellipse, Arc, 
and Picture can be placed and moved on the fine grid. 
For description of various scenarios for this option, see 
Customizing placement and movement of objects on the 
schematic.

Note: This setting is saved in the CAPTURE.INI file and 
it is used whenever you start the next Capture session.

Coarse

(only for schematic page 
editor)

Specify whether connectivity and drawing objects can be 
placed and moved on the coarse grid. For description of 
various scenarios for this option, see Customizing 
placement and movement of objects on the schematic.

Note: This setting is saved in the CAPTURE.INI file and 
it is used whenever you start the next Capture session.

Master

(only for schematic page 
editor)

Specify whether connectivity and drawing objects can be 
placed and moved on the master grid, if Pointer snap to 
grid check box is selected. This setting is equivalent to 
the Snap To grid toolbar state .

Specify whether connectivity and drawing objects can be 
placed and moved on the fine grid, if Pointer snap to 
grid check box is not selected. This setting is equivalent 
to the Snap To grid toolbar state .

For description of various scenarios for this option, see 
Customizing placement and movement of objects on the 
schematic.

Note: This setting is saved in the CAPTURE.INI file and 
it is used whenever you start the next Capture session.

../cap_ug/Setting_Project_Preferences.html#Customizing_placement_and_movement_of_objects_on_the_schematic
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connectivity objects. Otherwise, your part pins may be placed on the 
fine grid, making it difficult to connect them properly.

Note: When you place a part on fine grid, it remains on fine grid 
through any cut-and-paste and drag-and-drop operations.

Miscellaneous tab

Use these options to specify miscellaneous options in Capture.

Use this control... To do this...

Fill Style Specify a fill pattern for rectangles, ellipses, and 
polygons.

Line Style Specify line style for lines, polylines, rectangles, ellipses, 
and arcs.

Line Width Specify line width for lines, polylines, rectangles, ellipses, 
and arcs.

Color Specify the color of lines, rectangles, and ellipses. 
Polylines and arcs use the default color of objects set in 
the Colors tab. This option only applies to lines, 
rectangles, and ellipses in the schematic page editor.

This color is not the default color, but can be set to use 
the default color. Objects placed while this option is not 
set to the default color, won't use the default color. 
Changing this option won't change the color of objects 
already placed in the schematic page editor.

Note: You can change the fill style, line and width style, and color on individual objects using 
the Properties command on the Edit menu.

Junction Dot Size Specify the dot size as Small, Medium, Large, and Very 
Large. This will increase or decrease the size of the dots 
created when a wire is connected to another wire.

Project Manager and Session 
Log

Specify the font for the session log. If you click on this 
box, a standard Windows Font dialog box for font 
selection appears. This option is neither a schematic 
page nor a part editor option.
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Text Rendering

Render TrueType fonts with 
strokes

Specify that text appears as a series of lines, connected 
to resemble the outlines of the corresponding TrueType 
letters or numbers they represent.

Fill text Specify that text outlines be filled in.

Auto Recovery

Enable Autorecover Enable or disable auto recovery. If the option is checked, 
then auto recovery is enabled.

Update every N minutes Specify the time interval in minutes (where N is the 
number of minutes) after which Capture performs an 
auto-save. 

Note: Auto recovery is not an automatic saving feature. If you intentionally exit Capture 
without first saving your changes, they will be lost. Autorecovered files are automatically 
deleted when you exit Capture normally.

Auto Reference

Automatically reference placed 
parts

(Default: ON)

Enable automatic part referencing. When a part is placed 
on the schematic page, the next available reference 
designator will automatically be assigned. Disabled, 
parts placed on the schematic will be assigned the 
reference designator found in the library. For example: 
U?A or JP?. This is the default selection.

You can choose to perform design level annotation by 
selecting the Design Level (Only PCB Designs) 
option. This option is not selected by default. This option 
should be used for PCB Designs only. For more 
information on Design Level Annotation, see Table 8-2: 
Design Level Annotation table on page 318.
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Note: The Auto Reference feature should be used to provide unique part references for 
simulation, and is not intended to replace the packaging process for a PCB design. For 
packaging you should Annotate your design. 

Preserve reference on copy Enable part references to be preserved while pasting a 
part to a schematic page. When you copy a part and 
paste it on a schematic page, the part will retain the 
same reference designator as that of the copied part. 
But, if you place a new part on a schematic page, 
Capture will assign the reference designator found in the 
library. For example: U?A or J?P.

Note: This option is not supported for complex 
hierarchical designs.

Note: You can select only one option at a time.

Table 8-2: Design Level Annotation

Project Created Using Simulation 
Enabled

Will Design Level 
Annotation Work?

Schematic - Yes

PCB Wizard Board No Yes

PCB Wizard Board Yes No

PCB Wizard Board Yes, using 
Analog or Mixed 
Signal Simulation

No

PCB Wizard Board Yes, using 
Verilog-based 
digital simulation

No

Analog or Mixed Signal 
Simulation

Yes, using 
VHDL-based 
digital simulation

No

Programmable Logic 
Wizard

- No
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Depending on the check box selection state, the following scenarios are possible:

■ If both the check boxes are disabled:

❑ the new part that you place on a schematic page will not be annotated.

❑ the part references of the copied part will not be preserved while pasting that part 
on a schematic page.

■ If the Automatically reference placed parts check box is enabled:

❑ the new parts that you place on a schematic page will be annotated.

❑ the part references of the copied part will not be preserved while pasting that part 
on a schematic page, rather they will be incremented.

■ If the Preserve reference on copy check box is enabled:

❑ the new part that you place on a schematic page will not be annotated.

❑ the part references of the copied part will preserved while pasting that part on a 
schematic page.

Intertool Communication

Enable intertool communication

(Default: OFF)

Enable intertool communication with other OrCAD 
products such as Simulate or Layout. For more 
information about intertool communication, see Intertool 
communication. This option is not specific to either the 
schematic page editor or the part editor.

Wire Drag

Allow component move with 
connectivity changes

(Default: ON)

If this check box is selected or the toolbar button is in the 
Drag Connected Object state, then Capture allows you to 
drag and place the selected part or wire on the 
schematic, even if it results in connectivity changes. Also, 
Capture flags a warning with a changed cursor and will 
show the temporary markers.

If the check box is not selected or the toolbar button is in 
the Drag Connected Object state, then the selected part 
or wire attaches to the cursor and does not get placed on 
the schematic, if it results in connectivity changes. Also, 
Capture flags only a warning with a changed cursor and 
does not show the temporary markers.

Docking
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Pan and Zoom tab

Use these options to specify panning and zooming factors. Set them 
separately for the schematic page editor, and the part and symbol 
editor.

Docking Place Part

(Default: ON)

If this option is checked, the dockable Place Part dialog is 
invoked when you select the Place Part command. 
Unchecking this option will ensure that the modal Place 
Part dialog displays.

Note: You need to restart Capture to make changes to 
this option effective.

IREF Display Property

Global Visibility

(Default: ON)

Checking this option ensures that the intersheet 
references are visible. Unchecking this option will hide 
the intersheet references.

Note: If you un-check this option (to hide the intersheet 
references in a design), and then run the Intersheet 
References command, the intersheet references will be 
displayed on the relevant pages of the design. If you then 
open the Miscellaneous tab, notice the Global Visibility 
option is checked.

Place Part

Refresh part on selection 

(Default: OFF)

If this option is checked, then the library parts are 
updated in the Place Part dialog. Unchecking this option 
ensures that the library parts are not updated in the 
Place Part dialog.

Use this control... To do this...

Zoom Factor Specifies the zoom factor for the editor.

Note: The zoom factor can be any number between 1 and 
10.

Auto Scroll Percent Specifies how much of the schematic page or part scrolls 
across the screen when the pointer drags a selected 
object into the border area of the editor.
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Select tab

Use these options to specify selection factors.

Text Editor tab

Use these options to specify the text settings like syntax highlight 
colors.

Use this control... To do this...

Area Select Specify whether objects are selected when the selection 
area border intersects them, or only when they are 
completely enclosed in the selection area.

Note: If the Fully Enclosed option is selected and you 
select an object on a schematic page, make sure that you 
select the object along with its name and number. 
Otherwise, the object does not get selected.

Maximum number of objects to 
display at high resolution while 
dragging

Specify the maximum number of objects that are visible 
at high resolution while performing a drag-and-drop 
operation. When you drag a number of objects greater 
than this value, a rectangular placeholder appears in lieu 
of the selected objects.

Show Palette Specifies whether the tool palette is visible or hidden.

Use this control... To do this...

Syntax Highlighting Displays the current colors for VHDL and Verilog 
keywords, comments, and quoted strings. Select one of 
the color buttons to display the standard Windows Color 
dialog box. In the Color dialog box, you can change the 
color of the selected language element.

Current Font Setting Displays the current settings of the font item selected in 
the Set Font For option. The settings displayed are the 
font, font size, style, effects, and color.

Set Display the standard Windows Font dialog box for setting 
font options. The settings apply to the selected font item 
only.
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Board Simulation tab

Use these options to specify the hardware development language 
used for board simulation.

Note: Be sure to use a monospaced font (for example, Courier) as the default font for the 
text editor or the source editor. If you use a true-type font, the editor may distort the 
appearance of the text, making it difficult to read.

Tab Setting Specify the spacing between tabs in terms of character 
spaces for the text editor. The range is limited to 1-100.

This tab setting is stored in the CAPTURE.INI file. 
Capture will ignore existing CAPTURE.INI files that 
specify the tab setting in inches and will reset spacing to 
a default of four character spaces.

Highlight Keywords, Comments, 
and Quoted Strings

Specify that Capture highlight all VHDL or Verilog 
keywords, comments, and quoted strings in the active 
file.

Show line numbers Specify that the text editor display line numbers in text 
files

Save text files on deactivate Specify that any open text files are saved in their current 
state whenever the text editor window loses focus

Auto reload text files Specify that the text editor reload text files automatically 
when there is a more recent version of the file as a result 
of a Capture operation (such as netlist generation).

Save text files before running 
tools

Specify that the text editor save any open text files before 
running any Capture tools (such as design rules check or 
netlist generation).

Reset Reset all the tab options to Capture's default values.

Use this control... To do this...

VHDL Specify that Capture use VHDL for the board simulation 
netlist and testbench. 

Verilog Specify that Capture use Verilog for the board simulation 
netlist and testbench.
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Print dialog box

To open this dialog

Choose Print (see Print command) from the File menu.

Note: Click the Setup button to go to the Print Setup dialog box and 
check settings before you print. All settings you choose (except the 
number of copies) are saved to CAPTURE.INI and will become the 
default when you restart Capture.

Use this control... To do this...

Printer Displays the active printer and printer connection.

Scale Specify the scaling factor to print by, or let Capture 
automatically scale to the specification.

■ Scaling to paper size - Forces Capture to scale the 
printing job to the page size specified in the Page 
Size tab in the Schematic Page Properties dialog 
box. Use the Page Size tab in the Design Template 
dialog box on the Options menu to reset the Custom 
page size.

■ Scale to page size - Forces Capture to scale the 
printing job to the page size specified by the Page 
size option in the Print dialog box.

■ Scale - Specifies the scaling factor to print by, or lets 
Capture automatically scale to the specified scale.

Page size If Scale to page size is selected, select the page size to 
which the image will be scaled. Choose one of the 
standard page sizes, or Custom. These sizes are defined 
in the Schematic Page Properties dialog box, in the Page 
Size tab.
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Print offsets Specifies horizontal and vertical printing offsets in inches 
or millimeters (mm) depending on the setting you’ve 
chose in the Design Template dialog box. Capture 
centers the page horizontally and vertically when both 
check boxes are selected.

Your entire schematic page will be output to the printing 
or plotting device, regardless of the use of offsets. The 
following rules define the number of output pages that 
will be printed or plotted:

■ The device and its driver determine the dimensions 
of the printed page area.

■ The number of pages is calculated from the physical 
dimensions of the schematic page and the 
driver-provided area dimensions.

■ A positive offset shifts the entire schematic page to 
the right in the X direction, and down in the Y 
direction. Additional pages are output as necessary 
so the entire schematic is printed. There is no 
truncation.

■ A negative offset shifts the schematic page left, and 
up. The effect of a negative offset is to start the 
drawing on a “previous” page. Previous pages are 
“prepended” so drawing can start at the starting 
portion of the schematic. There is no truncation.

■ Only the number of pages required to print or plot the 
schematic page will be printed. Extra, blank pages 
are omitted.

Print option Specify whether you want to print instances or 
occurrences of a page. 

■ Inst. Mode (Instance mode) - Enables you to print 
only the instances of a page in a schematic. This 
option is selected by default.

■ Occ. Mode (Occurrence mode) - Enables you to print 
multiple occurrences of a page in a schematic.

Print quality Specify the resolution of the print. Choose a setting from 
the drop-down list.

Copies Specify the number of copies to print.
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Print to file Print the object to a file. If you select this option, the Print 
to File dialog box appears after you click OK.

Print all colors in black Causes difficult-to-read colors to print in black.

Collate copies Print copies organized in order of page numbers

Print area When a specific print area is set for the schematic page 
and this option is selected, the print output is the print 
area of the schematic page. Clear this check box to print 
the entire schematic page.

When Print area is selected, all print options except Print 
quality, Copies, Print to file, and Print all colors in black 
are unavailable. Output of selected print area is zoomed 
in and centered.

Include pages outside hierarchy Specifies to also print pages in the design that are not 
included in the root hierarchy. If you do not select this 
option, only those files included in the root hierarchy will 
print.

Include referenced pages in 
other libraries or designs

Specifies to also print pages outside of the design that 
the root hierarchy references. If you do not select this 
option, only the files in the design’s root hierarchy will 
print.
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The Print statistics section of the Print and Print Preview dialog boxes 
reports the number of horizontal and vertical pages it takes to print 

Print statistics ■ Printed pages per document page - Specifies the 
number of horizontal and vertical pages needed to 
print a document. If a schematic page (document 
page) takes more than one page to print out, Capture 
reports the total number of pages under the Total 
column heading. Horizontal and Vertical refers to the 
pages that will make up the printed schematic page.

For example, a schematic page may take four pages 
to print, so the Total is 4. Depending on physical 
shape of the design, the Horizontal may be 2 and the 
Vertical may be 2 (2 x 2), or the Horizontal may be 4 
and the Vertical may be 1 (4 x 1).

■ Maximum page size for selected printer - These 
dimensions identify the printable page area of the 
printer and are dependent on the printer and paper 
size.

■ Size from schematic page properties - Specifies the 
dimensions of the page size selected on the Page 
Size tab of the Schematic Page Properties dialog 
box.

■ Size of actual printout - Specifies the scaled 
document size as it changes with different settings in 
the Scale options or when you change the page 
orientation in the Print Setup dialog box.

The Maximum size for the page layout, Size from 
schematic page properties, and Size of actual 
printout dimensions are shown in inches or 
millimeters, depending on the setting you’ve chose in 
the Design Template dialog box.

Setup Display a standard Windows dialog box to set printer or 
plotter configuration.



OrCAD Capture Reference Guide

June 2020 327 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

out the selected document. If the schematic page you want to print 
takes a two-page layout as shown here:

You would see this in the Printed pages per document page statistics:
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Note: When printing a multi-page schematic, make sure that the 
pages do not have multiple Title Blocks with different page numbers. 
Otherwise, the pages will not be printed in the correct order. If you 
change the page numbers in the Title Blocks manually, then make 
sure that the Do not change the page number check box is checked 
in the Annotate dialog box.

Print Preview and Print Setup dialog boxes

To open this dialog

Choose Print Preview (see Print Preview command) from the File 
menu.

Note: Click the Setup button to go to the Print Setup dialog box 
before you print. All settings you choose (except the number of 
copies) are saved to CAPTURE.INI and will become the default when 
you restart Capture.

Use this control... To do this...

Printer Displays the active printer and printer connection.

Scale Specify the scaling factor to print by, or let Capture automatically 
scale to the specification.

■ Scaling to paper size - Forces Capture to scale the printing job 
to the page size specified in the Page Size tab in the Schematic 
Page Properties dialog box. Use the Page Size tab in the 
Design Template dialog box on the Options menu to reset the 
Custom page size.

■ Scale to page size - Forces Capture to scale the printing job to 
the page size specified by the Page size option in the Print 
dialog box.

■ Scale - Specifies the scaling factor to print by, or lets Capture 
automatically scale to the specified scale.

Page size If Scale to page size is selected, select the page size to which the 
image will be scaled. Choose one of the standard page sizes, or 
Custom. These sizes are defined in the Schematic Page Properties 
dialog box, in the Page Size tab.
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Print offsets Specifies horizontal and vertical printing offsets in inches or 
millimeters (mm) depending on the setting you choose in the 
Design Template dialog box. Capture centers the page horizontally 
and vertically when both check boxes are selected.

Your entire schematic page will be output to the printing or plotting 
device, regardless of the use of offsets. The following rules define 
the number of output pages that will be printed or plotted:

■ The device and its driver determine the dimensions of the 
printed page area.

■ The number of pages is calculated from the physical 
dimensions of the schematic page and the driver-provided area 
dimensions.

■ A positive offset shifts the entire schematic page to the right in 
the X direction, and down in the Y direction. Additional pages 
are output as necessary so the entire schematic is printed. 
There is no truncation.

■ A negative offset shifts the schematic page left, and up. The 
effect of a negative offset is to start the drawing on a “previous” 
page. Previous pages are “prepended” so drawing can start at 
the starting portion of the schematic. There is no truncation.

■ Only the number of pages required to print or plot the 
schematic page will be printed. Extra, blank pages are omitted.

Print option Specify whether you want to print instances or occurrences of a 
page. 

■ Inst. Mode (Instance mode) - Enables you to print only the 
instances of a page in a schematic. This is the default option.

■ Occ. Mode (Occurrence mode) - Enables you to print multiple 
occurrences of a page in a schematic.

Print quality Specify the resolution of the print. Choose a setting from the 
drop-down list.

Copies Specify the number of copies to print.

Print to file This option is not available in Print Preview. If you want to print to 
file, use the Print dialog box.

Print all colors in black Causes difficult-to-read colors to print in black.

Collate copies Print copies organized in order of page numbers
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Print area When a specific print area is set for the schematic page and this 
option is selected, the print output is the print area of the schematic 
page. Clear this check box to print the entire schematic page.

When Print area is selected, all print options except Print quality, 
Copies, Print to file, and Print all colors in black are unavailable. 
Output o selected print area is zoomed in and centered.

Include pages outside 
hierarchy

Specifies to also print pages in the design that are not included in 
the root hierarchy. If you do not select this option, only those files 
included in the root hierarchy will print.

Include referenced 
pages in other 
libraries or designs

Specifies to also print pages outside of the design that the root 
hierarchy references. If you do not select this option, only the files 
in the design’s root hierarchy will print.

Print statistics ■ Printed pages per document page - Specifies the number of 
horizontal and vertical pages needed to print a document. If a 
schematic page (document page) takes more than one page to 
print out, Capture reports the total number of pages under the 
Total column heading. Horizontal and Vertical refers to the 
pages that will make up the printed schematic page.

For example, a schematic page may take four pages to print, so 
the Total is 4. Depending on physical shape of the design, the 
Horizontal may be 2 and the Vertical may be 2 (2 x 2), or the 
Horizontal may be 4 and the Vertical may be 1 (4 x 1).

■ Maximum page size for selected printer - These dimensions 
identify the printable page area of the printer and are 
dependent on the printer and paper size.

■ Size from schematic page properties - Specifies the 
dimensions of the page size selected on the Page Size tab of 
the Schematic Page Properties dialog box.

■ Size of actual printout - Specifies the scaled document size as 
it changes with different settings in the Scale options or when 
you change the page orientation in the Print Setup dialog box.

The Maximum size for the page layout, Size from schematic 
page properties, and Size of actual printout dimensions are 
shown in inches or millimeters, depending on the setting you’ve 
chose in the Design Template dialog box.
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Print Setup dialog box

To open this dialog

choose the Print Setup (see Print Setup command) from the File 
menu.

OR

Click the Setup button on the Print dialog box or Print Preview and 
Print Setup dialog boxes.

The Print Setup dialog box is a standard windows dialog box for 
configuring your printer or plotter. Use it to choose a printer, paper 
source, and orientation before printing. For more information on 
setting up printers and plotters, refer to the documentation for your 
configured printer driver.
Many times, the options for your printer are not available in the 
standard setup dialog box. If you do not find the options you need, try 
the printer setup in the Windows Control Panel.

Print to File dialog box

To open this dialog

In the Print dialog box, select the Print to File option and then click 
OK.

Setup Display a standard Windows dialog box to set printer or plotter 
configuration.

Use this control... To do this...

Output file name Specify the name of the output file.
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Programmable Logic Project Wizard 
dialog box

Programmable logic project for designs may include Verilog or VHDL 
models as part of the structure. Projects of this nature will often use 
simulation and synthesis tools as part of the design flow. When you 
create a programmable logic project, certain folders are added to the 
project. These are discussed in Working with the project manager.

To create a programmable logic project:

1. Select the logic vendor and target family for the project (for 
example, Actel, Altera, and Xilinx family).

2. Click the Finish button.

Propagation Delay dialog box

Use this dialog box to specify a pin-pair and select valid minimum and 
maximum value for the PROPAGATION_DELAY property.

The PROPAGATION_DELAY property has the following syntax:

<Pin_pair>:<min_value>:<max_value>

To open this dialog

While editing the PROPAGATION_DELAY property in the Property 
Editor, choose Invoke UI from the Edit menu press CTRL+U.

OR

Right-click the grid corresponding to the PROPAGATION_DELAY 
property and select Invoke UI from the popup menu.

Use this control... To do this...
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Note: You can use the User Properties dialog box to assign the 
PROPAGATION_DELAY property to all the bits of a bus at the same 
time. Make sure that you use the correct syntax for specifying a value 
for the PROPAGATION_DELAY property. The syntax is:

Pin Pair Applies Min and/or Max delay constraint to various 
pin-pairs. This value may be set to one of the following:

■ Longest/Shortest pin-pair—Minimum delay is applied 
to the shortest pin-pair and maximum delay is applied 
to the longest pin-pair.

■ Longest/Shortest Driver/Receiver—Minimum is 
applied to the shortest Driver/Receiver pin-pair and 
maximum is applied to the longest Driver/Receiver 
pin-pair.

■ All Drivers/All Receivers—Min/Max constraints apply 
to all Driver/Receiver pin-pairs.

Min Specifies the minimum allowable propagation 
delay/length for the pin-pairs. 

Min Rule Specifies whether the minimum allowable propagation 
delay is measured as DELAY in ns, %MANHATAN, or 
LENGTH in mills (mils), micron (um), millimeter (mm), 
centimeter (cm), and inches (in).

Max Specifies the maximum allowable propagation 
delay/length for the pin-pairs. 

Max Rule Specifies whether the maximum allowable propagation 
delay is measured as DELAY in ns, %MANHATAN, or 
LENGTH in mills (mils), micron (um), millimeter (mm), 
centimeter (cm), and inches (in). 

Add Pin Pair Displays the Create Pin Pairs dialog box. Use this dialog 
box to define a pin-pair.

Keyboard shortcut: ALT, A

Delete Pin Pair Deletes the pin-pair corresponding to the selected row.

Keyboard shortcut: ALT, D

OK Performs syntax checking and if the syntax is correct 
assigns the PROPAGATION_DELAY property on the 
selected net.
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<Pin_pair>:<min_value>:<max_value>

The pin-pairs can only be:

■ L:S

■ D:R

■ AD:AR

Properties dialog box

Use the dialog box to access information about the current project, or 
the file currently selected in the project manager window. You can 
also change the description of a file.

To open this dialog

Choose Properties (see Properties command) from the Edit menu or 
from the pop-up menu.

General tab

Use this tab... To do this...

General tab Provide information about the file name, size, and the 
date it was last modified. For more information, see 
General tab

Type tab Specify the type of the file, such as schematic or 
simulation model. For more information, see Type tab.

Project tab Specify project options. These options include project 
type, vendor, and family. For more information, see Type 
tab.

Use this control... To do this...

File name Displays the name of the file currently selected in the 
project manager window.



OrCAD Capture Reference Guide

June 2020 335 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.

Type tab

PSpice Part Search dialog box

Use this dialog box to place PSpice Parts on the schematic page by 
searching them in the libraries using PSpice Part Search.

To open this dialog

Select Place – PSpice Component – Search.

Last modified date Displays the date that the file was last modified.

Size Displays the size (in bytes) of the file currently selected in 
the project manager window.

Use this control... To do this...

File type drop-down list The drop-down list provides a list of file descriptions. The 
file description of the file that is currently selected in the 
project manager window appears in the window. Select 
another file description from the drop list to change the 
file type of the file currently selected in the project 
manager window.

Use this control... To do this...

Category View

Hide Categories View/Show 
Categories View

Toggle Hide Categories View or Show Categories View 
to hide or unhide the Category View.

Search Online Opens new window in Capture for searching PSpice 
models in OrCAD Capture Marketplace

Categories tab Displays PSpice parts in categories defined by PSpice 
parts function

Library tab Displays PSpice parts in the libraries they are associated 
to
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Search Window View

Search text box Enter the search text to search for PSpice parts in the 
PSpice Part Search database

Search drop-down list Provides option to search in selected category or all 
categories

Symbol Viewer Displays symbol of the selected part

Part Table View

Part Name Displays part name of the PSpice part

Description Displays brief description of the PSpice part

Symbol Library Displays library path of the selected PSpice part
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Remove Occurrence Properties box

To open this dialog

Select a design (.DSN) in the Project manager and choose Remove 
Occurrence Properties (see Remove Occurrence Properties 
command) from the Design menu.

Click Yes, if you want to remove all backannotation and occurrence 
properties from the design. Otherwise, click No.

Caution

If you chose to remove all backannotation and 
occurrence properties from your design, these 
properties are permanently removed from the 
design. You cannot undo this action.

Rename Hierarchical Port dialog box

To open this dialog

Select a hierarchical port in a library in the Project manager and 
choose Rename (see Rename command) from the Design menu.

Rename Off-Page Connector dialog box

To open this dialog

Select an off-page connector in a library in the Project manager and 
choose Rename (see Rename command) from the Design menu.

Use this control... To do this...

Name Specify the name of the hierarchical port.

Use this control... To do this...
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Rename Page dialog box

To open this dialog

Select a schematic page in the Project manager and choose 
Rename (see Rename command) from the Design menu.

Rename Part dialog box

To open this dialog

Select a schematic part in a library in the Project manager an choose 
Rename (see Rename command) from the Design menu.

Rename Part Property dialog box

To open this dialog

Select a design (.DSN) or a schematic page in the Project manager 
and choose Rename Part Property (see Rename Part Property 
command) from the Edit menu.

Name Specify the name of the off-page connector.

Use this control... To do this...

Name Specify the name of the schematic page.

Use this control... To do this...

Name Specify the name of the part.

Use this control... To do this...

Find User Property Type the name of the part property you want to change.
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Rename Power Symbol dialog box

To open this dialog

Select a power or ground symbol in a library in the Project manager 
and choose Rename (see Rename command) from the Design 
menu.

OR

Select a power or ground symbol in the schematic page editor and 
choose Properties from the Edit menu.

Note: If you rename a power or ground symbol using this dialog box, 
the name is limited to 31 characters.

Rename Schematic dialog box

To open this dialog

Select a schematic folder in the project manager and choose 
Rename (see Rename command) from the Design menu.

Replace with User Property Type the name of the part property you want.

Use this control... To do this...

Name Specify the name of the power or ground symbol.

Use this control... To do this...

Name Specifies the name of the schematic folder.
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Rename Title Block dialog box

To open this dialog

Select a title block in a library in the Project manager and choose 
Rename (see Rename command) from the Design menu.

Replace Cache dialog box

To open this dialog

Select a part in the design cache folder and choose Replace Cache 
(see Replace Cache command) from the Design menu.

Use this control... To do this...

Name Specify the name of the title block.

Use this control... To do this...

New Part Name Specify the part's name. The current name appears in 
the text box.

Note: If the list of parts is not available in the Part name 
list box, select a library in the Part Library field.

Part Library Specify the path and library containing the replacement 
part. The current path and library appear in the text box.

Note: When you select a library, the Part Name field 
displays a sorted list of all parts that you can select.

Browse Display a standard Windows dialog box for selecting files.

Actions

Preserve schematic part 
properties

Retain all instance and occurrence properties of the 
schematic part in the design, bringing in the graphics, 
pins, and package properties from the library.

Replace schematic part 
properties

Bring in graphics, pins, and package properties from the 
library, totally replacing the schematic part in the design.
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Replace dialog box

To open this dialog

In a text editor window, choose Replace from the Edit menu.

Preserve Refdes Preserve the reference designator of parts and/or sym-
bols that you want to change.

Note: This option is not available for symbols that do not 
require preserving of the reference designator. For 
example, if you have selected a title block, off-page 
connector, h-port, or power ground symbols, the 
Preserve Refdes check box will be unavailable for 
selection.

Use this control... To do this...

Find what Specify the string to be found and replaced.

Replace with Specify the string to replace the one specified in the Find 
What option.

Match whole word only Specify that the search cannot match the Find What 
string within another word.

Match case Specify the search must match the case of the string 
specified in the Find What option.

Find Next Find the next occurrence of the specified text, without 
replacing the currently selected string.

Replace Replace the currently selected string with the one 
specified in the Replace With option.

Replace All Replace all occurrences of the string specified in Find 
what with the string specified in Replace with. The 
search and replace takes place in the specified section of 
the file.
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Save Files in Project dialog box

The Save Files in Project dialog box appears when you save a file in 
a project without first saving the project. Capture may also display 
this dialog box if you perform an action that requires the project be 
saved first, and it has not been saved.

Save Part As dialog box

To open this dialog

In the Part editor, choose Save As from the File menu.

Save Project As dialog box

Save Project As saves the project to a new location along with the 
associated files present inside or outside the project directory 
maintaining their internal and external links. Associated files include 
referred projects, designs, libraries, simulation profiles, output files 
and so on.

Use this control... To do this...

Yes Save the design file (*.DSN) and the project file (*.OPJ).

Yes All Save the design file (*.DSN) and the project file (*.OPJ). 
Also save any other open files that are part of the project.

No Don't save the design file (*.DSN).

No All Don't save any file in the project (*.OPJ).

Cancel Cancel the action.

Use this control... To do this...

Name Specify the name of the part to be saved.

Library Specify the path and filename of the library that the part 
is saved in.
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To open this dialog

Perform one of the following:

■ Choose File – Save Project As.

■ Select DSN in the project manager and from the pop-up menu 
choose Save Project As.

■ Select Design Resources in the project manager and choose 
Save As from the pop-up menu

Use this tab... To do this...

Destination Directory Specify the location to which the project should be saved.

Project Name Shows the current project name. You can edit to change 
it to a different name.

Settings Specify whether or not to copy the design file and 
referred files. 

Referred files include Projects, Libraries, Output Files, 
Simulation Files and so on referred from the current 
project. 

Important

Irrespective of the option selected to copy the 
referred files, the links to the referred files are 
always updated   for the new saved project. In 
case of PSpice projects, PSpice files are always 
copied to the new location, irrespective of the 
options selected in the settings tab.

Copy DSN to Project Folder Select to copy the design file to the destination project 
folder. Selected by default.

Rename DSN to match 
Project

Select to rename the design file to match the project 
name. Selected by default.

Copy All Referred Files 
Present Within Project Folder

Select to copy all referred files that are in the current 
project folder into the destination folder. Selected by 
default.

Note: The hierarchical structure of these referred files is 
preserved in the target project directory as well.
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Save Part Instance dialog box

The Save Part Instance dialog box appears when you finish editing a 
part instance in the part editor window and close its part editor 
window.

Schematic Page Properties dialog box

To open this dialog

In the schematic page editor, choose Schematic Page Properties 
(see Schematic Page Properties command) from the Options menu.

Copy All Referred Files 
Present Out of Project Folder

Select to copy all referred files that are outside the 
current project folder into the destination folder. The files 
are copied to a new subfolder MovedFiles inside the 
target project directory

Note: The hierarchical structure of the referred files is not 
maintained while copying them.

Use this control... To do this...

Update Current Apply the changes only to the selected part instance.

ll Apply the changes to all instances of the selected part. If 
you have an identical part from another library, the 
instances of the part from the second library won't be 
affected.

Discard Return to the schematic page editor without applying any 
changes to the selected part instance.

Cancel Return to the part editor and continue editing the part.

Use this tab... To do this...

Page Size Specify the measuring scale used, the page width and 
height, and the spacing between pins on a schematic 
page. For more information, see Page Size tab.
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Page Size tab

The Schematic Page Properties dialog box appears when you 
choose the Schematic Page Properties command from the Options 
menu, when you are in the schematic page editor.

The Design Template dialog box appears when you choose the 
Design Template command from the Options menu.

Set these options for future schematic pages. Changing these 
options won't affect schematic pages you've already created.

Grid Reference Choose between alphabetic and numeric, and between 
ascending and descending for both horizontal and 
vertical grid references. Also use it to set the grid count 
for both horizontal and vertical grid references, and set 
the width of grid references. For more information, see 
Grid Reference tab.

Miscellaneous Displays the schematic folder's creation time, last 
modification time, and the number of the schematic page 
being viewed in the schematic page editor.

Use this control... To do this...

Units Specify the unit of measurement future designs are 
measured in. Select either inches or millimeters. This 
only affects the schematic page editor. It doesn't affect 
the part editor, which is always measured in grid units.

New Page Size Specify the size of new schematic pages in the current 
design. The first five choices are A to E if the unit 
measurement is inches, or A4 to A0 if the unit 
measurement is millimeters.

Width Displays the width of new schematic pages in the 
indicated unit measurement. You may specify the width 
of the custom schematic page. All other schematic page 
widths are permanently set for the current design.

Height Displays the height of new schematic pages in the 
indicated unit measurement. You may specify the height 
of the custom schematic page. All other schematic page 
heights are permanently set for the current design.
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Grid Reference tab

The Schematic Page Properties dialog box appears when you 
choose Schematic Page Properties from the Options menu, when 
you are in the schematic page editor.

The Design Template dialog box appears when you choose the 
Design Template command from the Options menu.

Set these options for existing schematic pages. Changing these 
options won't affect future schematic pages.

Pin-to-Pin Spacing Displays the pin-to-pin spacing in the indicated unit 
measurement.

Use this control... To do this...

Horizontal and Vertical

Count Specify the number of divisions in the horizontal or 
vertical grid references.

Alphabetic and Numeric Specify whether the grid references are alphabetic or 
numeric.

Ascending and Descending Specify whether the grid references ascend or descend.

Width Specify the width of the grid reference division.

Border Visible

Displayed Specify whether the border is visible on the screen.

Printed Specify if the border is visible on paper.

Grid Reference Visible

Displayed Specify whether the grid references are visible on the 
screen.

Printed Specify whether the grid references are visible on paper.

Title Block Visible

Displayed Specify whether the title block is visible on the screen.

Printed Specify whether the title block is visible on paper.
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Select Directory dialog box

To open this dialog

Choose the ... (browse Directories) button in the Archive Project 
dialog box.

ANSI grid references Specify if schematic pages use the ANSI Standard grid 
references.

Use this control... To do this...

Directories Displays the current selected drive and directory.

Drives Specify the drive to create the new project on.

Create Dir Display the Create Directory dialog box to create a new 
directory on the current drive. The new directory is 
created below the current selected directory.

Network Display a standard Windows Map Network Drive dialog 
box to select a different drive.
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Select File Type dialog box

The Select File Type dialog box appears after you add a file to a 
project.

Use this control... To do this...

File Types list Select a file type for the file you 
are adding to the project. 
Choose the appropriate type 
from the provided list:

■ EDIF Netlist

■ List

■ OrCAD Project

■ Report

■ Schematic Design

■ Schematic Library

■ Simulate Stimulus

■ Standard Delay File

■ Unknown

■ VHDL Netlist

■ VHDL SimModel

■ VHDL Source

■ VHDL Synthesis Macro 
Library

■ VHDL Synthesis Target 
Library

■ VHDL Testbench

■ Waveform

■ XNF Netlist
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Selection Filter dialog box

The Selection Filter dialog box allows you to control the selection of 
objects in a schematic page during a block-select operation. It 
provides check box options that allow you to include or exclude 
objects from a list. For example, if you select the Parts, Nets, and 
Power/GND check boxes, only these objects will be selected when 
you perform the block-select operation.

To open this dialog

In the schematic page editor

Right-click the schematic page and choose Selection Filter from the 
popup menu.

OR

Choose Selection Filter from the View menu.

OR

Use the keyboard shortcut, Ctrl + I.

Select New Project Path dialog box

The Select New Project Path dialog box allows you to specify a 
different location for the project in the new format.

Use this control... To do this...

Check box under the Schematic 
Page Drag Selection Filter 
group

Specify the objects that should be selected when the 
mouse pointer is dragged diagonally across the 
schematic page.

Select All Select all the check boxes in the Schematic Page Drag 
Selection Filter group.

Clear All Clear all the selected check boxes in the Schematic Page 
Drag Selection Filter group.
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New Project Path

Specify the location where you want the project in the new format to 
be created. The project in the old format will be retained in its original 
location.

Select Occurrence dialog box

This dialog box displays when you open a schematic page that has 
multiple occurrences.

Set Label State dialog box

To open this dialog

In the schematic page editor, choose Label State, Set from the Edit 
menu.

Setup dialog box

The Setup dialog box is used to set up, edit and view information 
about the configuration file used for netlisting and back annotating 
property information between Capture and PCB Editor. For more 
information about the configuration file, see Updating the PCB Editor 
configuration file.

Use this control... To do this...

Occurrence list Specify which occurrence of the schematic page you 
want to open. This option lists all occurrences available 
for the selected schematic page.

Use this control... To do this...

Enter Label Specify a label for the current state of the schematic 
page.
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To open this dialog

Click the Setup button in the PCB tab of the Create Netlist or Back 
Annotate dialog boxes.

Use this control... To do this...

Configuration File Mapping file used to pass properties back and forth 
between Capture and PCB Editor.

Order of Preference:

Last Used > Design Directory > CDS_SITE path > 
Capture Install Directory

If you have run a previous netlisting or back annotation 
the configuration file you used is listed. If not, the first 
found *.CFG file in your design directory is used. If no 
*.CFG file is found in your design directory, then the CFG 
file on the path defined by the CDS_SITE environment 
variable will be used. Finally, if the CDS_SITE 
environment variable is not set, the default will be to use 
the sample ALLEGRO.CFG file that was installed with 
Capture.

Edit Click this button to edit the configuration file listed in the 
Configuration File field. The file opens in your default text 
editor. You can edit the configuration in any text editor. 
Only changes that are saved to the file get used when 
you run the netlist. Just having the file open with changes 
won’t be enough.

Backup Versions Species the number of backup versions of the PST*.DAT 
files you want to maintain in your design directory. The 
highest value is the latest (newest). For example, 
PSTXNET.DAT,2 is the third version of the 
PSTXNET.DAT netlist file saved, and PSTXNET.DAT is 
the most recent version saved.

Device/Net/Pin name char limit Specifies the maximum permissible character limit or 
length of a component, net, or pin name. The default is 
31. The maximum value permitted by Capture is 255.
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Simulation Settings dialog box

To open this dialog

Choose Edit Simulation Profile (see Edit Simulation Profile 
command) from the PSpice menu.

Ignore Electrical constraints Specifies that the following electrical constraints will be 
ignored during netlist:

■ PROPAGATION_DELAY

■ RATSNEST_SCHEDULE

■ RELATIVE_PROPAGATION_DELAY

■ DIFFERENTIAL_PAIR

■ NET_SPACING_TYPE

■ NET_PHYSICAL_TYPE

■ ELECTRICAL_CONSTRAINT_SET

■ RATSNEST_SCHEDULE

■ VOLTAGE

■ MIN_LINE_WIDTH

■ MIN_NECK_WIDTH

■ MATCHED_DELAY

Note: These electrical warnings are ignored when the 
design is forward annotated to layout. However, if any of 
the above constraints is defined on the board, these 
constraints will again be ignored in the backannotation 
process.

Output Warnings Specifies if netlist warnings (ALG*) are to be logged 
during netlisting.

Suppress Warnings Specifies the netlist warnings (ALG*) to be ignored during 
netlist.
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This dialog box is similar to the Simulation Settings dialog box in 
PSpice. Both dialog boxes set simulation profile properties.

Use this tab... To do this...

General Specify file information and simulation notes. For more 
information, see General tab

Analysis Specify analysis options. This includes time domain, DC 
sweep, AC sweep and noise, and bias point options. For 
more information, see Analysis tab

Include Files Add include files for the current design only, or globally 
for all designs.

PSpice searches model libraries, stimulus files, and 
include files for any information it needs to complete the 
definition of a part or to run a simulation. Include files are 
user-defined files that contain:

■ PSpice commands

or

■ Supplemental text comments that you want to appear 
in the PSpice output file

Create include files using any text editor, such as 
Notepad. Include file names typically have an .INC 
extension.

For more information, see the Include Files tab help 
topic.
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Libraries ■ Add new model libraries that were created outside of 
Capture or the model editor

■ Remove libraries from the configuration list. 
Removing a library using this dialog box means that 
you are removing it from the configured list. The 
library still exists on your computer and you can add 
it back in if needed.

■ Establish whether a model library is for the current 
design only, or global for all designs

■ Change the order in which PSpice searches the 
model libraries

■ Change or add directory search paths

PSpice searches model libraries, stimulus files, and 
include files for any information it needs to complete the 
definition of a part or to run a simulation.

For more information, see the Libraries tab help topic.

Stimulus Add a stimulus file which contains time-based definitions 
for analog and digital input waveforms.

PSpice searches model libraries, stimulus files, and 
include files for any information it needs to complete the 
definition of a part or to run a simulation.

You can create a stimulus file by:

■ Manually using the Model Text View of the model 
editor (or a standard text editor) to create the 
definition. Stimulus files typically have an .STM 
extension.

■ Using the stimulus editor, which automatically 
generates a file with an .STL extension

For more information, see the Stimulus tab help topic.

Options Specify values, limits, and conditions for analog and 
gate-level simulation, and the information to include in 
the output file. For more information, see the Options tab 
help topic.
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Analysis tab

The Analysis tab specifies analysis options for the simulation.

Data Collection Specify which data is collected, and what file format is 
used to write the information. For more information, see 
the Data Collection Settings tab help topic.

Probe Window Determine if the Probe window appears when the profile 
is opened, and either during simulation or after 
simulation has completed. You can also choose to show 
all markers on open schematics or show the last plot. For 
more information, see the Probe Window tab help topic.

Use this control... To do this...

Analysis Type Specify the analysis type. The type determines the 
options that are available in the Options box. Analysis 
types include:

■ Time Domain (Transient)

■ DC Sweep

■ AC Sweep/Noise

■ Bias Point

Options Depending on the analysis type selected, a sub-set of 
the following options are available.

■ General settings options

■ Primary and secondary sweep options

■ Monte Carlo/Worst Case options

■ Parametric Sweep options

■ Temperature Sweep options

■ Save Bias Point options

■ Load Bias Point options
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General settings options

Primary and secondary sweep options

Use this control... To do this...

Run to time Specifies a finishing time, or stopping time, for the 
simulation. You can specify periods shorter than 
seconds, by including the time increment (such as "ns") 
immediately after the time period.

Start saving data after Specifies the time to wait before saving data. This is 
useful for saving only specific portions of the analysis 
data and reducing the size of the data file. You can 
specify periods shorter than seconds, by including the 
time increment (such as "ns") immediately after the time 
period.

Transient options

Maximum step size Specifies a smaller internal time step value than the 
default value.

Skip the initial transient bias 
point calculation

Specifies to skip the calculation of the bias point.

Output File Options This button displays the Transient Output File Options 
dialog box

Use this control... To do this...

Sweep variable

Voltage source Specifies the source's voltage is used to set the sweep.

Current source Specifies the source’s current is used to set the sweep.

Global parameter Specifies that during the sweep, the global parameter’s 
value is set to the sweep value and all expressions are 
reevaluated.

Model parameter Specifies that the parameter in the model is set to the 
sweep value.

Temperature Specifies to set the temperature to the sweep value. For 
each value in the sweep, all the circuit components have 
their model parameters updated to that temperature.
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Monte Carlo/Worst Case options

The Monte Carlo/Worst Case options in the Simulation Settings 
dialog box's Analysis tab specifies analysis options for the 
simulation.

Monte Carlo/Worst Case analyses vary the lot or device tolerances 
of devices, among multiple runs of an analysis (DC sweep, AC 
sweep, or transient).

You can run either a Monte Carlo or a worst-case analysis, but not 
both at the same time. Before running either analysis, you must set 
up the device and lot tolerances of the model parameters to be 
investigated.

Name Specifies the name of the source.

Model type Specifies the model type.

Model name Specifies the model name.

Parameter name Specifies the name of the global or model parameter.

Sweep Variable

Linear Specifies that the sweep variable is swept linearly from 
the starting to the ending value.

Logarithmic Specifies that the sweep variable is swept logarithmically 
by octaves or decades.

Value list Specifies that the sweep uses a list of values.

Start value Specifies the starting value for the sweep.

End value Specifies the ending value for the sweep.

Increment Specifies the step size for the sweep.

Use this control... To do this...

Monte Carlo Perform a Monte Carlo (statistical) analysis of the circuit.

Worst-case/Sensitivity Perform a sensitivity and worst-case analysis of the 
circuit.

Monte Carlo options

Number of runs Specifies the total number of runs to be performed.
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Parametric Sweep options

Use distribution Specifies whether to use the Uniform or Gaussian 
distribution curve. Uniform is the default distribution. You 
can also create your own distribution curves by clicking 
the Distributions button.

Random number seed Specify the seed for the random number generator within 
the Monte Carlo analysis. This value must be an odd 
integer ranging between 1 and 32,767. If this is not 
specified, the default value of 17,533 is used.

Save data from Produce output from subsequent runs, after the nominal 
(first) run.

■ <none> Only the nominal run produces output.

■ All Forces all output to be generated.

■ First Generates output only during the specified 
number of runs.

■ Every Generates output every specified number of 
runs.

■ Runs (list) Does analysis for the listed runs.

Distributions Display the Distributions dialog box.

Worst-case/Sensitivity 
options

Vary devices that have Specify which devices are included in the analysis by the 
model parameter indicating use of DEV or LOT 
tolerance.

Limit devices to type(s) Specify the types of devices to include in the analysis. 
The list is a string containing the initial letters of PSpice 
primitives.

Save data from each sensitivity 
run

Save the worst case data for every run of the DC, AC, or 
Time Domain analysis.

More Settings Display the Monte Carlo Worst-Case Output File Options 
dialog box.

Use this control... To do this...
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Temperature Sweep options

Sweep options

Voltage source Specifies the source's voltage is used to set the sweep.

Current source Specifies the source's current is used to set the sweep.

Global parameter Specifies that during the sweep, the global parameter's 
value is set to the sweep value and all expressions are 
reevaluated.

Model parameter Specifies that the parameter in the model is set to the 
sweep value.

Temperature Specifies to set the temperature to the sweep value. For 
each value in the sweep, all the circuit components have 
their model parameters updated to that temperature.

Name Specifies the name of the source.

Model type Specifies the model type.

Model name Specifies the model name.

Parameter name Specifies the name of the global or model parameter.

Sweep Type

Linear Specifies that the sweep variable is swept linearly from 
the starting to the ending value.

Logarithmic Specifies that the sweep variable is swept logarithmically 
by octaves or decades.

Value list Specifies that the sweep uses a list of values.

Start value Specifies the starting value for the sweep.

End value Specifies the ending value for the sweep.

Increment Specifies the step size for the sweep.

Use this control... To do this...

Run the simulation at 
temperature

Specifies a temperature at which the analysis is done. 
The value is specified in degrees Centigrade.
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Save Bias Point options

Load Bias Point options

Repeat the simulation for each 
of the temperatures

Specifies that the analysis must be performed for each of 
the temperatures listed. The values are specified in 
degrees Centigrade, and must be separated by spaces.

Use this control... To do this...

Save bias information in 
filename

Specifies the path and filename to save the bias point 
node voltages and inductor currents in.

Options

Save bias information Specifies to save the bias either at a specific time, or at 
each time interval. All times are specified in seconds. If a 
time interval is specified, then only the latest bias is 
saved.

When Primary Sweep value is Specifies the first DC sweep value at which the bias point 
is to be saved. If there are two sweep variables, Primary 
Sweep value specifies the first value.

When Secondary Sweep value 
is

Specifies the second value, if there are two DC sweep 
variables. If there is only one variable, type the value in 
the Primary Sweep value text box.

When Parametric Sweep value 
is

Specifies the transient analysis time at which the bias 
point is to be saved.

When Monte Carlo run number 
is

Specifies the number of Monte Carlo or worst-case 
analysis run for which the bias point is to be saved.

When Temperature and Sweep 
temperature is

Specifies the temperature at which the bias point is to be 
saved.

Do not save subcircuit voltages 
and currents

When selected, specifies that node voltages and inductor 
currents for subcircuits are not saved.

Use this control... To do this...
June 2020 361 Product Version 17.4-2020
© 2020                                                                                                                                                 All Rights Reserved.



OrCAD Capture Reference Guide
Data Collection Settings tab

The Data Collection Settings tab specifies data collection options.

General tab

The General tab specifies file properties, and simulation profile 
notes.

Load bias information from 
filename

Specifies the name of the file to load bias points. It is 
used in setting initial bias conditions for subsequent 
simulations. However, loading a bias point file does not 
guarantee convergence.

Use this control... To do this...

Schematic/Circuit Data

All voltages, currents, and digital 
states

Collect data for voltages, currents, and digital states.

All but internal subcircuit data Exclude subcircuit data.

At Markers only Collect data for the marked node only.

None Do not collect data.

Save data in the CSDF format 
(.CSD)

Specify that PSpice will write simulation results to the 
data file in ASCII format following the CSDF convention.

Use this control... To do this...

Simulation Profile Specifies the name of the current simulation profile.

Input

Project Name (.OPJ) Specifies the path and file name of the project file 
containing the schematic for simulation.

Schematic filename (.DSN) If Schematic is selected, this specifies the path and file 
name of the design file containing the schematic for 
simulation.

Schematic name Specifies the name of the root schematic for the 
simulation profile.
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Include Files tab

Include files contain PSpice circuit file commands. PSpice reads 
these before reading the netlist or simulation profile. Include files are 
useful for defining mathematical functions used in expressions.

Libraries tab

Use this tab to configure global and design only model libraries.

Output

Output filename Specifies the file name for simulation output.

Probe data filename Specifies the name for Probe data output.

Notes Provides a text area for you to record notes on the active 
simulation profile.

Use this control... To do this...

Filename Display an include file name to be added to the current 
design only, or globally for all designs.

Include Files Lists the include files to be loaded for the simulation.

Add as Global Add the include file named in the Filename box to the 
Include Files list box, as global to all designs.

Add to Design Add the include file named in the Filename box to the 
Include Files list box, for the current design only.

Edit File Open a file you select from the Include Files list for 
editing.

Use this control... To do this...

Filename Display a selected model library file name to be added to 
the current design only, or globally for all designs.

Include Files Lists the model library files to be loaded for the 
simulation.

Add as Global Add the include file named in the Filename box to the 
Include Files list box, as global to all designs.
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Options tab

Add to Design Add the model library file named in the Filename box to 
the Library Files list box, for the current design only.

Edit File Open a model library you select from the Library Files list 
for editing.

Use this control... To do this...

Analog Simulation Use the Analog Simulation settings to fine-tune analog 
simulation accuracy, set iteration limits, set operating 
temperature, and specify MOSFET parameters.

General Enter values for speed level, tolerances, and minimum 
conductance.

Autoconverge Enter relaxed limits for various options that PSpice can 
modify during a simulation to achieve convergence.

MOSFET options Enter values for the default drain area, default source 
area, default length, and default width.

Analog Advanced options Enter values for the total transient iteration limit, relative 
magnitude for matrix pivot, and absolute magnitude for 
matrix pivot.

General Enter values for solver, ITL5, and minimum conductance.

Bias Point Enter values for various options to enable GMIN 
stepping, ITL6, PSEUDOTRAN

Transient Enter values related to transient analysis, such as 
METHOD, CSHUNT, TRANCONV.

Gate-level Simulation Use the Gate-Level Simulation settings to set timing, I/O 
levels for A/D interfaces, drive strength, and error 
message limits.

General Enter various options for default delay selector, flip-flop 
and latches' initial state, default digital level, suppressing 
simulation error messages in the .dat file

Advance options Enter values for the minimum output drive resistance, 
maximum output drive resistance, overdrive ratio, default 
delay calculation, and error message limits.

Output file
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Note: The option names shown correspond to the option names 
used in the PSpice OPTIONS command. For more information about 
this command, refer to the PSpice Reference document.

Probe Window tab

Stimulus tab

Use this tab to configure global and design stimulus files.

General Use the Output File settings to select the types of 
information PSpice A/D saves to the simulation output 
file.

Use this control... To do this...

Display Probe window when 
profile is opened

Display the Probe windows that were displayed the last 
time the profile was opened.

Display Probe window

during simulation. Display the Probe windows when the simulation is 
running, and update the waveforms as the simulation 
progresses.

after simulation has completed. Display the Probe windows when the simulation is 
finished.

Show

All markers on open schematics Show the traces for all the markers that are placed on 
currently open designs in Capture.

Last plot Show the traces that were used the last time the profile 
was opened.

Nothing Show the traces that were used the last time the profile 
was opened.

Use this control... To do this...

Filename Display a selected stimulus file name to be added to the 
current design only, or globally for all designs.
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Specify Part Filter dialog box

To open this dialog

In the Place Part dialog box click the Filter button.

Include Files Lists the stimulus files to be loaded for the simulation.

Add as Global Add the stimulus file named in the Filename box to the 
Stimulus Files list box, as global to all designs.

Add to Design Add the stimulus file named in the Filename box to the 
Stimulus Files list box, for the current design only.

Edit File Open a stimulus file you select from the Stimulus Files 
list for editing.

Use this control... To do this...

Contains Simulation Model Specify that you want to restrict the part search to 
only parts that have associated PSpice or HDL 
simulation models.

PSpice Model Specify that you want to restrict the part search to 
only parts that have associated PSpice models. You 
can also restrict the search to only parts that have 
associated parameterized or non-parameterized 
PSpice models.

Smoke information Specify that you want to restrict the part search to 
only parts that have associated PSpice models that 
contain smoke information.

HDL Model Specify that you want to restrict the part search to 
only parts that have associated HDL models. You 
can also restrict the search to only parts that have 
associated VHDL or Verilog models.

Contains Packaging 
Information

Specify that you want to restrict the part search to 
only parts that have packaging information.
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Transient Output File Options dialog box

The Transient Output File Options dialog box appears when you 
select the General Settings option from the Analysis tab of the 
Simulate Settings dialog box, and click the Output File Options 
button.

Use this control... To do this...

Print values in the output file 
every:

Specify the interval for printing transient values to the 
output file.

Perform Fourier Analysis Perform a Fourier analysis, which decomposes the 
results of transient analysis to Fourier components.

Center Frequency Specify the fundamental frequency. Not all of the 
transient results are used; only the interval from the end, 
back to 1/frequency before the end is used. This means 
that the transient analysis must be at least 1/frequency 
seconds long.

Number of Harmonies Specify the number of harmonics of the selected 
voltages and currents to be calculated in the transient 
analysis.

Output Variables Specify a list of output variables. The output is split up 
depending upon the width of the data columns and the 
output width.

Include detailed bias point 
information for nonlinear 
controlled sources and 
semiconductors (/OP)

Include detailed information about the bias point. The 
bias point is calculated regardless of whether this option 
is selected or not. However, if this option is not selected, 
then the only information about the bias point is a list of 
the node voltages, voltage source currents, and total 
power dissipation. Selecting this option can cause the 
small-signal (linearized) parameters of all the nonlinear 
controlled sources and all the semiconductor devices to 
be placed in the output file. This option controls the 
output for the regular bias point only.
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Update Properties dialog box

To open this dialog

In the project manager, choose Update Properties (see Update 
Properties command) from the Tools menu.

Use this control... To do this...

Scope Specify whether to process all the properties in the 
design or just in the selected schematic page or pages.

Mode Update either instances or occurrences. Capture 
automatically sets this option based on the project type. 

Action

Update parts and Update nets Specify whether to update the properties of parts or nets.

Use case insensitive compares Match the combined property string with update 
properties without regards to case sensitivity.

Convert the update property to 
uppercase

Convert the case of characters in the update property to 
uppercase. The update file itself remains unchanged.

Unconditionally update the 
property (normally only updated 
if empty)

Unconditionally change the specified property. By 
default, a property is only updated if it is empty. That is, 
properties with values already in them are not updated.

Do not change updated 
properties visibility

Specify that the visibility of the updated properties is not 
changed

Make the updated property 
visible

Specify that the updated property is to be made visible.

Make the updated property 
invisible

Specify that the updated property is to be made invisible.

Create a report file Specify whether Capture creates a report file.

Report file Specify a report filename and path. 

Property update file Specify an update file. The update file must be in ASCII 
format. 

Browse Displays a standard Windows dialog box for selecting 
files.
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User Properties dialog box

To open this dialog

■ In the part editor:

❑ Click the User Properties button in Place Pin dialog box. It 
contains name and value of the user-defined property.

❑ In the Property Sheet pane, click the add row icon ( ) 
to add user-defined properties. Some of the commonly 
used properties are available in the drop-down list.

■ In the schematic page editor:

Click the User Properties button in Edit Part Properties dialog 
box.

Note: You can use the User Properties dialog box to assign 
PROPAGATION_DELAY and RELATIVE_PROPAGATION_DELAY 
properties to all the bits of a bus at the same time. Make sure that the 
syntax is correct. For more information, see Assigning signal flow 
properties.

Use this control... To do this...

Name List the item’s properties.

Value Display the value of each property.

Attributes Display the attributes of each property. An "R" indicates 
the property is read-only, and a "V" indicates the property 
is visible to the user. You cannot remove or change the 
values of read-only properties, but you can set their 
visibility in the Display Properties dialog box.

New Display the New Property dialog box so you can create a 
property for the item.

Remove Remove the selected property from the item's property 
list.

Display Display the Display Properties dialog box so you can 
change the appearance of the selected property.
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Update Alias dialog box

Use this control... To do this...

Part Aliases In this section, click the add row icon 
( ) to specify a new part alias. 

Click the Add Alias button ( ) to 
add the new alias.

Apply Click Apply to save the alias. You can 
see the new alias added to the library in 
the project manager tab.
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Zoom Scale dialog box

To open this dialog

In the schematic page editor, choose Zoom – Scale from the View 
menu.

Use this control... To do this...

X% Choose a predefined zoom scale ranging from 25% to 
400%.

Custom X% Specify a custom zoom scale.
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